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In this Chapter you will learn:

 

• How the Score Editor and MIDI data relate.
• What Display Quantize is and how it works.

 

Welcome!

 

Welcome to Cubase Scoring! The Score Editor has been created to allow you to get 
any possible piece of music displayed as a score, complete with all the symbols and 
formatting needed. It allows you to extract parts out of a full orchestra score, to add 
lyrics and comments, create lead sheets, score for drums, create tablature, etc. In 
other words: just about any type of notation you could ever desire!

There are a few basic principles to how the Score Editor works, which you just have 
to understand to make full use of it. So please bear with us during this chapter, we’ll 
try to be as concise as possible.

 

How the Score Editor operates

 

The Score Editor basically does the following:

 

• Reads the MIDI notes out of the Parts/Tracks.
• Looks at the settings you have made.
• Decides how the MIDI notes should be displayed according to the settings.

 

Score Edit takes MIDI data and settings as input and produces a Score as output.

 

Score Edit does all this in real time. If you change some of the MIDI data (for exam-
ple by moving or shortening a note) this is immediately reflected in the score. If you 
change some of the settings (for example the time signature or key signature) this 
is also immediately apparent.

You should not think of Score Edit as a drawing program, but rather as an “inter-
preter” of MIDI data.

MIDI Data

Score settings

Score Editor Score Display
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MIDI Notes vs. Score Notes

 

Cubase MIDI and Drum Tracks hold MIDI notes and other MIDI data. As you may 
know, a MIDI note in Cubase is only defined by its position, length, pitch and veloc-
ity. This is not nearly enough information to decide how the note should be dis-
played in a score. The program needs to know more: What type of instrument are we 
talking about, Drums? Piano? What key is the piece in? What is the basic rhythm? 
How should the notes be grouped under beams? etc. You provide this information 
by making settings and working with the Tools available in the Score Editor.

 

An example of the MIDI/Score relation

 

When Cubase stores a MIDI note’s position it makes the measurement in an absolute 
value, called ticks. There are “always” 15360 ticks to a quarter note. Have a look at 
the example below.

 

A quarter note at the end of a 4/4 measure.

 

The note is on the fourth beat of the measure. Now, let’s say you change the Time 
Signature to 3/4. This shortens the length of a “measure” to only three quarter 
notes - 46080 ticks. Suddenly our quarter note is in the next measure:

 

The same note in 3/4.

 

Why? Because by changing the Time Signature you are not changing the MIDI data 
in the Track/Part (since that would ruin your recording!), the note is still at the same 
absolute position. It’s just that now each “measure” is shorter, which effectively 
moves the note in the score.

What we are trying to get across here is that Score Editor is an “interpreter” of the 
MIDI data. It follows rules that you set up by making settings in dialog boxes, on 
menus, etc. And this interpretation is “dynamic”, or in other words, it is constantly 
updated whenever the data (the MIDI notes) or the rules (the Score settings) 
change.
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Display Quantize

 

Let’s say you used the Arrange window to record a figure with some staccato 
eighth notes. When you open the Score Editor it displays it like this:

This doesn’t look anything like what you intended. Let’s start with the timing - ob-
viously, you were off at a couple of places (the third, fourth and last note all seem to 
be a 1/32nd note late). You could solve this by Quantizing the figure, but this could 
make the passage sound too “stiff”, and not fit in the musical context. To resolve 
this problem the Score Editor employs something called “Display Quantize”.

Display Quantize is a setting which is used to tell the program two things:

 

• How precise Score Edit should be when displaying the note positions.

• The smallest note values (lengths) you want displayed in the score.

 

In the example above, the Display Quantize value seems to be set to 1/32nd notes 
(or a smaller note value). When reading the next chapter (and when following the 
Tutorials) you will find out how to set the Display Quantize value yourself.

Let’s say we change the Display Quantize value to sixteenth notes in the example:

 

With Display Quantize set to sixteenth notes.

 

OK, now the timing looks right, but the notes still don’t look like you intended. 
Maybe you can understand that from a computer’s point of view, you did play six-
teenth notes, which is why there is a lot of pauses. But that’s not how you meant it. 
You still want the Track to play back short notes, because it is a staccato part, but 
you want something else “displayed”. Try setting the Display Quantize value to 
eighth notes instead:

 

With Display Quantize set to eighth notes.

 

Now we have eighth notes, as we wanted. All we have to do now is to add staccato 
articulation which can be done with one simple mouse click using the Pen tool (you 
will find out about this in “Working with Symbols”).

How did this work? By setting the Display Quantize value to eighth notes you give 
the program two instructions, that would sound something like this in English: 
“Please, display all notes as if they were on exact eighth note positions, regardless 
of their actual positions” and “Please, don’t display any notes smaller than eighth 
notes, regardless of how short they are”. Please note that we used the word display, 
which leads us to one of the most important messages of this chapter:

 

❐

 

Setting a Display Quantize Value does not alter the MIDI notes of your recording in any 
way, as regular Quantizing does. It only affects how the notes are displayed in Score 

 

Edit (and nowhere else)!
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Choose your Display Quantize values with care

 

As explained above, the Note Display Quantize value puts a restriction on the 
“smallest” note value that can be displayed. Let’s for a second look what happens if 
we set it to quarter notes:

 

With Display Quantize set to quarter notes.

 

Oops, this doesn’t look too good. Well of course it doesn’t! We have now instructed 
the program that the “smallest” note that occurs in the piece is a quarter note. We 
have explicitly told it that there are no eighth notes, no sixteenths, etc. So when the 
program draws the score on screen (and on paper) it quantizes the display of all our 
eight notes to quarter note positions, which makes it look like above. But again, 
please note that when you hit Play, the passage will still play as it originally did. The 
Display Quantize setting only affects the score image of the recording. One last im-
portant note:

 

❐

 

Even if you enter notes using the mouse and input perfect note values, it is very impor-
tant that you have your Display Quantize settings right! These values are not just used 
for MIDI recordings! If you for example set Note Display Quantize to quarter notes and 
start clicking in eight notes, you will get eighth notes in the Track (as MIDI data), but 

 

still only quarter notes in the display!
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Using Rest Display Quantize

 

Above we use Display Quantize for notes. There is a similar setting called “Rest” Dis-
play Quantize which is used to set the smallest rest to be displayed. Often, this set-
ting is very effective:

What if the original note example looked like this:

As you see, the first note is moved one sixteenth note later. If we change the Display 
Quantize value for the notes to eighth notes, the score will be displayed like this:

 

With Note Display Quantize set to eighth notes.

 

Unfortunately, this moves the first note to the same position as the second, since six-
teenth note positions aren’t allowed. We could solve this by inserting extra Display 
Quantize values within the bar with the Display Quantize tool, but there is a much 
easier way: Change the Display Quantize value for notes back to sixteenths, but set 
the Display Quantize value for 

 

rests

 

 to eighth notes! This tells the program not to dis-
play any rests smaller than eighth notes, 

 

except when necessary

 

. The result looks like 
this:

 

With Note Display Quantize set to sixteenth notes, but Rest Display Quantize set to eighth 
notes.

 

How did this work? Well, you instructed the program not to display any rests 
smaller than eighth notes, except when “necessary”. Since the first note appeared 
on the second sixteenth note position, it was necessary to put a sixteenth rest at 
the beginning of the figure. All other rests, however, could be hidden by displaying 
the notes as eighth notes, and were therefore not “necessary”.

This leads us to the following general guidelines:

 

• Set the Note Display Quantize value according to the “smallest note position” you 
want to be shown in the score.

 

For example, if you have notes on odd sixteenth note positions, the Note Display Quantize 
value should be set to sixteenth notes.

 

• Set the Rest Display Quantize value according to the smallest note value (length) you 
want to be displayed for a single note, positioned on a beat.

 

A common setting would be to have Note Display Quantize set to 16 (sixteenth 
notes) and Rest Display Quantize set to 4 (quarter notes).
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Handling exceptions

 

Unfortunately, the guidelines above won’t work perfectly in every situation. You 
may for example have a mix of straight notes and tuplets of different types, or you 
may wish to display equally long notes with different note values depending on 
the context. There are several methods you could try:

 

Automatic Display Quantize

 

If your score contains both straight notes and triplets, you can use Auto Display 
Quantize. When this is activated, Cubase VST tries to “understand” whether the 
notes should be Display Quantized to straight notes or triplets (see page 71).

 

Using the Display Quantize Tool

 

With the “Q” tool, you can insert new Display Quantize values anywhere in the score. 
Inserted Display Quantize can either have a length (and thus affect only a few beats, 
for example) or affect the Staff from the insertion point onwards. See page 78.

 

Permanent Alteration of MIDI Data

 

As a last resort, you could resize, quantize or move the actual Note Events. However, 
this would result in the music not playing back like it originally did. Most often, it is 
possible to get the score to look like you want without altering any MIDI data.

 

Summary

 

This closes our discussion on the basic concept of Display Quantizing. There are a 
number of other special situations which require more advanced techniques, which 
you will find out about in the next chapters. You will also read about other settings 
which work along the same lines as Display Quantize but each with its own applica-
tion. These are called “Interpretation Flags”.

 

Entering Notes by hand compared with Recording them

 

Sometimes you will enter and edit notes by hand (or rather using the mouse and 
computer keyboard) and at other times you will record them from a MIDI keyboard. 
Most of the time, you will do a combination of both. In “Transcribing MIDI Record-
ings” you will find out how to make a recorded score as legible as possible without 
performing any permanent changes to the MIDI data. “Entering and Editing Notes 
using the Mouse” shows how to enter and edit notes using the mouse. In real life, 
even if you have recorded the piece perfectly, you will often have to do some per-
manent editing to your recording before printing. Which leads to this conclusion:

 

❐

 

You will have to read both chapters in order to understand how to produce legible 

 

scores!
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Tutorials
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In this Chapter you will learn:

 

• How to click in a simple melody and add some lyrics.
• How to transcribe an example recording using Polyphonic Voices. 

 

Tutorial 1 – Entering Notes with the Mouse

 

In this short Tutorial you will find out how to open the Score Editor and enter some 
notes in Page Mode. The purpose is for you to get some understanding for how 
MIDI Data and the score relate.

 

Setting up the page

 

1. Launch Cubase VST.

 

This automatically opens the Autoload Song.

 

2. Make sure the first MIDI Track is selected. Rename it to “Melody”.

3. Create a Part between bar 1 and 5.

 

This is probably most easily done by double clicking in the Part Display between the Left and 
Right Locator.

 

Double clicking between the Locators creates a Part.

 

4. With the Part selected, pull down the Edit menu and select “Score”.

 

The Score Edit window opens.

Double click here
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5. Pull down the Score menu and select Page Mode.

 

The Score is now displayed as it appears on a printed page. If the item on the menu says “Edit 
mode”, you are already in Page mode and don’t need to select anything.

 

6. Pull down the File menu and select Page Setup.

 

The standard Macintosh Page Setup dialog appears.

 

7. Make sure the desired Paper Size and Scale settings are selected.

8. Close the dialog by clicking OK.

9. Resize the window and/or use the horizontal scroll bar to make sure all four bars are 
visible on the screen at the same time.

Selecting Page Mode...

...makes the Score appear as on a page.
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Making Staff Settings

 

The four bars we are supposed to enter into the score are this, the end of a well 
known song.

 

The Score you are about to create!

 

1. Pull down the Score menu and select “Staff Settings...”.

 

A dialog box appears.

 

The Staff Settings dialog.

 

2. Since we are only entering a simple melody, we can leave the Staff Mode set to “Sin-
gle”.

 

If you examine the Score, you will see that the “smallest note position” that occurs, 
is eighth notes (i.e. there are no notes on odd sixteenth note positions or smaller). 
Furthermore, the smallest note value for a single note positioned on a beat is a half 
note. As described on page 12, this tells us the necessary Display Quantize settings. 
We will now “feed this information” into the staff.

 

3. In the Display Quantize section of the dialog, pull down the Notes menu and set it to 
“8”. 
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4. In the same section, pull down the Rest menu and set this to “4”.

 

Following the general guidelines, the value “2” (half notes) should be enough, but “4” is the 
largest Rest Display Quantize value available.

 

5. Since the piece is simple, and doesn’t contain any triplets, make sure “Auto Quantize” 
is deactivated.

6. As we will be drawing in notes with “perfect lengths”, make sure Clean Lengths is 
turned off.

7. Make sure No Overlap, Syncopation and Shuffle are all turned off.

 

The function of these flags is described in “Transcribing MIDI Recordings”.

 

8. The Clef is OK, so leave it as it is.

9. Use the scroll bar to the right of the Clef symbol to select the Key Signature “Bb” (two 
flats).

 

The Key Signature/Clef part of Staff Settings.

 

10.Click OK to close the Staff Settings dialog.

 

Using Undo

 

If something goes wrong when you proceed with the steps below, remember you 
can always Undo the last action.
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Entering the Notes

 

1. Since the “smallest position” we will enter any notes at is eighth notes, pull down the 
Snap pop-up menu and set it to “8”.

 

This will restrict input to eighth note positions. Now you will not be able to input notes at six-
teenth note positions, but that’s exactly what we want, right?

 

The Snap pop-up menu.

 

2. The first note is a half note, so click on the half note symbol on the Score Toolbar. 

 

The Score Toolbar is located just above the Score.

 

The Score Toolbar with the half note selected.

 

When you click on the note symbol and move the mouse pointer into the score, 
please observe that the program has now automatically selected the Note tool for 
you. This tool can also be selected “manually” from the Toolbox as in any editor.

 

3. Move the mouse pointer over the note lines and press the mouse button without re-
leasing it.

 

A half note symbol appears “under” the pointer.

 

Dragging a half note in the score.
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4. Since the note is supposed to be positioned at the beginning of the staff, drag the 
mouse all the way to the left of the staff.

5. When you have found the right horizontal position, drag vertically to find the right 
pitch.

 

You can check the pitch in two ways: directly in the score (accidentals appear as you drag) 
and in the mouse box on the Status bar. The pitch you are aiming for is D4.

 

The Status bar shows mouse position and current pitch.

 

6. Release the mouse button.

 

The note appears. It is selected and therefore has a black rectangle around its head.

 

The first note entered!

 

7. The next note is an eighth note, so click on the eighth note symbol on the Score Tool-
bar.

 

The pointer takes on the shape of an eighth note.

 

8. Press the mouse pointer over the score as with the first note.

9. Drag the note back and forth without releasing the button.

 

You will notice that the note is ‘magnetically’ attracted to the eighth note positions within 
the bar. This is because we have Snap set to eighth notes. The position we are aiming for is 
the first upbeat after the half note rest’s start position. You can also check the position by 
looking at the mouse box on the Status Bar (it should display “1.3.3.0”).

 

10.When you have found the right position and pitch, release the mouse button.

 

The note now appears in the score, and the program automatically inserts the correct rest in 
front of it.

 

The first bar with the second note added.

 

If the note doesn’t appear at the correct position, there are two ways to go:

 

• Undo and try again.

• Select the arrow from the Toolbox, press the mouse button with the pointer over the 
note head and drag it to the correct position.
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11.Click to enter the next two eighth notes. If you think you can find the correct position 
immediately, just position the pointer and click briefly to make the note appear.

 

These two notes will automatically be grouped under a beam.

 

The first bar finished!

 

12.Enter the first note in measure two, with the current settings.

 

Oops, the note is of the wrong length, since you didn’t change the note value. Of 
course, you could Undo and try again, but let’s try another method, to change the 
length of the existing note:

 

13.Click on the half note symbol on the Score Toolbar.

 

The Mouse pointer takes on the shape of a half note.

 

14.Hold down the [Option] key and click on the note with the wrong length.

 

Its length changes to a half note.

 

This way of changing the lengths of notes is probably something you will use a lot 
when you make mistakes entering notes and when you tidy up MIDI recordings.

 

15.Continue entering the last notes in the remaining bars, using the techniques described 
above.

 

The finished score.
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Trying Display Quantize Settings

 

Let’s check what Display Quantize can do with your piece as it is now.

 

1. Play back the piece via MIDI to check that it is correct.

2. Open Staff Settings again and change the Note Display Quantize to quarter notes (4).

 

With Display Quantize set to “4”.

 

Oops again! As you can see, the eight notes are now interpreted as quarter notes. 
This is natural because by changing the Display Quantize value, you specifically in-
structed the program not to display any notes on anything other than quarter note 
positions.

 

3. Now try playing back.

 

As you will note, playback is not affected. This is because Display Quantize, as set 
up in Staff settings, only affects how the score is displayed, not the MIDI data.

 

4. When you are done, set Note Display Quantize back to eighth notes.
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Adding some Lyrics

 

1. Pull down the Score menu. From the Symbol Palette submenu, select “Other”.

 

Selecting the “Other” Palette.

 

2. In the Palette that appears, click on “Lyrics”.

 

The “Other” part of the Symbol Palette.

 

• When you select a symbol like this, the cursor automatically switches to the Pencil tool.

 

If the Pencil tool doesn’t appear, double click on the “Lyrics” symbol instead (there is a pref-
erence for this, as described later in this manual).
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3. Move the pointer to a position straight below the first note.

 

Positioning the pointer under the first note.

 

4. Click once with the mouse.
A box appears.

Clicking brings up a box for the first word.

We shall now enter the text “More, much more than this, I did it my way!”, with one 
word on each note.

5. Type in the first word (“More”) and then press the [Tab] key.
More appears under the first note.

After hitting [Tab], the program moves on to the next note.

6. Type in the next word (“much”) and hit [Tab] again.

7. Proceed like this for all notes except that last.

8. After typing in the text for the last note, hit [Return] instead of [Tab].
The lyrics appear under the notes.

The Score just after adding the last word.

The lyric blocks are spaced far too tightly, and also selected, which makes the score 
look very strange.

9. Select the arrow pointer from the Toolbox and click on a white area in the score.
All text gets deselected.



- 25 - 

10.Pull down the Score menu. From the hierarchical “Auto Layout” menu, select “Move 
Bars”.
The measure spacing gets adjusted to make the lyrics readable.

Auto Layout and its submenu.

• If you find that the lyrics are too close to the notes or too far below them, you can easily 
adjust this: Select all the words by enclosing them in a rectangle with the Arrow tool, 
and drag them up or down.

The finished score.

11.Double click on the text “Untitled 1” at the top of the screen.
The Title, Comment & Copyright dialog appears.

12.Pull down the Text Element pop-up menu and select “Title”.

13.Type in your title of the “song” in the text field beneath the pop-up menu and click OK 
to close the dialog.

This finishes the first tutorial! Congratulations! You might want to proceed with the 
next tutorial directly if you wish, or dive into the program and get back to this one 
when you are ready to enter the world of Polyphonic Voicing!
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Tutorial 2 – Converting a MIDI Recording

This tutorial is slightly more complicated than the previous one. It is mainly in-
tended to give an introduction to Polyphonic voicing. You might want to study the 
first chapters of this Scoring manual before trying this tutorial out, since it assumes 
you are at least vaguely familiar with how to move notes etc.

On your Cubase VST CD-ROM, you will find a folder called “Score Tutorials”. One of 
the files in this folder is called Tutorial 2. This is an Arrange file with a recording of 
three bars of piano music. To get this properly scored we need to use something 
called Polyphonic Voices. An introduction to this is found on page 130. Below we 
will concentrate on how to use Polyphonic Voices rather than how they work.

Examining the recording

1. Open the file.

2. Set up an instrument to play a piano sound on MIDI Channel 1. Play back the piece to 
listen to it.
Well it isn’t really perfectly played, is it? But we won’t correct it more than necessary, simply 
to show you don’t need perfectly played MIDI recordings to get perfect scores.

3. Open the Score Editor.

4. If you’re not in Page mode already, select Page Mode from the Score menu.

5. If necessary, resize the window so that you see all four measures.

6. Examine the piece.
Right now it should look like this:

After we’re done, it will look like this:

The score after formatting and editing.
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Basic Settings

1. Double click on the 4/4 symbol in the score, and in the dialog that appears, select the 
Cut Time symbol and click OK.

The “Cut Time” time signature symbol.

2. Select Staff Settings from the Score menu.

3. Select Polyphonic from the Staff Mode pop-up menu.

The Staff mode pop-up at the top of Staff Settings.

4. Click the Edit button.
The Polyphonic Settings dialog appears.

The Polyphonic Settings dialog.
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We now have to specify the voices we need. Look at the picture of the finished score, 
above. You will see that there are at the most two notes sounding at the same time 
which are not part of the same chord (for example at the end of bar 1 and the begin-
ning of bar 2, but also in many other places). To be able to score these separately 
and with different stem direction, we need a voice for each.

The dialog is already set up with two voices for the upper staff, one with stems up 
and the other with stems down, so let’s leave that as it is.

Check the lower staff in the finished score above. There we have the same phenom-
enon, so two voices with different stems is fine there too.

Now we are going to use a feature called “Auto Move To Voices” which automati-
cally puts notes into voices, saving a lot of time compared to performing it manually. 
One of the pieces of information we need to supply in this case is where we should 
initially split the system to create as little work as possible afterwards. The best point 
for this piece seems to be C#3.

5. Activate Auto Move To Voices. Activate Split Note and set it to C#3. Make sure Lines To 
Voices and Bass To Lowest are turned off.

Set up Auto Move To Voices like this.

6. Click OK.

7. Since the smallest note position in the score is eighth notes, set Note Display Quantize 
to eighth notes.

8. There are no rests at all, but set Rest Display Quantize to eighth notes too, anyway.

9. Make sure Auto Quantize is deactivated.
Auto Quantize is best used when you have mixed regular notes and triplets, which we don’t 
in this example.

10.Turn off all Interpretation flags.
In many cases you will need to use these, but you could always try with them turned off, first.

All Interpretation Flags turned off.
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11.Use the right scroll bar in the Clef/Key section to set two flats.

12.Activate the “Lower Staff” checkbox to check you have the right clef and key (bass clef 
– two flats) for the bass staff.

13.Click OK.

14.To get a more sensible measure width for this reasonably crowded score, click the Auto 
Layout icon on the Score Toolbar.

The Auto Layout button on the Score Toolbar.

The score should look like this:

The score after using “Auto Move To Voices”.

Ok, it’s closer but we still have quite a bit of work left to do.

Using Undo

If something goes wrong when you proceed with the steps below, please remem-
ber you can always press Undo to revert the last action.
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Moving Notes to Voices and other basic editing

Please examine the Score. Notes on the treble clef with stems up are in Voice 1. 
Notes with stems down on the same clef are in Voice 2. The same goes for the bass 
clef, but notes with stems up are in Voice 5 and notes with stems down are in Voice 6.

Things seems to be completely wrong in the lower staff. Most notes are pointing up 
when we want them pointing down. Let’s move a few of them right away, to get 
them in the correct Voice.

1. Select notes in the lower voice by dragging a selection rectangle around them and 
then release the mouse. 
The rectangle should look like this:

so that the following notes get selected:

2. Pull down the Score menu and select “Move To Voice” from the “Staff Functions sub-
menu. Yet another submenu appears - select Voice 6 from this. Click in some white 
space in the score to deselect.
Many of the notes at the lower staff now have the correct stem direction.

The Score after moving the notes on the lower staff to a new voice.
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There seems to be a note missing at the downbeat of the first bar. How can this be? 
Well, if you look in the score example, many notes occur in two voices, to make the 
score more legible. This first note is an example of this. It appears on the lower staff, 
but we need it on the upper too. We will now enter the note, but first we have to 
make sure it goes into the right voice.

3. To make the Voice buttons on the Score Toolbar show Voice 1 to 2, click anywhere in 
the upper staff.

4. To make sure the note goes into the right Voice (Voice 1), click on the Voice 1 icon on 
the Score Toolbar.

Voice 1 selected on the Score Toolbar.

5. Click on the eighth note symbol on the Score Toolbar and enter an eighth note C3 at 
the beginning of the upper staff.
Since it is in the same Voice as the next note, they get beamed automatically.

A note added at the downbeat.

Check the notes in the middle of the first bar. The lower of the two seems to be on 
the wrong staff. We want it pointing upwards, on the lower staff, which means we 
need to move it to the Voice 5.

6. With the arrow tool, click on the note to select it.

7. Select “Move To Voice” from the Score “Staff Functions” submenu, and select Voice 5.
The note appears on the lower staff.

Before and after moving the note to a voice on the lower staff.
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Using Clean Lengths

Check the note we just moved, it appears as a dotted quarter. We want a half note, 
right? So the note was played a bit too short. Of course, we could change the note’s 
length, but there’s a better way. Cubase knows that notes are often played shorter 
than scored and has a special feature for this:

1. Open Staff Settings again.

2. Turn On Clean Lengths.

Clean Lengths activated.

3. Click OK.
The note is now shown as a half note, but when you play back, it still has the same sounding 
length. Clean Lengths is yet another example of a function that only affects the display of 
notes.

The same part of the score with Clean Lengths Off and On.
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More Editing and Voice moving

Let’s again examine the middle of the bar on the upper staff. There seems to be a 
note missing now. As you can see we want two notes with the same pitch at the 
same position, but with different stem directions. The one we have goes down, so 
we need one that goes up. This means we have to insert it into Voice 1.

1. The Voice button on the Score Toolbar may show 5 to 6. If it does, use the Arrow Tool to 
click in the upper Staff.

2. Click on the Voice 1 button on the Score Toolbar.

3. Click on the eighth note on the Score Toolbar and use the Note Tool to enter the 
missing note at exactly the same position and pitch as the existing one.

A new note added at the same position and pitch as an existing.

Oops, it wound up just before the other one, not on top of it. This is OK for now 
though, and is even acceptable notation. But we will go back and make it even 
better later!

When we turned on Clean Lengths we fixed the dotted quarter on the bass clef. But 
we gave ourselves a new problem. A C4 on the last quarter on the upper staff is 
now displayed as too long. In fact it was played a little bit too long. Let’s shorten it.

4. Click on the quarter note on the Score Toolbar.

5. Hold down [Option] and click on the note.
The tie goes away.

Before and after changing the length of the note.

6. At the downbeat of bar 2, enter an eighth note F#3 into voice 1, just as you did above.
Watch the pitch box on the Status Bar while entering the note so that you get the pitch right.

Again, adding a new note with the same pitch and position as an existing.

Oops, we got two notes, on top of each other, with a sharp each! Doesn’t look too 
good.
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7. Select the new note, if it isn’t already selected. Then click on the “No” button among 
the accidentals in the Score Toolbar.
The accidental of the note is hidden.

8. Change the length of the Bb3 at the second beat to the eighth note it should be.
This time we could try another way of changing lengths of notes: Hold down [Command], 
point at the note with the arrow tool and press the mouse button. A “length slider” appears.

The length is displayed in sixteenth notes and ticks. Since we want an eighth note, you 
should drag the slider so that the length is “2.0” (two sixteenth notes and zero ticks).

9. Move the second F3 in measure two, from Voice 2 to Voice 1.
This time you might try using the keyboard. You can move notes to Voices by holding down 
[Option] and pressing a number key on the typewriter part of the keyboard. For example, to 
move a note to Voice 1, select it and press 
[Option]-[1].

❐ As always in Cubase VST, you can change these key commands in the Preferences–Key 
Commands dialog.

10.The note you just moved seems to be too long, so shorten it to an eighth note.

11.There’s a Eb3 eighth note missing on the third quarter, in Voice 1. Draw it in.
Don’t forget to select Voice 1 before you click.

12.The E3 at the end of the bar seems to be in the wrong voice. Move it to Voice 2.
Again, a quick way is to select it with the arrow tool, hold down [Option] and press [2].

The Score should now look like this.
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The Lower Staff

At the beginning of bar two, the notes in the lower staff are both pointing in the 
wrong direction. Remember that notes pointing up in the lower staff are in Voice 5 
and notes pointing down are in Voice 6.

1. Select each of the two notes and move them to the other voice.

Before and after shifting the voices of the notes.

2. The C3 is too short, make it a half note.
The rest after it disappears.

In the second half of the bar, the A#2 seems to have been played tied when it 
should have been two notes. Let’s split it up.

3. Select the Scissors from the Toolbox.

The Scissors tool in the Toolbox.

4. Click on the tied Bb2.
It is split into two notes.

Before and after splitting.

5. The Bb2 in the last bar should be on the upper staff. Move it to Voice 1.
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All the notes in the last bar are too short. Let’s lengthen them all at once.

1. Drag a selection rectangle around all the notes in the last bar.

A selection rectangle to select all the notes in the last bar.

2. Hold down [Command] and click on the whole note on the Score Toolbar.
All selected notes are set to the note value you clicked.

The notes in the last bar lengthened to whole notes.

Removing Rests and setting the Length of the piece

There are far too many rests. If you look at them they seem to appear in voice 2 and 5. 
Actually we don’t need any rests at all.

1. Open Staff Settings.

2. Click on the Edit button.

3. For Voice 2 and 5, deactivate the “Rests–Show” column.
The rests will now be hidden for these two voices.
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4. Make sure Auto Move To Voices is not activated, and click OK in this dialog and the one 
behind it.
Auto Move To Voices should be turned off since we don’t want to move any notes to new 
voices at this point when we’re almost done!

Auto Move To Voices should be turned off.

There’s one measure too many at the end. This is simply because the Part we re-
corded into is too long! We could shorten the Part in the Arrangement, but it’s even 
easier to remove the last bar from within Score Edit:

5. Make sure the Arrow tool is selected, hold down [Option] and [Shift] and click on the 
bar line before the last bar.
This moves the Song Position to the beginning of the fourth bar - check the Transport Bar, it 
should show “4.1.1.0”.

6. Pull down the Score menu and select “Remove Bar” from the Format submenu.
The bar is removed!

The score as it should look at this point.

Measure Widths and Note Positions

1. To adjust measure spacing, click the Auto Layout icon on the Score Toolbar.

The program selects widths for the bars, depending on their “density” of notes. Maybe you 
would like the bars to be a little wider, to make the piece even easier to read?

2. If you don’t have the regular arrow pointer selected, select it.

3. Position the pointer over the last bar line, press the mouse and drag a couple of centi-
meters to the right.
All the bars get proportionally expanded.

The Auto Layout button on the Score Toolbar.
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4. To adjust the width of the last bar only, hold down [Command] and drag the last bar 
line again.
Give it some space, we need room for the arpeggio.

The last bar shortened by dragging.

We will now use the Layout Tool. This allows you to move notes graphically, with-
out affecting their “musical” position. In other words, moving notes with the Layout 
Tool doesn’t affect playback.

5. Select the Layout Tool from the Toolbox.

The Layout Tool in the Toolbox.

6. Select 200% from the Scale pop-up menu to the right of the horizontal scroll bar.
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7. Use the scroll bar so that you can see the upper staff and the middle of measure 1.

The score in 200% magnification.

8. Drag the dotted quarter note to the left so that it winds up on top of the note just to the 
left of it.

Dragging the note with the Layout Tool. The second picture shows the final result.

9. Select 100% again.

Inserting Symbols

1. Pull down the Score menu, select “Symbol Palette” and from the submenu that ap-
pears, select “Dynamics”.
The Dynamics symbols palette appears.

2. Click on the mf symbol in the palette.
The Pencil tool is automatically selected. If the Pencil tool doesn’t appear, double click on the 
symbol instead (there is a preference for this, as described later in this manual).

The “Dynamics” part of the Symbol Palette, with the mezzo forte symbol selected.

3. Move the pointer into the score and click where the “mf” should be.
The mezzo forte symbol appears.

4. Select the arrow tool.

5. Select the first five notes in Voice 1 in the first bar.
You can do this by dragging a rectangle, or by holding down [Shift] and clicking.

6. Pull down the Do pop-up menu and select Insert Slur.
A slur is automatically created, spanning the selected notes. But it would look better if the 
slur was on the downside of the notes instead.
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7. With the slur symbol selected, pull down the Do pop-up menu and select “Flip”, until 
the slur is positioned right.

The slur as it should look.

8. Click or double click on the crescendo symbol in the Dynamic symbol palette so that 
the Pencil tool is selected again.

9. Point at the position where you want the crescendo to start, drag to the right and re-
lease the mouse button.
Repeat this for the other crescendo symbol, according to the picture on page 26.

10.From the Palette’s pop-up menu at the top, select “Note Symbols”.
The Palette window switches to show the Note Symbols palette.

11.Click or double click on the fermat we need, so that the Pencil tool is 
selected.

A fermat selected in the Palette.

12.Make sure Voice 1 is selected on the Score Toolbar.

13.Move the pointer into the score and click on the top note in the last chord in the upper 
staff.

Clicking on the note adds the fermat above it.

14.Select the regular arrow pointer and click on the top note on the lower staff. Move it to 
Voice 5, so that the other fermat that we are about to enter, will wind up above the 
note, not below.
Fermats are positioned after stem direction for the voice.

15.Click the fermat again in the Palette and click on the top note in the lower staff.
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16.From the Palette’s pop-up, select Line/Trill.

17.Click on the “arrow up” arpeggio.

18.Click just before the notes in the last measure.
The arpeggio appears.

An arpeggio with default length and handles visible.

19.To change the height and position of the arpeggio, drag the upper and lower handles.
If you can’t see any handles, click on the arpeggio using the regular arrow tool.

The final score.

Congratulations!

This completes the second tutorial which has introduced you such advanced topics 
as Polyphonic voicing, adding Symbols of various types and using the Layout Tool. 
If you understood the purpose of the steps above, you’ll have no problem getting 
the most out of Cubase Score’s many additional features!

Other Score Tutorials

The “Score Tutorials” folder contains several other files as well. These are Song files, 
each describing some aspect of the Score Editor. Exactly what is demonstrated in 
each tutorial is described in the Song’s Notepad (opened from the Edit menu). We 
recommend that you check out these tutorials, and use them in parallel with the man-
ual, because some features are more easily demonstrated within the program, than in 
words.
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3
The Basics
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In this Chapter you will learn:

• How to open the Score Editor.
• How to set up the Page Size and Margins.
• How to switch between Page and Edit Mode.
• How to hide and show the Symbols Palette, the Status bar and Score Toolbar.
• How to set up the Ruler.
• How to set a magnification factor.
• How to use the Score Preferences.

Preparations

1. In the Arrange window, create a Track for each Instrument.
Please note that you can prepare a piano (split) staff from a single Track, there’s no need to 
create one Track for the bass clef and one for the treble clef.

2. Name each Track after the Instrument.
This name can later be used in the Score if you like.

3. Record into the Tracks or create empty Parts on all Tracks.
You can make very long Parts that cover the entire piece, or you can start out with shorter 
Parts to begin with. If you choose the latter option, you can always go back and add new 
Parts or copy existing Parts later.

Opening Score Edit

Editing one Track

1. In the Arrange window, make sure no Parts are selected.
This is most easily done by clicking somewhere in an empty section of the Part display.

2. Click on the Track (in the Track list) so that it gets selected.

3. Select Score from the Edit menu or use a key command (by default [Command]-[R]).
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Editing several Tracks

There are two ways to do this:

From the Arrange Window:

1. Select all Parts on the Tracks you want to work on in the Score.
If you know you want to work on them all, you can use Select All on the Edit menu. You can 
edit up to 64 Tracks at a time.

2. Open the Score Editor.

With three Tracks, you get three instruments in Score Edit. Note that Tracks can be split into two 
staves, as is the case of the Piano Track in the picture above.

You will get one Staff for each Track, and you might create a split staff for one or 
more Tracks. In this way you can think of the Arrange windows as an overview of 
your entire score and the Tracks as representing one instrument each.
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From Score Edit

1. Open the Score Editor for a single Track.

2. Pull down the Score menu and open the “Display Tracks” submenu.
This submenu contains all non-empty MIDI and Drum Tracks in the Arrangement.

 

3. To display a Track in the Score Editor, select it from the pop-up menu.
Displayed Tracks are indicated by a check mark in the list. You can remove Tracks from the 
display by selecting them again from the pop-up menu.

This method allows you to work with different Track configurations without having 
to leave the Score Editor at all!

Editing one or several Parts

1. Select the Parts you want displayed in the Score.
You can select Parts freely on a Track if you want to work on a certain section. You can also 
select arbitrary Parts on several Tracks. Each Track will then be displayed on its own staff.

2. Select Score from the Edit menu or use a key command (by default [Command]-[R]).
If you have selected “Score” on the “Double click opens” pop-up menu in the Preferences–
General–Editors dialog, you can also double click on one of the selected Parts to open them 
in Score Edit.

Editing predefined combinations of Tracks

On page 265 you will find out how to open Score Edit with a certain combination of 
Tracks you have been editing before.
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The Song Position

The Song Position appears as a vertical line across the staff.

When you open Score Edit, the view is automatically scrolled so that the Song Posi-
tion is visible in the window. This means you don’t always see the beginning of the 
Track/Part when you first open Score Edit.

• You can move the Song Position by dragging it around.

• You can also hold down [Shift]+[Option] and click anywhere in the score to move the 
Song Position there.
This is handy if the Song Position pointer isn’t visible.

Page Mode

When you are preparing a score for printout, you should set the Score Editor to 
Page Mode. This is done by selecting Page Mode from the Score menu (if it doesn’t 
already say “Page Mode”).

Selecting Page Mode.

When you do this, the window switches to show you one page at a time, as it will 
appear on printout.

The lines around the score are the Printer margins, see below.

The Song Position pointer
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Page Mode vs. Edit Mode

All you can do in Edit Mode, you can do in Page Mode. But Page Mode offers a myr-
iad of additional features. For one thing, all the Tools are available.

The Toolbox in Page Mode.

❐ This section of the manual assumes you are in Page Mode. It will be mentioned explic-
itly if something in this text specifically relates to Edit Mode.

Using the Scroll Bars in Page Mode

In Page Mode, the scroll bars are used to scroll the image of the page inside the 
window.

Moving between pages in Page Mode

If your score takes up more than one page, you can skip between the pages in two 
ways:

• By using the page number indicator in the lower right corner.
The number can be scrolled, or you can double click and enter a new page number.

The Page Number indicator – scroll or double click to move to another page.

• By using key commands.
By default, the Page Up and Page Down buttons are used for this.

Playing Back and Recording

This is done exactly as in Edit mode (see the Getting Started book and the Score 
Edit chapter in the Getting into the Details document). 
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Changing Magnification

There are two general ways to change the magnification in Page Mode: by setting a 
magnification factor on the Scale pop-up menu or by using the Magnifying Glass 
tool.

Using the Scale Pop-up Menu

To the left of the Page Number Indicator you will find a pop-up allowing you to set 
the magnification factor. 

The magnification pop-up.

By zooming in you will be able to make detailed adjustments to symbols etc. By 
zooming out you will get a better overview.

• You can double click and type in a custom magnification factor. 
This custom magnification factor will remain on the pop-up menu until you specify a new 
one.

• If you select “Fit Page”, the magnification factor will be adjusted according to the win-
dow size, so that the whole page is visible.

• If you select “Fit Width”, the magnification factor will be adjusted according to the win-
dow width, so that the full width of the page is visible.

Using the Magnifying Glass tool

The Magnifying Glass tool in Score Edit works much like in the Arrangement:

• Click once with the Magnifying Glass to zoom in one step.

• Hold down [Option] and click once with the Magnifying Glass to zoom out one step.
When you press [Option], the Magnifying Glass is shown with a minus sign, to indicate that it 
will decrease magnification.

• Drag a rectangle with the Magnifying Glass to set a custom magnification.
The section encompassed by the rectangle is magnified to fill the window.
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The Active Staff

One thing to note when you are working with multiple staves is the Active Staff. 
Only one staff at a time can be active, and is indicated by a black rectangle to the 
left of the clef symbol.

Later on you will find out how to make settings that apply specifically to the active 
staff.

Making a Staff Active

There are two ways to make a staff active:

• Click anywhere in it.

• Use the up and down arrows on the computer keyboard to step through the staves.

About the Link button

At the upper left corner of the Score Edit window, you will find a button labelled 
Link. When this is activated, all other open editors will follow the Active staff selec-
tion in Score Edit. In other words, if you make a staff Active, the corresponding Part 
(or Track) will be automatically displayed in the other open editors as well.

This staff is active.

The Link button.



- 50 - 

Making Print and Page Setup settings

Before you start preparing the Score for printout, you will want to make some 
Printer and Page settings for your Song. You don’t have to do this as the first thing 
you do, but it’s a good working habit.

1. Select Page Setup from the File menu.
The regular Macintosh Page Setup dialog box appears. This is described in detail in the Ma-
cintosh documentation.

2. Select the preferred printer, paper size, orientation, etc.

3. Locate the Cubase VST-specific settings.
Depending on which Macintosh operating system you use, you may have to use a pop-up 
menu in the dialog to display these settings.

4. If you need to, change the margins by setting the Left, Right, Top and Bottom settings.
Please note that each printer has a minimum margin. To set the values automatically to this, 
click the Default Values button.

❐ If you set margins smaller than the Default values, not everything on the page might 
get printed!

5. If you want the left and right margin settings to be swapped on pages with even num-
bers, activate the “Toggle Margins” checkbox.
Use this if you are planning to print scores more than one page of length, and want to have 
opposite sides “symmetrically mirrored”.

• To make the Settings permanent, save the Song.
If you want new Songs to always start with certain Print and Page Setup settings, set up your 
Autoload Song as desired and Save it to make the change permanent.

Activate Toggle Margins by 
clicking in the checkbox.
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Designing your Work Space

Some of the areas in the window can be hidden or revealed. Exactly which areas 
you wish to see depends on what kind of work you are doing, and how big a moni-
tor you have.

These areas can be hidden/revealed.

The Info Line

The Info line displays information about the currently selected note. It can be hid-
den/revealed by clicking the Info button on the status bar, or by using the key com-
mand for “Note Info on/off” (set in the Preferences–Key Commands–Arrangement/
Editors dialog; by default [Option]+[Command]-[I]).

The Score Toolbar

The Score Toolbar can be revealed/hidden by clicking the button to the right of the 
“F” button on the horizontal scroll bar.

The “Show Invisible” Filter Bar

This area contains checkboxes for determining which indicators, handles and other 
“Invisible” elements should be shown in the score. You hide and show the Filter Bar 
by clicking the “F” button on the horizontal scroll bar.

The Status Bar

The Entire Status Bar (including Score Toolbar, Info Line and “Show Invisible” Filter 
Bar) can be hidden with the button at the far right on the horizontal scroll bar.

Ruler

Score Toolbar

Info Line

Status Bar

Show Invisible Filter
Bar

Click this button to hide/show the Score Toolbar.

Click this button to hide/show the Filter Bar.

Click this button to hide/show the Statusbar.
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“Tearing Off” the Score Toolbar

It is possible to “tear off” sections of the Score Toolbar and move them around as 
separate palettes on the screen:

1. Point at the handle next to a section and press the mouse button.

2. Drag the section off the Toolbar. 
It appears as a separate Palette window.

3. To close a Toolbar Palette window, click on its close box.
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The Ruler

In Score Edit there are no Meter/Time Position Rulers as in the other editors. In-
stead, there are horizontal and vertical “Graphic Rulers” in Page Mode. These help 
you position symbols and graphical objects in the scores.

• To set which units should be used on the Rulers, pull down the “Ruler” pop-up menu at 
the bottom of the window.
Choose between inches, centimeters or points.

• To hide the Rulers, select “Off” from the pop-up menu.

The Position Window

To help you further when positioning objects in the scores, Page Mode has a spe-
cial Position Window, in which you can view and adjust object positions numeri-
cally, in the unit selected for the Rulers. To show or hide the Position Window, click 
in the Ruler.
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The Symbol Palettes

The Symbol Palettes, which are used to add symbols to the Score, can be displayed 
by selecting any of the “Symbol Palettes” options from the Score menu.

• Just as with the Toolboxes, you can choose whether you want the Symbol Palette to be 
vertical or horizontal, by clicking on its Zoom box.
When the Palette is vertical, you can click in the area to pull down a pop-up menu with short-
cuts to the other Symbol Palettes.

• You close a Symbol Palette by clicking on its close box button.
If you want to close all open Palettes, select “Close All” from the Symbol Palettes submenu, or 
hold down [Option] and click on the close box button of one of the Palettes.
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Showing and Hiding “Invisible” Elements

Some of the elements in the score will not be printed, but rather serve as indicators 
for layout changes, handles, etc. These elements can be hidden or shown in any 
combination. There are two ways to do this:

• In the Show Invisible dialog, accessed from the Global Settings submenu on the Score 
menu.

• By using the Filter Bar above the Score Toolbar.
The Filter Bar is displayed or hidden with the “F” button (see page 51).

The Show Invisible dialog and the Filter Bar have the same checkboxes:

• You can check/uncheck all options by clicking the “Check/Uncheck All” button in the 
Show Invisible dialog.
In the Filter Bar, this is done by [Option]-clicking one of the checkboxes.

Option: Description:

Hidden Notes Reveals any notes you might have hidden (see page 274).

Quantize Displays markers in the score where you have made Display Quantize “exceptions” 
(see page 78).

Layout Tool Displays markers in the score where you have made adjustments with the Layout 
Tool (see page 173).

Grouping Displays markers in the score where you have made beam groupings (see page 
164).

Cutflag Displays markers in the score where you have inserted Cutflag Events (see page 
172).

Bar Handles Reveals the bar handles, used for copying bars (see page 211).

Hidden Displays markers in the score for each hidden element (notes excepted). See page 
274.

Split Rests Displays markers in the score wherever you have split multiple rests (see page 276).

Stems/Beams Displays markers in the score where you have made any stem or beam adjustments 
(see page 151 and page 170).
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Setting Key, Clef and Time Signature

When preparing for entering notes into a score, you will probably want to start out 
by setting the desired Key, Clef and Time Signature for the Staff. The text below as-
sumes you are working on one Track only. If you have multiple Staves, you either 
make this setting independently for each Staff or for all staves at once. See page 68 
for details.
Normally, all these symbols appear at the beginning of each staff. However, you 
can control this by using the Real Book option (see page 272) and by Hiding (see 
page 274).

Setting the Initial Time Signature

From within the Score

1. Double click on the Time Signature symbol at the beginning of the Staff.
A dialog box opens.

The Time Signature dialog with a 4/4 signature.

2. If the piece is in 4/4 or 2/2,you can select common time/cut time directly by clicking one 
of the two symbols at the right side.
This will set the Time Signature to 4/4 or 2/2, respectively, but also give you a common/cut 
time symbol on the staff.

3. If the piece is in any other time, set the numerator and denominator above and below 
the line, respectively.
The Numerator can consist of several numbers for composite Time Signatures. However, if 
the piece is in a simple time signature you only need to fill in the first number above the line. 
The more advanced options are described below.

• The “As Pickup Bar” option is described on page 279.

4. Click OK or press [Return].

❐ All Tracks share the Time Signature! In other words, when you set the Time Signature, 
you do this for all Tracks in the Arrangement.
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If you need to enter half a bar somewhere (for example) you have to make a Time 
Signature change (for example from 4/4 to 2/4 and back again). On page 116 you 
will find out how to input Time Signature changes.

Composite Time Signatures and the Grouping Option

For Composite Signatures, the Numerator can be made up of up to four groups. For 
example, ”4+4+3+/” on the upper line and 8 on the lower, means the Time Signa-
ture is 11/8.

The reason for dividing the Numerator into several numbers is to get beaming and 
tied notes displayed correctly automatically. This does not affect the Metronome or 
anything else, only beams and ties. For more information on Beaming, see page 163.

If “For Grouping Only” is not activated, the numerator will show all the numbers en-
tered. If it is activated, it will show the sum of the numbers entered, as for “simple” 
Time signatures. 

“For Grouping Only”, Off and On.

Note that Cubase VST tries to preserve the denominator when you insert a compos-
ite signature with “For Grouping Only” activated. This means that if you have a 4/4 
Time Signature, and change it to a composite value (3+3+2 eighths for example), 
the Time Signature will still be displayed as 4/4 instead of 8/8.

Setting the Time Signature from the Transport Bar

You can also set the Time Signature directly on the Transport Bar, as described in 
the main Cubase manual. Please note the following:

• The Time Signature box on the Transport Bar always displays the first Time Signature Event 
in the Master Track. When you change this value you are in fact editing the first Time Signa-
ture event in the Master Track.

• You can not create composite Time Signatures from the Transport Bar.

Setting the Time Signature by editing the Master Track

You can also add, edit and delete Time Signatures by editing the Master Track 
(which is described in its own chapter). Please note the following:

• The Score always shows the Time Signature events in the Master Track, regardless of 
whether or not the Master Button is activated. Likewise, any Time Signatures you create in 
the Score Edit will be shown in the Master Track.

• You can not create composite Time Signatures from the Master Track.

The Time Signature on the Transport bar.
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Setting the Initial Clef

Directly in the Score

1. Double click on the current Clef.
A dialog appears.

Double clicking on a clef brings up the clef dialog.

2. Use the scroll bar to select one Clef.

❐ This does not work if Auto Clef is activated in the Staff settings dialog box, see below.

3. Repeat the steps above for all staves in the system.

• If you wish, you can set a Display Transpose value in this dialog.

In the Staff Settings Dialog Box

1. Double click just to the left of the Staff, or select Staff Settings from the Score menu.
A dialog box appears showing the current settings for the active Staff.

2. Locate the Key/Clef section.

The Key/Clef section of Staff Settings.

3. Use the left scroll bar to select one of the available Clefs.
You will find out how to insert Clef changes on page 116.
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4. Click the “Prev” and “Next” buttons or use the Up and Down arrow keys on the com-
puter keyboard to step around among the staves and make settings for each one.
The name of the Track you currently make settings for is displayed in the window title.

5. Click OK or press [Return], to close the dialog.

In a Split System

If you have a Split System (see page 114 and page 135) you can of course set differ-
ent Clefs for the Upper and Lower Staff.

1. Open Staff Settings.

2. Select a Clef for the upper staff.

3. Activate the “Lower Staff” check box.

4. Set a clef for the Lower Staff.

Using Auto Clef

Auto Clef activated in Staff Settings.

In the Staff settings dialog you will also note one option called Auto Clef. If this is 
activated, the program will automatically select a Treble Clef or a Bass Clef for the 
Staff, depending on in which range the notes in the Part fall.
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Setting the Initial Key

In the Staff Settings Dialog Box

1. Double click just to the left of the Staff, or select Staff Settings from the Score menu.
The Staff settings dialog box appears.

The Staff Settings dialog box.

2. Use the right scroll bar in the Key/Clef section of the dialog box to select one of the 
Keys.

3. Click the “Prev” and “Next” buttons or use the Up and Down arrow keys to step around 
among the staves and make settings for each one.
The name of the Track you are currently making settings for is displayed in the window title.

4. Click OK or press [Return] to close the dialog.

❐ If you want to set all staves in the Score to the same key (which you probably do), 
there’s a short-cut: Select the desired key for one of the staves, hold down [Option] and 
click OK.



- 61 - 

Setting The Key For A Split System

You might have a Split System (see page 114 and page 135) with two staves.

1. Open Staff Settings.

2. Set a Key for the upper staff.
This will make the Lower staff automatically be set to the same key.

3. If you need to set a different key for the Lower staff, activate the “Lower Staff” check 
box and set a clef for this.

The Lower Staff check box.

Directly in the Score

If the current key is anything but C major/A minor (no accidentals) you can set the 
key directly in the Score:

1. Double click on one of the current accidentals at the beginning of a staff.

A dialog appears.

2. Use the scroll bar to select a key.

• If you wish, you can set a Display Transpose value in this dialog.

3. Repeat for all staves.
You will find out how to insert Key changes on page 116.

Double click in this area



- 62 - 

Working with Transposing Instruments

Some instruments, for example a lot of brass instruments, are written transposed. 
For this purpose, there is a Display Transpose function in the Score Editor. By set-
ting this, you transpose the notes in the score, without affecting how the notes play 
back. This allows you to record and play back a multi stave Arrangement, and still 
score each instrument according to its own transposition.

Setting Display Transpose

1. Double click just to the left of the Staff, or select Staff Settings from the pop-up Staff 
menu.
A dialog box appears showing the current settings for the active Staff.

2. Click the “Staff Options...” button.
The Staff Options dialog appears.

3. Select your instrument from the pop-up below the text “Display Transpose” or scroll 
the value directly.

The Display Transpose section in the Staff Options dialog.

❐ Please note that if you select an instrument that shares a transposition value with 
other instruments, the first instrument on the menu is shown.

4.  If needed, select a new Staff using the Up and Down arrow keys or click Exit and use 
the “Prev” and “Next” buttons and then click “Staff Options...” again.

5. Click Exit.
Note that the key signature is automatically adjusted to fit the transposition.

6. Repeat to set the Display Transposition for other staves, as needed.

7. Click OK or press [Return] to close the Staff Settings dialog.

❐ Display Transpose does not affect MIDI Playback!

Display Transpose in the Key dialog

If you want to change the Display Transpose setting in the middle of the score, you 
can do this by inserting a Key change (see page 116). In the Key dialog you will find a 
Display Transpose field, in which you can enter a transposition value in semitones. 
This is handy, if you are writing a saxophone part and want the player to switch from 
alto to soprano saxophone, for example.
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Working Order

When you prepare a Score we suggest you do things in the following order, because 
it will minimize the time needed if you make a mistake somewhere and need to redo 
a step. Try our suggestion first, and if you think another method suits your particular 
working situation better, go ahead and do it!

• Preferably work on copies of recorded Tracks.
If the parts are fairly complex you might need to make permanent editing after which they 
don’t play back as they originally did.

• If memory is short, break the score up into segments.
You might for example use Split at Locators to split the Parts across all Tracks.

• Put the Tracks in the Arrange window in the order you want them in the score.
You can not rearrange the order of systems in the Score Editor. However, you can go back 
and change the order in the Arrange window.

• When you open Score Edit, start by making the adjustments described in this chapter.
You should always begin by setting page margins, etc.

• If you have recorded music into Tracks already, try adjusting the score “picture” as 
much as possible without permanently editing the notes.
Use Staff settings, Display Quantize, Grouping etc.

• If the Tracks are empty, make basic Staff settings, enter the notes and then make de-
tailed adjustments, add Display Quantize etc.

• If needed, use Polyphonic Voicing to resolve overlapping notes, to create piano sys-
tems, to handle crossing voices etc.

• When all this is done, decide if you need to perform “destructive” editing.
You might for example have to permanently alter the length of some of the recorded notes.

• Hide unwanted objects and add note dependant and note related symbols.
This includes accents, dynamic symbols, crescendo, slurs, lyrics, “graphic rests” etc.

• Work through the score and adjust the number of bars across the page.

• Adjust the vertical spacing between staves and grand staves.
Both the steps above can be performed automatically by the program using the Auto Layout 
features.

• Add Layout symbols like endings, page text, etc.

• Print.

• Go back and create alternative Layouts to extract voices etc.
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Force Update

If for some reason, the screen isn’t redrawn properly (as a result of the computer’s 
recalculation of the page’s appearance), this menu item on the Score menu forces a 
total redraw of the whole page.You can also force an update by clicking on the Up-
date button on the Tool Bar.

About the Score Preferences

There are a lot of settings which affect the look of the scores as well as the working 
techniques in Score Edit. These settings are gathered in the Preferences–Score dia-
log on the Edit menu.

The Preferences-Scores-Chord Types dialog box.

As with other Preferences, the Score Preferences are divided into several pages, ac-
cessed by using the pop-up menu in the dialog.When we refer to the Preferences in 
this manual, we use the following syntax: Preferences–Score–Page name.

For most of the settings, you can decide whether you want to save them with the 
Song or in the Cubase VST preferences, by activating or deactivating the checkbox 
“Save with Song” (see the Getting Started book).

❐ For a complete listing of the Score Preferences, see the Menu and Dialog Reference 
document.

The Update button

Use the pop-up to change page.
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4
Transcribing MIDI Recordings
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In this Chapter you will learn:

• How to make initial Staff Settings to make a Score as legible as possible.
• How to use the Display Quantize Tool to handle “exceptions” in the score.
• How to resolve parts that contain mixed notes and triplets.

About Transcription

This chapter assumes you have a MIDI recording which you want to transform into 
a printable score. However, if the parts are fairly complicated, you will probably 
need to perform some manual editing of the notes. Hence you will need to read the 
next chapter too!

❐ Before starting, make sure you understand the basic principles behind the Score 
notes/MIDI notes relationship and also what Display Quantize is, as described in “How 
the Score Editor works”.

Getting the Parts Ready

1. Record the music.
You must definitely play in time with the Click.

2. Play back to check that the music got recorded as intended.
If not, you might need to re-record or perform some editing.

3. Decide how much permanent alteration to the recording you can accept to make the 
score look good.
If the answer is “none”, you should prepare your score from a copy of the Track. See the 
“Strategies” section below.

4. Select all Parts (on all Tracks) that you wish to work on.
It is also possible to add and remove Tracks from within Score Edit using the Display Tracks 
function on the Score menu.

5. Select Score from the Edit menu.

6. Switch to Page Mode.
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Strategies: Preparing Parts for Score Printout

Below follow a few tips that you might want to refer to when preparing a piece for 
printout:

• If a part is complex, you might possibly have to do some “manual” editing of notes, like for ex-
ample moving them or changing their lengths (see next chapter). This means that the record-
ing will then not play back exactly as it originally did. If this is a problem, we suggest you work 
on a copy of the recording. Use Track copying to create a version of the Track for scoring. Re-
name the Track and mute the original Track while you are preparing the score. If you prefer to 
work on a copy of the entire Arrangement, save the Arrangement and reopen it (that way, 
your Song will contain two Arrangements, the “play version” and the “print version”).

• For reasons described in the previous chapter, quantizing the Track might be a good idea. 
This will reduce the amount of detailed adjustments needed in Score Edit. Remember that 
you can always prepare the score from copies of the original Tracks, as described above.

• If you need to quantize, always play back your Tracks afterwards to make sure timing wasn’t 
disrupted due to an inappropriate Quantize value. You might have to quantize some sec-
tions with one value and others with another.

• If the piece contains many repetitions, it might be quicker to initially just record one instance 
of them each. If you then finish the Score work on each section, you can assemble the entire 
piece by working with Parts in the Arrange window. This might save you some time since 
you might only have to perform detailed adjustments to each section once.

• A similar approach can also be used when you are creating sections where several instru-
ments play the same rhythm (a horn section, for example): Record the first instrument and 
make adjustments so that it looks like it should in Score Edit. Then copy the Part to the other 
Tracks, and change the pitches of the notes using MIDI Input. Finally, go through the copied 
Parts and make fine adjustments, change Display Transpose settings, etc. This can be a very 
fast way to create polyphonic parts with complicated rhythms.

• There may also be situations when the quickest way to record a part for several instruments, 
is to simply record it in one go, by playing the chords on your MIDI instrument. If you later 
want to split the recording into separate Tracks or Polyphonic Voices, you can use the Ex-
plode function, as described on page 82.
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Staff Settings

The first thing you do after opening the Score Editor is to make some initial Staff 
settings.

Opening the Staff Settings Dialog

There are four ways to display the Track Staff settings:

• Make the staff active and select Staff Settings from the Score menu.

• Double click to the left of the staff.

• Make the staff active and select “Get Info” from the Edit menu.

• Make the staff active and click on the “i” button on the Score Toolbar.
If you use the last two methods, make sure no notes or symbols are selected!

Either way, the Staff settings dialog appears and shows the current settings for the 
Staff:

The Staff Settings for a Track called “MIDI 1”.
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Stepping between Tracks/staves

If you have multiple staves you might want to move the Staff settings indicator up 
and down without closing the dialog:

1. Note in the title of the dialog box which Staff/Track is currently selected.

2. To move the Staff settings indicator one staff down, click the Next button or press the 
arrow down key on the computer keyboard.

3. To move it one staff up, click the Prev button or press the arrow up key on the com-
puter keyboard.
If there’s no staff above/below the current, one or both the buttons may be greyed out.

In the lower left corner of Staff Settings you find the Next and Prev buttons.

When you step through the staves, the dialog gets updated to show the settings 
for the Track. However, it always shows the Staff settings (the ones valid for the en-
tire Track), never the “exceptions” you might have inserted using the Display Quan-
tize tool (see page 78).

❐ Stepping between Staves this way is the same as clicking “OK” and opening Staff Set-
tings for another Staff. This means that any settings you have made to a Staff is made 
permanent when you select another Staff - pressing Cancel will only restore the set-
tings for the last selected Staff.

Making Settings for Multiple Staves at once

If you hold down [Option] when you click OK to close Staff settings, the settings you 
have made are copied to all staves currently in the score. This can be used for 
quickly making settings that are common to all staves on a grand staff.

1. Open Staff Settings.

2. Adjust all the parameters that are common to all Staves.
This might for example be Key Signature, Display Quantize, Syncopation handling, Shuffle, 
Beaming etc.

3. Hold down [Option] and close the dialog.

4. Open Staff settings again for each staff and make the adjustments particular to that 
staff.
This might for example include Clef and Display Transpose (for brass, etc.).

5. Close by clicking OK.
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Staff Presets

When you know you will reuse settings made for one Track in other Tracks, you will 
save some time by creating a Staff Preset. This is described on page 122.

Key And Clef

The basic Key and Clef Track Staff settings are described in detail on page 56. There 
is also a Lower Staff check box which is only used in conjunction with Piano (Split) 
Staves and Polyphonic Voicing. This is described on page 59.

Display Quantize

The Display Quantize settings.

This is where you give the program basic information about how to interpret your 
playing. There are “fixed” Display Quantize values plus an “Auto” option which 
should only be used when your music contains mixed straight notes and triplets. 
For background information about Display Quantize, see page 10.

If your music only contains “Straight” Notes or Triplets

1. Set the Note Quantize value according to the “smallest note position” you want to be 
shown in the score.
For example, if you have notes on odd sixteenth note positions, the Note Display Quantize 
value should be set to 16 (sixteenth notes). The “T” values on the pop-up are for triplets.

2. Set the Rest Quantize value according to the smallest note value (length) you want to 
be displayed for a single note, positioned on a beat.
For example, if you want a single short note on a beat (quarter note position) to be displayed 
as a quarter note, set the Rest Quantize value to 4 (quarter notes).

3. Deactivate the Auto Quantize option.

4. Set all the Interpretation Flags.
These are described in detail below.

5. Examine the score.

6. If necessary, use the Quantize tool to insert “exceptions” to the Staff settings.
See page 78.
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If your music contains Mixed Straight Notes and Triplets

1. Examine the score and decide if it mainly contains triplets or mainly “straight” notes.

2. Set the Note Quantize Value accordingly.
If the score is mainly triplets, select the smallest triplet note position used in the score. If it is 
mainly straight notes, select the smallest “ordinary” note position.

3. Set the Rest Quantize value.
This is done according to the same rules as above.

4. Activate the Auto Quantize option.

5. Turn on the Deviation (”Dev.”) and Adapt flags if you need them
When Deviation is activated, triplets/straight notes will be detected even if they are not ex-
actly “on the beat”. However, if you know your triplets/straight notes are perfectly recorded 
(quantized or entered by hand), turn this off.
When Adapt is activated, the program “guesses” that when one triplet is found, there are 
probably more triplets surrounding it. Turn this on if not all of your triplets are detected.

Interpretation Flags

The Interpretation Flags

Clean Lengths

When this is turned on, the program interprets the length of your notes differently 
than otherwise. A note’s length (in the display only) might be extended to the be-
ginning of the next note or to the next Rest Quantize “position”. An example:

• If a note is too short, you will get a rest just after it.
• When Clean Lengths is turned on, the rest will disappear.

A slightly short eighth note with Clean Lengths off and on.

If using Clean Lengths doesn’t help in a particular situation, you will have to manu-
ally resize the offending note(s) or use the Display Quantize tool (see page 78).
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No Overlap

When notes starting at the same position have different lengths, the program gen-
erally adds more ties than you may want. This can be avoided by using No Overlap.

This recording in Key Edit...

...will be displayed like this when No Overlap is off...

...and like this when No Overlap is On.

You can insert “exceptions” to the No Overlap setting in Staff settings, by using the 
Display Quantize Tool.

❐ Please note that there will probably be situations when neither of these alternatives is 
ideal. If you run into such a situation, it can probably be resolved by using Polyphonic 
Voices, see page 129.

Syncopation

When syncopation is off, the program generally adds ties to long notes crossing 
beats. There are a few exceptions to this. For example, a half note starting at “2” in 
4/4 is always displayed as a half note, never as two tied quarter notes.

If you want more “modern” notation of syncopated notes, turn on Syncopation.

Syncopation off, and on.

Again, Syncopation off, and on.
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Please note that you can insert “exceptions” to the Syncopation setting in Staff Set-
tings, by using the Display Quantize Tool. You could also create tied notes in vari-
ous combinations by using the Cutflag tool.

Shuffle

In jazz it is very common to score a shuffled beat as straight notes, simply to make it 
more legible. 

When the Shuffle flag is turned on, Cubase searches for groups consisting of a quar-
ter note triplet followed by an eighth note triplet or groups of an eighth note and a 
sixteenth note triplet. If it finds one, it displays the group using regular eighth notes 
or sixteenths.

Shuffle Off and On.
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Staff Options

The “Staff Options” dialog.

When you click the “Staff Options” Button in the Staff Settings dialog, another dialog 
opens up with additional Staff Settings (which can be made part of a Staff Preset just 
as the other settings). Below follows a brief description of these, with references to 
more detailed explanations:

Staff Options Switches

Activate This: When:

Flat Beams When you want the beams over notes to be flat (as opposed to slanted). 
See page 169.

No Beams When you don’t want any beaming at all on the staff (for example for vocal 
scoring). See page 163.

Beam Subgroups When you want sixteenth notes displayed under a beam to be divided into 
groups of four notes. See page 169.

Beam Subgroups Off and On

16th Subgroups When you want even smaller subgroups of sixteenth notes. This setting 
has no effect if Beam Subgroups is turned off.

As above, but with 16th Subgroups activated.
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System

This section allows you to set the number of system lines and to control spacing be-
tween the lines. See page 308 for an example of how this can be used with Tabla-
ture.

Fixed Stem Length

Activate this if you want all note stems to end at the same vertical position.

Drum Map Options

These settings are all described in the chapter “Drum Scoring”.

Tablature

Activate this to create tablature scores.

Display Transpose

• The numerical setting is used to transpose the score up or down without affecting playback 
and without actually transposing the MIDI data.

• The pop-up menu contains a number of preset transposition values for common instru-
ments which are scored transposed.

More details on page 62.

Consolidate Rests When you want small consecutive rests joined into one (an eight note rest 
and a sixteenth note rest joined to a dotted eighth note rest for example). 

Consolidate Rests Off and On.

Activate This: When:
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Situations which require Additional Techniques

The notes may not always appear in the score as you expect them to, initially. This is 
because there are a number of situations which require special techniques and set-
tings. Below follows a list of some of these and where to find more information 
about handling them:

• Notes at the same position are considered parts of a chord. To get independent voicing (for 
example notes with different stem directions), such as for vocal material, you need to use the 
special Polyphonic Voicing feature described on page 129.

Without and with Polyphonic Voicing.

• If two notes beginning at the same position have different lengths, the longer one will be 
displayed as a number of tied notes. To avoid this, you will either have to use the “No Over-
lap” feature (see page 72) or polyphonic voicing (see page 129).

• For details of handling crossing voices, see page 145.
• One note will often be displayed as two notes with a tie. This is only how the program dis-

plays the note, there is still only a single note “stored”.

This single note in Key Edit is displayed as two tied notes in Score Edit.

• Generally the program adds ties where necessary (if a note stretches over a beat), but not al-
ways. For more “modern” notation of syncopated notes (less ties), you will need to use the 
Syncopation feature described on page 72.

The same note, without and with Syncopation.

• If you find that you want a long note to be displayed as two or more tied notes, you can 
achieve this with the Cutflag tool. See page 172.

• If two notes on the same position are too close to each other or if you want their order in the 
part reversed, you can do this without affecting playback. See page 173.

• If a note has the wrong accidental, this can be changed. See page 156.
• Stem direction and length is automatic, but you can change it manually if you wish. See page 

150.
• If you are scoring for piano and therefore (or for other reasons) need a split staff. There are 

special techniques for this, described on page 114 and page 129.
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If you run into Trouble

Below follows a few simple troubleshooting steps that will help you pinpoint other 
common problems:

• The note I recorded is displayed with the wrong length. For example, I recorded a six-
teenth and got a quarter note.
You probably have the wrong Display Quantize value set, see page 70 for details. If you feel 
insecure about what Display Quantize is, and how it works, please read “How the Score Edi-
tor works”. If Overlap is on, you might want to turn it off.

• There is a pause after a note that I don’t want.
The note is probably too short. This can be adjusted in two ways, by using Clean Lengths (see 
page 71) or by manually lengthening it (see page 110). If this problem occurs a lot in your 
score, try selecting a larger Rest Display Quantize value (see page 12).

• There is no pause after the note although there should be one.
Either the note is too long (use Clean Lengths or change the current note’s length). Or, your 
Rest Display Quantize value is set too high. Open Staff Settings and lower it.

• The note has an accidental when it shouldn’t, or it doesn’t when it should.
Enharmonic shifting is discussed on page 156.

• Notes are not grouped under beams the way I want it.
Normally the program groups eighth notes, sixteenths etc. under beams. This can be turned 
off. There is also detailed control of which notes are grouped under a beam. This is all de-
scribed on page 163.
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Inserting Display Quantize Changes

There are instances when you will want different Staff Settings on different sections 
of the Track. The Staff Settings are valid for the entire Track, but you can insert 
changes wherever you like. There are two ways to do this:

By using the Display Quantize Tool

1. Select the Display Quantize Tool from the Toolbox.

The Display Quantize Tool in the Toolbox.

2. Move the mouse over the Staff where you want to insert a new Display Quantize value.

3. Use the mouse position box to find the exact location.
The vertical position is of no relevance as long as you click somewhere in the staff.

Only horizontal position matters when you use the Display Quantize Tool.
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4. Click the mouse button.
The Display Quantize dialog appears.

5. Activate the flags you need and set the Quantize values as desired.
Details are found on page 70 and page 71. Additional hints below.

6. If you want to restore the settings to the ones used in the Staff Settings, click on “Re-
store to Staff”.

7. Click OK (if you use Polyphonic Voices, see below).
The new Quantize Settings are now inserted into the Staff at the position indicated in the dia-
log. The settings are valid until a new change is inserted. You will see a text “marker” below the 
notes that indicates that a Display Quantize change has been inserted (if you don’t see this, 
check the Show Invisible settings, as described below).

Using the Do Pop-up Menu

When using this method, there is one important difference: The Display Quantize 
Events have a length. That is, the settings you make will affect a finite section of the 
score only. After the “end” of such a Display Quantize Event, the Display Quantize 
settings are restored to the Staff Settings.

1. Select the notes that you want to be affected by the Display Quantize settings.
This selection is used to automatically set the “Length” of the Display Quantize change. In 
other words, it is really only the first and last selected notes that count - all notes in between 
these will be affected.

2. Pull down the Do pop-up menu and select “Insert Quantize...”.
The Display Quantize dialog appears.

3. Make the desired Display Quantize settings.

4. Click OK (if you use Polyphonic Voices, see below).
A Display Quantize Event is inserted, encompassing the selected Events.
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Display Quantize and Polyphonic Voices

If you use Polyphonic Voices (see page 129) you can choose whether you want to 
apply the settings to all Voices or only to the one that is currently selected.

• If you click on the “All Voices” button, one event is inserted for each Voice.
• If you click OK, only one event is inserted, into the current Voice.

For more details see page 143.

❐ Note that if the option “Display Quantize Tool affects All Voices” is activated in the 
Preferences–Score–Additional Settings dialog, all voices will be affected even if you 
click OK.

Hiding Display Quantize Events

When you insert Display Quantize events, text “markers” appear below the notes as 
an indication. These will not be printed, but you might want to hide them anyway:

1. Select “Show Invisible” from the Global Settings submenu on the Score menu.

The “Show Invisible” dialog.

2. In the dialog, turn off “Quantize”.

3. Close the dialog.

If you later want to view the Display Quantize indications in the score, simply check 
this option. 

❐ If you want to be able to edit or delete your inserted Display Quantize values, the 
markers need to be visible.

You can also hide and show “Invisible” elements using the “Show Invisible” Filter 
Bar, as described on page 55.
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Editing Display Quantize changes

1. Make sure the Display Quantize changes are visible in the score.
See above.

2. Double click on a Display Quantize indication.
The Insert Quantize dialog box appears.

3. Change the settings in the dialog box as described above.

• If the edited Display Quantize Event was created using the “Insert Quantize” command 
on the Do pop-up menu, the dialog will contain a ”Length” field.
This allows you to adjust the length of the Display Quantize Event, i.e. how large a section it 
should encompass. Setting Length to 0 effectively converts the Event to a “standard” Display 
Quantize Event, i.e. an Event without Length (valid until the next Display Quantize Event).

4. Click OK.

Deleting Display Quantize changes

1. Make sure the Display Quantize changes are visible in the score.
See above.

2. Click on a Display Quantize with the Eraser or select it with the arrow tool and hit 
[Backspace] on the computer keyboard.

A selected Display Quantize event.

Strategies: Adding Display Quantize changes

Very often, the score will be fine except for a few bars somewhere. Select the bars in 
question and insert a Display Quantize from the Do pop-up menu, to remedy the 
problem.

If you have mixed triplets and straight notes, it can be tempting to insert many dis-
play Quantize changes. Before you do so, try the Auto Quantize options and their 
additional settings. See page 71.
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The Explode Function

This function allows you to “split” the notes on a staff into separate Tracks. It is also 
possible to use this function to convert a polyphonic staff into Polyphonic Voices. 
However, in that case, the functionality is in many ways identical to that in the Poly-
phonic Voices dialog, therefore we refer to page 135. Below follows only a descrip-
tion of how to split the notes on a staff into several Tracks.

❐ You may want to create a copy of the original Track first, since this will be changed by 
the operation.

1. Pull down the Score menu and select “Explode...” from the Staff Functions submenu.

The Explode dialog, set to create Tracks.

2. Make sure “To New Tracks” is selected at the top of the dialog.

3. Select the number of new Tracks desired, in the value field just below this.
Note that this is the number of new Tracks to be created! For example, if you have a three-
part polyphonic section and want to split this into three separate Tracks, you should specify 
2 new Tracks, since the original Track will hold one of the parts.

4. Use the lower half to set up the criteria for the split.
Choose from the following options:

Option: Explanation:

Split Note Use this to move all notes below a certain pitch to another Track. When this is se-
lected, it is pointless to specify more than 1 new Track.

Lines To Tracks Use this when you want all musical “lines” to be put on one Track each. The 
notes with the highest pitch will remain on the original Track, the notes with the 
second highest pitch will be put on the first new Track, and so on. 

Bass To Lowest When this is activated, the lowest notes will always end up on the lowest Track.
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5. Click OK.
A number of new Tracks are now added to the Score and the Arrange window. The names of 
the new Tracks are derived from the name of the processed Part. “Vocal” might for example 
become “Vocal_1”, “Vocal_2” and “Vocal_3”.

Using “Score Notes To MIDI”

For very complicated scores, there might be situations where you have tweaked 
the parameters for Display Quantize and Interpretation best you can, and you still 
can’t get the score exactly as you want it. Perhaps one setting works fine in one sec-
tion of the Track and another is needed for another section.

In this case, “Score Notes To MIDI” will help you out. It changes the lengths and po-
sition of some or all the MIDI notes in the Track so that they have exactly the values 
currently shown on screen.

1. For safety, go back to the Arrange window and make a copy of the Track.

2. Open the Track again, in the Score Editor.

3. Make sure the notes you want to affect are not Hidden (see page 274).

4. If you want only a part of the score “converted”, use the To pop-up menu.
By setting this up and perhaps selecting some notes, you can “convert” only the selected 
notes, only the notes inside the Cycle, etc. If you want all notes affected, make sure the menu 
says “All”.

5. Select “Score Notes To MIDI” from the Format submenu on the Score menu.
The notes are now “converted”.

6. Make whatever adjustments that are needed to make the score read back as intended.

Now that the notes have the exact lengths and positions that were previously only 
displayed, you can probably turn off many of the options in Staff settings and de-
lete Display Quantize settings etc.

If you find the operation didn’t give you the result you were after, you can go back 
to the original Track, make a copy of that, and start over.
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5
Entering and Editing Notes using the Mouse
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In this Chapter you will learn:

• How to make various settings for how notes are displayed.
• How to enter notes by using the mouse.
• How to use tools and settings to make the score as legible as possible.
• How to set up a split (piano) staff.
• How to work with multiple staves.

Staff Settings

Before you start entering notes, you need to make some initial Staff settings in ad-
dition to those described in “The Basics”. In order for you to understand why, and 
how these settings and the note data in the score interact, please read “How the 
Score Editor works”.

Opening the Staff Settings Dialog

There are four ways of displaying the Staff settings for the Active staff.

• Make the staff active and select Staff Settings from the Score menu.

Opening Staff Settings from the pop-up menu.

• Double click to the left of the staff.

• Make the staff active (with no objects selected) and press [Command]-[I] on the com-
puter keyboard.
This is the default key command for “Get Info” - as always, you can choose another key com-
mand for this if you like.

• Make the staff active (with no objects selected) and click on the “i” icon on the Score 
Toolbar.

Double click in this area
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Either way, the Staff settings dialog appears and shows the current settings for the 
Staff.

The Staff Settings dialog box.

Stepping between Tracks/staves

If you have multiple Staves, you might want to move the Staff settings indicator up 
and down without closing the dialog:

1. Note in the title of the dialog box which Staff/Track is currently selected.

2. To move the Staff settings indicator one staff down, press the Next button or press the 
down arrow key on the computer keyboard.

3. To move it one staff up, press the Prev button or use the up arrow key on the computer 
keyboard.
If there’s no staff above/below the current, one or both the Next/Prev buttons may be 
greyed out.

When you step through the staves, the dialog gets updated to show the settings 
for the Track. However, it always shows the Staff settings (the ones valid for the en-
tire Track), never the “exceptions” you might have inserted using the Display Quan-
tize tool.
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Staff Presets

If you know you will reuse the settings you now make, on other Tracks, you should 
probably take the time to turn the settings into a Staff Preset. This is described in 
detail on page 122.

Suggested Initial Settings

When you start out entering notes using the mouse, you should set up the Staff set-
tings to make your score display the notes as entered. We suggest the following:

You will later find out how to adapt these settings in detail to make the score read 
as you wish it to be.

❐ It is “extremely important” that you understand how Note and Rest Display Quantize 
interact with the score. If you select too large a note/rest value, the notes you “click in” 
will not appear as intended. Please read the chapter “How Score Edit works”. If you 
have mixed triplets and straight notes, please refer to page 70.

Parameter: Setting:

Staff Mode Single (for split staves, see page 114)

Display Quantize: Notes 64

Display Quantize Rests 64

Auto Quant Activated only if you have mixed “straight” notes and triplets.

Clean Lengths Off

No Overlap Off

Syncopation Off

Shuffle Off

Key As desired

Clef As desired

Auto Clef Activate this if you want the program to select a treble or bass clef 
automatically.

Staff Options... As is
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Note Values and Positions

Two of the most important settings for entering notes (and the ones you will 
change most often) are the length of the note (the Note value) and the minimum 
spacing between notes (the Snap value).

Selecting a Note Value for Input

This can be done in one of three ways:

• By clicking the note symbols on the Score Toolbar.
You can select any note value from 1/1 to 1/128th and turn on and off the dotted and triplet 
options by clicking the two boxes to the right of the regular note values. The selected note 
value is always displayed in the Quant box and in the Note Tool cursor shape.

The Note Value is reflected in the Score Toolbar, the Quant Box and the Note Tool shape.

• By selecting a Quantize value from the Quant pop-up.

The Quant pop-up.

• By pressing numeric keys on the typewriter part of the computer keyboard.

This last method also sets the Snap (see below) to the same value, which may not 
always be desired. The default key commands are:

❐ The keys referred to above are the numeric keys on the typewriter keyboard (above 
the letters), not those on the numeric key pad (to the right of the typewriter keyboard).

• You can also use key commands to “step” between the Quantize values.
Assign key commands for this in the Preferences–Key Commands–Score dialog (“Next/Last 
Quantize Value”).

Key: Note Value: Key: Note Value:

1 1/1 6 1/32

2 1/2 7 1/64

3 1/4 8 1/128

4 1/8 T Turn on/off triplet

5 1/16 . Turn on/off dotted
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About unusual Note Values

Not all note values can be selected directly, for example double dotted notes. Such 
notes are created by changing the length of the note after you have put it in (see 
page 110), by gluing notes together (see page 111) or by using the Display Length 
feature.

Selecting a Snap Value

Snaps and Note Positions

When you move the mouse pointer over the score, you will see that the position 
box on the Status Bar tracks your movement and shows the current position in 
bars, beats, sixteenth notes and ticks. As described later, when drawing and mov-
ing notes, the positions on screen are restricted in the same way.

Positioning on screen is controlled by the current Snap value. If you for example set 
Snap to “8” you can only insert and move notes to eighth note positions, at quarter 
notes, at half bars or at bar positions. It is a good strategy to set Snap to the smallest 
note value in the piece. This doesn’t stop you from inputting notes at “coarser” po-
sitions. However, if you set the Snap value to too small a note value, it is easier to 
make mistakes.

Setting the Snap Value

The Snap value can be set in one of two ways:

• By Selecting a value from the Snap pop-up.

The Snap pop-up.

• By pressing numeric keys on the typewriter part of the computer keyboard.
This sets the Quantize to the same value. Which keys select which Note values is described 
above.

❐ Using the Snap pop-up menu, it is also possible to snap to frames, seconds or to the se-
lected Groove. However, this is not often used when inputting score notes.

With Snap set to “8”, you can only 
input notes at eighth note positions.
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The “Mouse Position Box”

While you might most often use the graphical position in the actual score to deter-
mine where the notes go, there are instances when you will want to verify the posi-
tion numerically by looking at the mouse position box:

❐ This assumes that the mouse position box displays meter position. If it shows time po-
sition, just click on it to switch back to meter position.

• The first number is the Bar.
• The second number is the beat. In 4/4 there are 4 beats to a measure. In 8/8 there are eight, 

in 6/8 there are six, etc.
• The third number is the sixteenth note within the beat. Again, the time signature determines 

the number of sixteenth notes to each beat. In a quarter note based time signature (4/4, 2/4, 
etc.) there are four sixteenth notes to each beat, in an eighth note based time signature (3/8, 
4/8, etc.), there are two sixteenth notes, etc.

• The last value is in ticks. As everywhere in Cubase VST, the number of ticks depends on the 
Display Resolution setting in the Preferences–General–General dialog. The figures below 
show the meter position values as displayed when the maximum Display Resolution (15360) 
is selected:

Quarter Note positions.

Eighth Note positions.

Eighth Note Triplet positions.

Sixteenth Note positions.

2/2
4/4
8/8

1.1.1.0 1.1.5.0 1.2.1.0 1.2.5.0
1.1.1.0 1.2.1.0 1.3.1.0 1.4.1.0
1.1.1.0 1.3.1.0 1.5.1.0 1.7.1.0

2/2
4/4
8/8

1.1.1.0 1.1.3.0 1.1.5.0 1.1.7.0
1.1.1.0 1.1.3.0 1.2.1.0 1.2.3.0
1.1.1.0 1.2.1.0 1.3.1.0 1.4.1.0

1.2.1.0 1.2.3.0 1.2.5.0 1.2.7.0
1.3.1.0 1.3.3.0 1.4.1.0 1.4.3.0
1.5.1.0 1.6.1.0 1.7.1.0 1.8.1.0

2/2
4/4
8/8

1.1.1.0 1.1.2.1280 1.1.3.2560 1.1.5.0
1.1.1.0 1.1.2.1280 1.1.3.2560 1.2.1.0
1.1.1.0 1.1.2.1280 1.2.1.2560 1.3.1.0

1.1.6.1280 1.1.7.2560 1.2.1.0 etc.
1.2.2.1280 1.2.3.2560 1.3.1.0 etc.-
1.3.2.1280 1.4.1.2560 1.5.1.0 etc.

2/2
4/4
8/8

1.1.1.0 1.1.2.0 1.1.3.0 1.1.4.0
1.1.1.0 1.1.2.0 1.1.3.0 1.1.4.0
1.1.1.0 1.1.2.0 1.2.1.0 1.2.2.0

1.1.5.0 1.1.6.0 1.1.7.0 1.1.8.0
1.2.1.0 1.2.2.0 1.2.3.0 1.2.4.0
1.3.1.0 1.3.2.0 1.4.1.0 1.4.2.0

1.2.1.0 etc.
1.3.1.0 etc.
1.5.1.0 etc.
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Adding and Editing Notes

Entering one note by dragging

To add a note to the score, proceed as follows:

1. Make the Staff Active.
Notes are always put in on the active staff. See page 49 for details.

2. Select the type of note by selecting a note value.
This is described in detail above.

3. If you selected the note value by clicking on a symbol on the Score Toolbar, the Note 
tool was automatically selected - otherwise select the Note tool from the Toolbox.

The Note Tool in the Toolbox. The shape of the note indicates the currently selected note value.

4. Select a Snap value.
Described above. The Snap will determine the spacing between notes. If you have Snap set 
to “1” you will only be able to add notes at downbeats. If you set Snap to “8” you will be able 
to add notes at all eighth note positions etc.

5. Position the mouse pointer over the note lines.

6. Press the mouse button without releasing it.
A note appears under the mouse pointer.

7. Move the mouse horizontally to find the correct position.
The note is “magnetically” attracted to the divisions defined by the current Snap value. This 
allows you to easily find the correct position.
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8. Move the mouse vertically to find the correct pitch.

9. Release the mouse button.
The note appears in the score.

Clicking Directly

When you get better acquainted with the Score Editor and find it easy to aim at the 
right position directly, you don’t need to drag the note around as described above. 
Simply aim at the correct position and click once.

If you have Problems getting the Pitch right

• Normally, you are allowed to “draw” notes with any pitch. But if the option “Keep moved 
notes within key “ is activated in the Preferences–Score–Editor Behaviour dialog, the pitches 
are restricted to inside the current key only.

• When you drag the mouse up and down before releasing the button, accidentals are shown 
beside the note to indicate the current pitch. This helps you verify the vertical position be-
fore releasing the mouse button.

Adding more Notes

1. If the next note is of another note value, select a new note value.
A quick way to do this is to use the number keys on the keyboard, see above. However, this 
also changes the Snap value.

2. If you need finer positioning, or if the current is too fine, change the Snap value.

3. Move the mouse to input the new note, and click.
Notes input at the same position are automatically interpreted as chords, see below.

The box below the mouse position box shows you to which 
pitch the current position corresponds.
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About the Interpretation

The notes may not always appear in the score as you expect them to, initially. This is 
because there are a number of situations which require special techniques and set-
tings. Below follows a list of some of these and where to find more information 
about handling them:

• Notes at the same position are considered parts of a chord. To get independent voicing (for 
example notes with different stem directions), such as for vocal material, you need to use the 
special Polyphonic Voicing feature described on page 129.

Without and with Polyphonic Voicing

• If two notes beginning at the same position have different lengths, the longer will be dis-
played as a number of tied notes. To avoid this, you will either have to use the “No Overlap” 
feature (see page 72) or polyphonic voicing (see page 129).

• One note will often be displayed as two notes with a tie. This is only how the program dis-
plays the note, there is still only a single note “stored”.

This single note in Key Edit is displayed as two tied notes in Score Edit.

• Generally the program adds ties where necessary (if a note stretches over a beat), but not al-
ways. For more “modern” notation of syncopated notes (less ties), you will need to use the 
syncopation feature described on page 72.

The same note, without and with Syncopation.

• If you specifically want a long note to be displayed as two (or more) tied notes, you can use 
the Cutflag tool for this.

• For details of handling crossing voices, see page 145.
• If a note has the wrong accidental, this can be changed. See page 156.
• If two notes on the same position are too close to each other or if you want their “graphical 

order” in the score reversed, you can do this without affecting playback. See page 173.
• Stem direction and length is normally automatic, but you can set it yourself. See page 150.
• If you are scoring for piano and therefore (or for other reasons) need a split staff, there are spe-

cial techniques for this, described on page 114 and page 129.
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If you run into Trouble

Below follow a few simple troubleshooting steps that will help you pinpoint some 
common mistakes:

• The note I put in has the wrong length. For example, I added a sixteenth and got a 
quarter note.
You probably have the wrong Display Quantize value set. Open the Staff Settings. If Auto 
Quantize is on, turn it off, unless you have mixed triplets and regular notes. Also check the 
Note and Rest Quantize. If the settings are too “coarse”, change them to a smaller note value. 
If you for example need the program to display an eighth note rest, Rest Quantize must be set 
to “8” or a smaller note value. (Please refer to “How the Score Editor works”.) If Overlap is on, 
you might want to turn it off.

• There is a pause after a note that I don’t want.
You probably added a note with the wrong note value. Either lengthen the note (physically 
or graphically - see page 110) or delete the one you have (see page 99) and add a new one 
with the correct note value.

• There is no pause after the note although there should be one.
Either the note is too long (delete and enter a new one or change the current note’s length, 
physically or graphically). Or, your rest Rest Display Quantize is set to too large a note value. 
Open Staff Settings and lower it.

• The note has an accidental when it shouldn’t, or it doesn’t when it should.
Maybe the note is simply of the wrong pitch? Click on it (using the arrow tool) and look at the 
Note Info Line (if this is turned on, see page 51). Move it to the correct pitch (see page 108). If 
this is not the reason, maybe you have the wrong key set? And last, enharmonic shifting is 
described on page 156.

• Notes are not grouped under beams the way I want it.
Normally the program groups eighth notes, sixteenths etc. under beams. This can be turned 
off. There is also detailed control of which notes are grouped under a beam. This is all de-
scribed on page 163.
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Adding Rests

You can add rests to the score. This is done as with notes, but with one major differ-
ence. Rests are always “inserted” into the score, that is, they “push” the notes that 
come after, to the right.

1. Select the rest value by selecting a Note value.
This is described in detail above.

2. Select a Snap value.
Also described above. The Snap will determine where you are able to insert the rest, as with 
notes.

3. Select the Rest symbol from the Toolbox.

The Rest Tool in the Toolbox.

4. Position the mouse pointer over the note lines.

5. Move the mouse horizontally to find the correct position.
Use the position box if you are unsure about the correct position.

6. Click with the mouse button.
The rest appears in the score and all the notes after it on the staff are moved “to the right”.

Before and after an eighth note rest was inserted at the beginning of the bar.
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Selecting Notes

In the operations described in the rest of this chapter, you will often work on se-
lected notes. The text below describes how to select notes in various ways:

By Clicking

1. Make sure you have the Arrow pointer selected.
A quick way to select the Arrow pointer is to press the [Tab] key - this toggles between the 
Arrow pointer and the previously used tool. As usual, you can assign another key command 
for this if you wish.

2. Click on a note head.
The note head gets inverted to indicate that it is selected.

3. To select more notes, hold down [Shift] and click on them.

4. To deselect notes, hold [Shift] down and click on them again.

• If you hold down [Shift] and double click on a note, this note and all the following notes 
in the same staff are selected.

Using a Selection Rectangle

1. Press the mouse button with the arrow pointer in some free (white) space in the score.

2. Drag the mouse pointer
A rectangle with a dotted outline appears. You can drag to select voices on several voices or 
staves if you wish.

3. Release the mouse button.
All notes with their note heads inside the rectangle get selected.

If you want to deselect one or more of the notes, hold down [Shift] and click as de-
scribed above.

Selected Notes
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Using the Keyboard

• You can step through the notes in the Staff using the [←] and [→] keys.

• You can hold down [Shift] to select the notes as you step through them.

• If you have Polyphonic Voices turned on, you will only step through the notes in the 
current Voice.

Selecting Tied Notes

Longer notes are often displayed in the score as one note with a tie. When you in-
tend to select the entire note for deleting etc., you should select the first note, not 
the tied note.

❐ There is a preference for this in the Preferences–Scores–Editor Behaviour dialog: If you 
activate “Tied notes selected as Single Units”, the whole note will be selected, even if 
you just click on one of the tied notes.

Deselecting Everything

• To deselect everything, simply click with the arrow pointer in some “free” (white) 
space in the score.

Selecting notes in one Voice only

If you are using Polyphonic Voices (see “Polyphonic Voicing”), you can select all 
notes in one of the Voices, by using the Select submenu on the Edit menu. This is 
described on page 138.
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Selecting notes with Equal Pitch

❐ Note that this selection is based on the actual pitch of the notes. Notes on different 
staves may be displayed differently if you have made Display Transpose settings.

1. Select one (and only one) note.

2. Pull down the Edit menu and open the Select submenu.

3. Point at the “Equal Pitch” option.

4. Select one of the options from the submenu that appears.

You can choose whether you want to select notes in all octaves or in the same oc-
tave only. If you for example had an “F” selected and you opt for the “In All Octaves” 
alternative, then all F0, F1s, F2s etc. will get selected. In either case, notes with the 
same pitch as the initially selected, on all staves and voices, are selected.

There are also keyboard equivalents for both options:

• To select all notes of the same pitch in the same octave, hold down [Command] and 
double click on one note.

• To select all notes of the same pitch in all octaves, hold down [Option] and double click 
on one note.

Either way, notes on all staves and in all voices are selected.
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Selecting notes with the Equal Pitch and Accidental

In some situations, you may want to select all notes that have the same pitch and 
are shown with a certain accidental. This allows you to select all F# notes but not 
the Gb notes, for example:

1. Select a note with the desired pitch and accidental.

2. Pull down the Edit menu and open the Select submenu.

3. Select “Same Enharmonic”.
All notes with the same pitch and accidentals, in all voices but in the active Staff only, are se-
lected.

❐ The other items on the Select submenu are described in the Menu and Dialog Refer-
ence document.

Deleting Notes

Notes can be deleted in two ways:

Using the Eraser Tool

1. Select the Eraser Tool from the Toolbox.

The Eraser Tool in the Toolbox.

2. Click on the Note(s) you want to erase, one at a time or drag over them with the mouse 
button pressed.

Using the Keyboard or Delete Menu item

1. Using the Arrow Tool or the computer keyboard, select the notes you plan to delete.

2. Select Delete from the Edit menu, or Press [Delete] or [Backspace] on the computer 
keyboard.
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Moving Notes

About the Lock Layers

When you are moving and editing notes in the score, you might accidentally move 
other objects near by. To avoid this, you can assign different types of objects to dif-
ferent “Lock Layers” (up to three) and instruct Cubase VST to “lock” one or two of 
these layers, making them unmovable.

• To set up which type of object should belong to which Lock Layer, double click on the 
Lock Layer button on the Status bar.
A dialog opens, where you can select a Lock Layer (1 to 3) for each object type.

The Lock Layer button.

• To lock a layer, click on its number on the Lock Layer button, so that it goes dark.
You can only select or move objects whose layer number is lit. For more detailed informa-
tion, see page 205.

Activating Auditioning

If you want to hear the pitch of the note while moving, activate the Speaker Icon on 
the Status Bar. When it is on, you will hear the current pitch of the “dragged” note, 
as described below.

Moving in any direction

1. Set the Snap value.
The Snap value will restrict your movement in time. You can not place the notes on note val-
ues smaller than the Snap value. If Snap for example is set to “8”, you will not be able to move 
the notes to a sixteenth note position. However, you will be able to put them on any eighth 
note, quarter note, half note or whole note position.

2. Select the note(s) you plan to move.
You can select across several staves if you wish.

3. Position the pointer over one of the selected notes, press the mouse button and keep it 
down.

Auditioning activated.
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4. Move the mouse.
The horizontal movement of the note is “magnetically attracted” to the current Snap value. The 
position box shows what the new position for the dragged note will be. The Transpose box 
shows how much you have transposed the note(s).

5. Release the mouse.
The notes appear at their new position.

Moving Vertically or Horizontally only

By using the [Shift] key, you can decide to only transpose notes or to only move 
them in time.

1. Perform steps 1 to 3 above.

2. Hold down [Shift] and move the mouse (with the mouse button still held).
Depending on in which direction you start to drag, the movement will be locked to horizon-
tally or vertically only. You may at any time release [Shift] to be able to move in any direction, 
and then press it again to lock the movement once more.

3. Release the mouse.
The notes appear at their new position.

❐ If you move notes vertically and the option “Keep moved notes within key” is activated 
in the Preferences–Score–Editor Behaviour dialog, the notes will be transposed within 
the current key only.

Select one or several notes and 
hold down and drag the mouse 
button to the new position.

The Transpose box will show you 
how many semitones you move 
your note(s)...

...and then transpose them when you release the mouse button.
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Moving by using the Arrow Keys

Instead of dragging the note with the mouse, you can use the computer keyboard 
to move it:

1. Select one or several notes.

2. Set the Snap value.
The notes will be moved in steps according to the set Snap value.

3. Hold down [Command] on the computer keyboard.

4. Use the arrow keys to move the note(s).
The left/right keys move notes sideways in Snap value steps. The up/down keys transpose 
notes in semitones steps (see page 108 for more info).

Moving across Staves - the Lock button

If you are editing several Tracks, you may want to move notes from one staff to an-
other. There are two ways to do this:

By dragging

1. Set Snap and select the notes as described above.
You may select notes from several staves, but only the ones on the stave from which you ac-
tually dragged will be moved, so this is probably best avoided.

2. Make sure the “L” (Lock) button on the Score Toolbar is deactivated.

When this button is activated, you cannot move notes and other objects from one staff to 
another, which is handy if you for example need to transpose a note very high or low.

3. Click on one of the note(s) and drag them to the new system.
The Active Staff rectangle indicates which staff the dragged note(s) will appear on.

By using key commands

1. Select the notes.

2. Use the key commands for “Next/Prev Dynamic/Text Size/String” to move the notes to 
the next or previous Staff.
By default, these are [+] and [–] on the typewriter part of the computer keyboard.

❐ Moving notes from one system to another actually moves the MIDI data between the 
Tracks.

Now the “L” (Lock) 
button is deactivated.
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Duplicating Notes

1. Set Snap and select the notes, as for moving.
You can duplicate any block of notes, even on several systems at the same time.

2. Before starting to drag, hold down [Option].

3. With [Option] still pressed, move the notes as described above.

• If you want to restrict movements to one direction only, hold down [Shift].
This works just as for moving, as described above.

• If you want to restrict the pitch to inside the current key only, make sure the option 
“Keep moved notes within key” is activated in the Preferences–Score–Editor Behav-
iour dialog.

4. Release the mouse button and all keys.
The new notes appear in the Score. 

The “Move Events To” function

This function allows you to move or copy notes and other Events between staves, 
or even between Tracks not displayed in Score Edit:

Setting Up

First you need to make Tracks “available” for moving or copying Events to:

1. Pull down the Score menu and select “Edit...” from the Move Events To submenu.
A dialog appears, listing all Tracks in the Arrangement.
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2. Locate the Tracks to which you want to be able to move or copy Events, and click in the 
“In Menu” column for these Tracks.
You will be able to move or copy Events to any Track with a check mark in this column, re-
gardless of which Tracks you are editing at the moment.

3. Click Exit to close the dialog.
If you now pull down the Move Events To submenu, you will find the Tracks you selected 
listed there.

• If you are editing more than one Track, these will also be listed on the submenu, even if 
they are not checked in the Edit dialog.
This makes it possible to move or copy Events between staves, without having to add Tracks 
to the list first. Likewise, the “All Staves” option is always available.

Moving Events

1. Select the Events you want to move.

2. Pull down the Move Events To submenu on the Score menu, and select the Track to 
which you want to move the Events.
The Events are removed from the current Track and inserted at the same positions on the 
Track you selected.

Copying Events

This is done just as moving Events, except you hold down [Option] when you select 
the destination Track from the Move Events To submenu.
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Copying Events to All Staves

By using the “All Staves” option, you can quickly copy the selected Events to all 
staves currently being edited. This is useful if you want to quickly duplicate phrases, 
dynamics or text comments to all staves in a score, etc.

1. Make sure the desired Tracks are opened in the Score Editor.
A quick way to add or remove Tracks from the Score Editor is to use the “Display Tracks” func-
tion on the Score menu, as described on page 45.

2. Select the Events you want to copy.

3. Pull down the Move Events To submenu on the Score menu, and select the “All Staves” 
option.
The Events are copied to all Staves in the Score Editor. Note that a split staff (e.g. a piano staff) 
is considered to be a single staff. 

Moving using the Bar Handles

You can move or copy whole bars by dragging the bar handles. This is described on 
page 211.
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Cut, Copy and Paste

Cutting Notes

1. Select the Notes.

2. Select Cut from the Edit menu or press [Command]-[X].
The notes are now removed from the score and put in an invisible place called the Clipboard. 
Below we describe how to put notes that are on the clipboard into the score.

❐ The Clipboard can only hold one set of notes. If you Cut and then Cut again (or Copy, 
see below), the set of notes that were on the Clipboard first, will be lost.

Copying Notes

1. Select the Notes.

2. Select Copy from the Edit menu or press [Command]-[C].
A copy of the notes is made, and put in an invisible place called the Clipboard. Below we de-
scribe how to put notes on the clipboard back into the score.

❐ As described above, the Clipboard can only hold one set of notes.

Pasting Notes

Notes that you have put on the Clipboard using Cut or Copy, can be placed into the 
Score again, in the following way:

1. Make one staff active.

2. Set the Song Pointer to the position where you want the first note to appear.

3. Select Paste from the Edit menu or press [Command]-[V].
The notes are Pasted in, beginning at the Song Position. If the Cut or Copied notes come 
from different staves, they will be Pasted into their original staves. Otherwise, the notes are 
put in on the active staff. They keep the pitch and relative positions they had when you Cut 
or Copied them. 
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Using Drag and Drop

If you have notes or other score objects that you want to copy, you can also use 
drag and drop for this. This method allows you to use the computer desktop as one 
big Clipboard with multiple entries!

1. Make sure you have an empty section of the desktop visible.

2. Select the notes you want to copy.

3. Drag them to the desktop.
A Part file is created, with the name of the currently edited Part. If you drag several objects 
out of the same Part, the file names will be separated by numbers. You may want to rename 
the Parts if you intend to keep them a longer time.

4. Locate the position in your scores where you want to insert the copied notes.
This may be on other Tracks or even in another Arrangement or Song.

5. Drag the Part file into the score and drop it at the desired position.
If you are editing several Tracks, make sure that the correct Staff is selected.



- 108 - 

Editing Pitches of Individual Notes

By Dragging

The most basic way to edit the pitch of a note would probably be to drag it up or 
down as described on page 101. Remember to hold down [Shift] to avoid moving 
the note sideways as well.

• If the option “Keep moved notes within key” is activated in the Preferences–Score–Ed-
itor Behaviour dialog, notes will be transposed within the current key only.

• To avoid accidentally moving the note into another staff, activate the Lock button as 
described on page 102.

Using the arrow keys

You can use the up and down arrow keys on the computer keyboard to transpose 
notes, in the following way:

1. Select the note(s) you want to transpose.

2. Hold down [Command].

3. Use the up and down arrow keys to transpose the note(s) up or down, in semitone 
steps.

• If you hold down [Shift] and [Command] in step 2 above, the notes will be transposed 
in octave steps instead.

Using the Info Line

You can use the Info Line to change the pitches (and other properties) of one or 
several notes numerically, as described in the Getting Started book.

• If you have several notes selected and change the pitch on the Info Line, the changes 
will be relative.
That is, all selected notes will be transposed by an equal amount.

• If you have several notes selected, hold down [Option] and change the pitch on the 
Info Line, the changes will be absolute.
That is, all selected notes will be set to the same pitch.
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Via MIDI

1. Activate the MIDI In button and the Pitch button just beside it.
This is done by clicking. If you also want to change the note-on and/or note-off velocity of 
the notes via MIDI, this can be done by also activating the corresponding velocity buttons, as 
described in the chapter “The MIDI Editors - General Information” in the Getting into the De-
tails documentation.

To edit pitches only, via MIDI, set up the buttons like this.

2. Select the first note you want to edit.

3. Press a key on your synthesizer keyboard.
The note takes on the pitch of the key you pressed. The program then selects the next note.

4. To change the pitch of the now selected note, simply press the corresponding key as 
for the first note.
In this manner you can change the pitches of as many notes as you wish, by simply pressing 
the relevant keys. You can also use the [←] and [→] keys to step around among the notes. If 
you for example made a mistake, you can step back to the previous note with [←].
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Changing the Length of Notes

When it comes to note lengths, Score Edit is special in that it doesn’t necessarily dis-
play the notes with their actual length. Depending on the situation, you may want 
to change the “physical length” of the notes or the “display length”.

Changing the “Physical” Length

This will change the actual length of the notes. The change will be reflected when 
you play back the music.

❐ Remember that the appearance of notes and rests in the Score is determined by the 
Display Quantize settings in the Staff Settings dialog. Depending on the Display Quan-
tize “Notes” and “Rests” values, notes may be displayed as if they were longer than 
they really are (see page 10).

By using the Note Tool

1. Select a Note value that you wish to apply to the Note.
This can be done by clicking a note value icon in the Score Toolbar, by selecting a new Quant 
value or by pressing keys on the computer keyboard.

2. Select the Note Tool if it isn’t already selected.

3. Hold down [Option] and click on the Notes you wish to set to this length.

By using the Arrow Tool

You can set the length of notes without switching to another tool. This method also 
allows you to set a note to an “uneven” length (five sixteenth notes, nine eighth 
notes, etc.). Proceed as follows:

1. Set the Snap value to the smallest “denominator” of the length you wish to set.
For example, if you want to change the length to five 1/16th notes, you would set Snap to 16.

2. If you want to set the length of several notes at the same time, select the notes.
For this to be possible, the option “Tools work on all selected Events” must be activated in 
the Preferences–General–Editors dialog.

3. Press [Command], point on a note with the arrow tool and press the mouse button.
A small length slider appears.

The length is shown to the right, as sixteenth notes and ticks.

4. Drag the slider to the desired length value.
The Snap value determines which lengths you can select.

5. Release the mouse button.
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By using the Score Toolbar

Using the Score Toolbar is another quick way to set a number of notes to the same 
length:

1. Select the notes you want to change.

2. Hold down [Command] and click on one of the note “buttons” on the Score Toolbar.
All the selected notes are now given the length of that note “button”.

By using the Info Line

You can also edit Length values numerically on the Info Line. The same rules apply 
as when changing the pitch of notes (see page 108).

Lengthening a Note by Gluing two Notes together

You can create unusual note length values by gluing notes of the same pitch to-
gether.

1. Insert the notes you want to glue together (if they don’t already exist).

2. Select the Glue Tool from the Toolbox.

The Glue Tube in the Toolbox.

3. Click on the first note.
This note will now be tied to the first note after it, that has the same pitch.

❐ Make sure you have a display note/rest quantize value that allows you to display notes 
of the created note value.

4. If you want to glue more notes, click again.

By gluing together a quarter note, an eighth note and a sixteenth note...

...you get a double dotted quarter note.
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Changing the length by using Functions

If you pull down the Functions menu and open the MIDI Functions submenu, you 
will find another submenu called “Note Length”. This contains various Functions for 
changing the length of notes, as described in the Menu and Dialog Reference doc-
ument. 

• As with all editing functions, the To pop-up menu and/or selection determines which 
notes are affected.

Changing the Display Length

If you want to change the displayed length of notes without affecting how they play 
back, the first thing to try is to adjust the Display Quantize, either for the whole Staff 
or for a separate section, using the Quantize tool (see page 78). But you can also 
make length adjustments to individual notes in the Note Info dialog:

1. Double click on the head of the note.
The Note Info dialog opens.

2. Locate the “Display Len” setting.
By default, this is set to “Auto”, meaning that the note will displayed according to its actual 
length (and the Display Quantize settings).

3. Set a new length value (displayed in sixteenth notes and ticks).
To set the Display Length to “Auto” again, scroll the value down to zero.

4. Click OK to close the dialog.
The note will now be displayed according to it’s Display Length setting. However, the Display 
Quantize settings still apply!

Splitting a Note in two

If you have two notes strung together by a tie, and click on the “tied” note head with 
the scissor tools, the note will be divided into two, with the respective length of the 
“main” and the tied note.

Before and after splitting a tied note.
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Muting Notes

If you want to display notes without having them played back, you could use the 
Graphic symbols. An easier way however, might be to insert the notes as usual and 
then mute them:

1. Select the notes you want to mute.

2. Pull down the Do pop-up menu and select “Mute Selected”.
The notes are muted.

3. To unmute the notes, select them and select “Unmute Selected” on the Do pop-up 
menu.

Finding Muted notes

There are two ways to distinguish muted notes:

• If the option “Use Colors for Additional Meanings” is activated in the Preferences–
Scores–Editor Behaviour dialog, muted notes are displayed in grey.

• If you select the notes, you will notice that they are displayed with a small “frame” in-
stead of the regular inverted note head.

Unmuting all notes

1. Pull down the Edit menu and select “All” from the Select submenu.
All notes are selected.

2. Pull down the Do pop-up menu and select “Unmute Selected”.
All selected notes are unmuted.

• If you want to unmute all notes after a certain position, you could instead hold 
down [Shift] and double click on the first note after that position.
All following notes would be selected, and you could use the “Unmute 
Selected” command without affecting any notes before that position.

Working with the Quantize Tool

There are instances when you will want different Staff Settings on different sections 
of the Track. The settings in the Staff Settings dialog are valid for the entire Track, but 
by using the Display Quantize Tool you are able to insert changes and exceptions 
wherever you like. This is described in detail on page 78.

These notes are muted.
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Split (Piano) Staves

Setting up the Split Staff

1. Make a staff active.

2. Open the Staff Settings dialog for the staff.

3. From the Staff Mode pop-up, select Split.

4. Set up the Split Point field.

The Split Note setting in Staff Settings.

All Notes below this will be put on the lower clef, all above will be put on the upper clef.

5. Select a Clef and Key.
When you set a key for the upper staff, this setting is automatically copied to the lower staff. 
To set a separate key for the lower staff, activate “Lower Staff” and then change the key.

6. Make whatever additional Staff settings you need.
These will apply to both the upper and lower clefs.

7. Close the Staff Settings Dialog.

Before and after setting a Split at C3.

Adding Notes

This is done just as on a single system, see page 91. Please note the following:

• When you enter a note, use the pitch box (on the Status Bar) to determine the pitch. Whether 
it winds up on the upper or lower staff has nothing do with where you aim with the mouse. 
The Split Note setting always decides if a note goes on the upper or lower clef. If you change 
the split point, this will affect existing notes, see below.

• Sometimes a fixed split point isn’t good enough. You might want to put two notes with the 
same pitches on different clefs in different parts of the piece. To achieve this you need to use 
Polyphonic Voicing, see page 129.
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Changing the Split Point

1. Open the Staff settings dialog for the system you are working on.

2. Change the Split Note value.

3. Close the dialog box.

Now, some notes that were previously on the lower staff will be on the upper, or 
vice versa.

Strategies: Multiple Staves

As described above, when you have Parts on several Tracks selected in the Arrange 
Window, these will be put on one staff each, when you open the Score Editor. This 
allows you to work on several staves in parallel.

Working with several staves is not much different from working with one. Below 
follow some guidelines that apply specifically to working with Multiple Staves.

Staff Settings

• As described above, the settings in the Staff setting dialog are local to each staff. By using the 
Prev and Next buttons or the up and down arrow keys you can set up all staves as needed, 
without closing the dialog box.

• If several staves share settings, you will save some time by using Staff Presets. Set up the Staff 
settings for the first staff, then make those settings a Preset. This Preset can then be applied 
to any of the other staves, one at a time. See page 122 for details.

Selecting Notes

• You can select notes from one or several staves at the same time, using any method of selec-
tion, as described on page 96.

Adding Notes

• You can add notes to any staff by just clicking inside it. The active staff rectangle will move to 
the staff where you input the note.

• If you need to put in a note with a very high or low pitch, which makes it wind up on the 
wrong staff when you click, first enter a note with the wrong pitch, and then edit its pitch as 
described on page 108.
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Inserting and Editing Clefs, Keys or Time Signatures

It is possible to insert a change of key signature, clef, or time signature anywhere in 
the score:

Inserting a Symbol on one Staff

1. Select “Clef etc.” from the “Symbol Palettes” menu on the Score menu
This opens up the “Clef etc.” Palette, which contains Clef, Key and Time Signature symbols.

The Symbol Palettes menu and the “Clef etc.” palette.

2. From the Palette, select the symbol you wish to insert into the score.
The Pencil tool is automatically selected (see also page 191).

The Clef symbol selected in the Palette.

3. Move the mouse over the Staff where you want to insert a new symbol.

4. Use the mouse position box to find the exact location.
The vertical position is of no relevance as long as you click somewhere in the staff. Time Sig-
nature changes can only be inserted at the beginning of a bar.

5. Click the mouse button.

• If you have inserted a new Clef, a dialog with the available clefs appear.

• If you have inserted a new Key Signature, a dialog with the available keys appears.
Inserting a key change on the upper staff of a split system automatically inserts the same key 
change on the lower.

• If you have inserted a Time Signature, the Time Signature dialog box appears.
The Time Signature dialog box is described in detail on page 56.
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6. Select an option from the dialog.
The symbol appears. If there is room for it in the bar, the notes are moved to make room for 
it. If not, you will have to use Auto Layout or make manual adjustments (see Moving Clefs be-
low).

❐ Inserting a symbol at position 1.1.1.0 is the same as changing the Staff settings which 
are stored in the Track. Inserting anywhere else adds the change to the Part.

Inserting a Symbol on all Staves

If you hold down [Option]+[Command] while inserting any of the symbols above, 
the symbol will be inserted at this position on all staves currently being edited in 
the Score Editor.

❐ For Key Signatures, Display Transpose is taken into account. This allows you to set all 
staves to a new key and the staves set to Display Transpose will still show the correct 
key after the key change.

Editing Keys, Clefs and Time Signatures

If you double click on a symbol, the same dialog appears as when you inserted it. 
This allows you to change the settings for it.

If you hold down [Option]+[Command] when double clicking, all symbols at the 
same position are changed accordingly. With Key Signatures, the Display Transpose 
value is taken into account as described above.

• You will find several options for how Key, Clef and Time Signature changes should be 
displayed in the Preferences–Scores–Additional Settings dialog.
You can also adjust the automatic spacing between these symbols in the Preferences–Scores–
Spacing dialog. See the Menu and Dialog Reference document for details.
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Moving Clefs

Clefs inserted into the score have an effect on how notes are displayed. If you for 
example insert a bass clef in the middle of a treble staff, the staff switches to show 
bass pitches. Therefore it is very important where you insert the clef.

However, you might want to move the clef graphically, without disturbing this rela-
tion between the clef and the notes. Proceed as follows:

1. Select the Layout Tool from the Toolbox.
This is available in Page Mode only.

The Layout Tool.

2. Click on and move the clef just as with the normal arrow pointer.
Now the clef is moved, but the score is still interpreted as if it remained in its original posi-
tion.
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6
Staff Settings
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In this Chapter you will learn:

• How to make Staff settings.
• How to work with Staff Presets.

Staff Settings

Below follows a run-through of all Staff settings, more detailed information about 
the ones already described and references to other places in the manual for some 
options.

The Staff Settings dialog box.
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Making Settings

Making Settings for Multiple Staves – one at a time

1. Open the Staff Settings dialog.

2. Use the Prev and Next buttons or the up and down arrow keys to step to the right staff.
The title shows which Track is selected. The dialog shows the settings for the current staff.

3. Make whatever settings you need to do.
You might for example click the “Staff Options...” button to display the additional options 
available.

4. Step to the next staff and make settings for this.
Repeat this until all staves have the right settings.

5. Press [Return] or Click OK.

Making Settings for Multiple Staves – all at once

1. Open the Staff Settings dialog.

2. Make whatever settings you need to do.

3. Hold down [Option], and hit [Return] or Click OK.
The settings you made will now apply to all staves currently visible in the Score Editor. By 
opening different combinations of Tracks, this can be used as a powerful way of making 
groups of Tracks get identical settings.
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Working with Staff Presets

You will spend some time making Staff Settings for your scores. Staff Presets allow 
you to reuse those settings whenever you work with a staff similar to one you have 
worked on before.

❐ A Staff Preset contains all the settings in the Staff Settings dialog except the Key Signa-
ture.

Creating a Staff Preset

1. Set up the Staff Settings as you want them.
This includes the Staff Options dialog, see below.

2. If you want a new item, select the last item on the Presets menu.
 This item is always called “empty”.

At the bottom of the Preset menu you will always find the item “empty”.

3. If you instead want to overwrite an existing Preset, hold down [Option] and select any 
other memory location from the Presets menu.

4. If you wish to change the name of the Preset, double click on it.
The name is entered as usual.

5. Click the Store button.

 
The Store button is in the Preset section of the dialog.

Applying a Staff Preset

1. In Score Edit, activate a Staff.

2. Select Staff Presets from the Score menu and then select one of the Presets from the 
submenu that appears.
All the settings in the Preset are now applied to the Active Staff.

• If you hold down [Option] and select a Preset from the Staff Preset submenu, the set-
tings in the Preset will be applied to all Staves opened into Score Edit.
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Renaming Staff Presets

1. Open the Staff Settings dialog box.

2. Select the Preset.

3. Double click on it and enter a New name as usual.

4. Click Store.

Copying a Preset

1. Open the Staff Settings dialog box.

2. Select the Preset.

3. Hold down [Option] and select another Preset.

4. If you wish to change the name, double click on it and enter a new name as usual.

5. Click Store.

How Staff Presets are stored

The Staff Presets are stored in the Cubase preferences. This means that once you 
have created a set of Staff Presets, they are available for selection in any Song you 
create or edit.
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Staff Mode

The “Staff Mode” part of the “Staff Settings” dialog.

This setting is used to create different types of staves:

Key and Clef

The basic Key and Clef Track Staff settings are described in detail on page 56. There 
is also a Lower Staff check box which is only used in conjunction with Piano Staves 
and Polyphonic Voicing. This is described on page 59.

Select This: When You Want To:

Single Score a simple “one voice” or chord part.

Split Score a Piano (or other) keyboard part (see page 114 for details).

Polyphonic Score a complicated part with polyphonic voicing on a single or split staff (see 
page 129 for details).
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Display Quantize and Interpretation Flags

These two sections of the dialog contain a number of settings used to determine 
how the notes should be interpreted. While these settings are more critical to mak-
ing MIDI recorded music appear as legible as possible it is still important to have 
them set correctly when entering notes using the mouse. Below you will find a brief 
summary of the settings - for more details, see page 70.

Notes and Rests Quantize values

• Generally, the Note Quantize value should be set to a value equal to, or smaller than, the 
“smallest note position” you want to be shown in the score.

• The Rest Quantize value should be set to a value equal to, or smaller than, the smallest note 
value (length) you want to be displayed for a single note, positioned on a beat.

• If the score contains only triplets, or mostly triplets, select one of the Triplet options.

Auto

• If the piece contains no triplets or only triplets, deactivate this option.
• If the piece contains mixed triplets and straight notes, activate this option (the additional op-

tions are described in detail on page 71).

Interpretation Flags

Activate This: When:

Clean Lengths When you find the program generally interprets your notes as shorter than 
you expect. See page 71.

No Overlap When notes starting at the same position, but having different lengths, 
give you more ties than you want. See page 72.

Syncopation When the program adds more ties to notes crossing beats and bar lines 
than you prefer. See page 72.

Shuffle When you have played a shuffle beat and want it displayed as straight 
notes (no triplets). For details see page 73.
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Staff Options

When you click the “Staff Options...” Button in the Staff Settings dialog, another di-
alog opens up with additional Staff Settings (which can be made part of a Staff Pre-
set just as the other settings). Below follows a brief description of these, with 
references to more detailed explanations.

Switches

Activate This: When:

Flat Beams When you want the beams over notes to be flat (as opposed to slanted). See 
page 169.

No Beams When you don’t want any beaming at all on the staff (for example for vocal 
scoring). See page 163.

Beam Subgroups When you want sixteenth notes displayed under a beam to be divided into 
two groups of eight notes. See page 169.

16th Subgroups When you want even smaller subgroups of sixteenth notes. This setting has 
no effect if Beam Subgroups is turned off.

Consolidate Rests When you want two rests joined to one (for example an eighth note and a 
sixteenth note rest displayed as a dotted eighth note rest). See page 75 for 
an example.
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System

This section allows you to set the number of system lines and to control spacing be-
tween the lines:

See page 308 for an example of how this can be used with Tablature.

Drum Options

These settings are all described in “Scoring for Drums”.

Fixed Stem Length

If you activate this checkbox, the stems of all notes will end at the same vertical posi-
tion. This feature is perhaps most often used when scoring for drums (see page 302).

A drum pattern with Fixed Stem Length activated.

The values determine which position (relative to the top of the staff) should be 
used for up and down stems, respectively. The graphical display helps you get your 
settings right. 

Display Transpose

• The numerical setting is used to transpose the score up or down without affecting playback 
and without actually transposing the MIDI data that is the basis for the score.

• The pop-up menu contains a number of preset transposition values for common instru-
ments which are scored transposed.

More details on page 62.

Tablature Mode

This option is described in “Creating Tablature”.

Setting: Description:

System Lines The number of lines in a system. For regular scoring, this should be set to 5.

Add Space Allows you to increase or decrease the space between the lines in a system.

Size Allows you to set a size for the systems, as a percentage (with 100% being the de-
fault value). In effect, this setting scales the score vertically.

Rastral This parameter affects the size as well, but uses the traditional “Rastral” measure 
system. Changing this value will automatically change the Size value (and vice 
versa) according to the following scheme:

Rastral 2 = 100%

Rastral 3 = 93.1%

Rastral 4 = 85.1%

Rastral 5 = 81.489%

Rastral 6 = 74.468%

Rastral 7 = 63.297%

Rastral 8 = 54.255%
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Staff Settings and General MIDI Instruments

If you are working with General MIDI compatible instruments, you can get a lot of 
score formatting “for free”:

1. Open the Preferences–Scores–Editor Behaviour dialog.

2. Activate the option “Staff Settings adapt to General MIDI rules”.

3. Close the dialog.

Now, Program Change numbers and MIDI Channels set for the Tracks in the Arrange 
window will be linked to certain properties in the score:

• Tracks set to Program Change 1 to 8 will automatically be set to a Piano staff (since these Pro-
gram change numbers correspond to piano instruments in General MIDI).

• Tracks set to play bass sounds, tuba and trombone will appear on a bass clef.
• Tracks set to play viola sounds will have an alto clef.
• Tracks set to play Trumpet will have a Display Transpose setting of +2.
• Other brass and woodwind instruments will also have Display Transpose settings: soprano sax 

+2, alto sax +9, tenor sax +14 baritone sax +21, piccolo and pan flute -12.
• All Tracks set to MIDI Channel 10 will be set to a drum clef with two voices, and a default 

mapping of the drum notes (which can be changed, see page 299).
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7
Polyphonic Voicing
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In this Chapter you will learn:

• How to decide when to use polyphonic voicing.
• How to set up voices.
• How to automatically convert your score to polyphonic voicing.
• How to enter and move notes into voices.

Background: Polyphonic Voicing

Polyphonic voicing allows you to resolve a number of situations impossible to score 
properly otherwise:

• Notes starting at the same position, but with different lengths. Without polyphonic voicing 
you get unnecessary amounts of ties.

Without and with polyphonic voicing.

• Vocal scoring and similar. Without polyphonic voicing, all notes starting at the same position 
are considered parts of a chord. With Polyphonic voicing you can give each voice a stem di-
rection, you can have individual rest handling for each voice etc.

Without and with polyphonic voicing.

• Complicated piano systems. Without polyphonic voicing you have to resort to a fixed split 
note setting to decide which notes go on which clef. With polyphonic voicing the split point 
can be “floating”. The program can even automatically put a bass line on the lower clef for 
you!

With a Split system and with polyphonic voicing.

How Voices are Created

There are eight voices. The first thing you do is to set them up. This includes “telling” 
the program which voices belong to the upper clef and which belongs to the lower, 
how you want rests displayed for each voice, etc.
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The second thing you do is to move or enter notes into the voices. If you have a re-
cording done already, the program can do much of this work for you, automati-
cally. You might then want to fine tune by moving one or more notes into another 
voice, or you might want to add notes to a certain voice.

❐ Each Voice is polyphonic. In other words, one Voice can contain chords.

Overlapping Notes

Throughout this chapter you will encounter the term “Overlapping Notes”. Two 
notes are considered overlapping when they are on the same staff and:

• They start at the same position, but have different note values (for example whole note and 
a quarter note both at the beginning of a bar), or...

Notes starting at the same position, without and with polyphonic voices.

• One note starts before another has ended. For example a half note at the beginning of a bar 
and an eight note at the second beat.

A note that starts before another has ended, without and with polyphonic voices.

Voices and MIDI Channels

Internally the program organizes the Notes into Voices by changing their MIDI 
Channel values. Normally you set it up so that notes with MIDI Channel 3 belong to 
Voice 3 etc. Most of the time the link between MIDI Channels and Voices will be to-
tally transparent to you as a user. But sometimes you can take specific advantage of 
this relation, as described later in this chapter. There is also a few other important 
things to note:

❐ When you make a note part of a voice, you are in fact changing its MIDI Channel value.
However, when you change the Voice’s MIDI Channel values in the setup dialog, this 
does not affect the notes’ MIDI Channel setting. This can lead to serious confusion, 
since the relation between the notes and the voices is affected. It might even make 
notes disappear (the program will warn if this happens). In other words, don’t change 
the MIDI Channels in the polyphonic voices dialog after you have put your notes into 
voices, unless you are absolutely sure of what you are doing.
Also please note that when you open a Part that contains notes on different MIDI Chan-
nels, these notes are de facto already assigned to voices (since notes are assigned to 
voices using their MIDI Channel setting). While this fact can be put to good use, it can 
also create confusion, and even disappearing notes, as described above.
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Setting up the Voices

This text describes the Polyphonic Settings dialog, in general. Below you will find 
more detailed explanations on how to select from the multitude of options.

❐ You can also convert existing Tracks into polyphonic voices automatically, using the 
Merge All Staves function.

1. Open the Staff settings dialog for the staff.

2. Select Polyphonic from the Staff Mode pop-up.

3. Click the Edit button.
The Polyphonic Settings dialog appears. It consists of eight rows with one voice in each. In 
this manual, we refer to the eight voices as voices 1 to 8.

❐ Do not confuse the voice numbers with the MIDI Channel setting for each voice.

The Polyphonic Settings dialog.

4. To activate a voice, click in its “On” column, so that a small dot appears.
There are four voices on each staff, for a total of eight. If you activate at least one “upper” 
voice and one “lower” voice, you will get a split (piano) staff.

5. If you have particular reasons to use specific MIDI Channels, change the “Chan” set-
tings for the voices.
The program automatically sets each voice to a different MIDI channel. If you don’t have 
good reasons to make changes, leave the settings as they are.
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❐ Please note the warnings about changing the MIDI Channel settings, on page 131. Also 
note that if two Voices are set to the same MIDI Channel, the lower will be treated as if 
it was turned off.

6. Click in the “Rests–Show” column to decide for which voices you want rests displayed.
A tick mark indicates that rests will be shown for a voice. Often you will only want rests to be 
shown for one voice per staff, see below.

7. If you have activated “Rests–Show” for a voice, but don’t want rests to be shown in 
empty bars, click in the “Rests–Reduce” column for that voice.
This is especially useful for Cue Voices, see page 174.

8. Click in the “Rests–Center” column to determine at which vertical positions rests 
should be shown (for voices with “Rests–Show” activated).
When this option is activated for a voice, the rest will be put in the vertical center of the staff, 
when it is not, the rest will get a vertical position based on the pitch of the notes.

9. Decide for a stem direction for each voice, by selecting from the pop-up in the Stems 
column.
If you select Auto, the program will make decisions about which stems go in which direction 
(just as when not using polyphonic voices). Regardless of which option you show, you can al-
ways force stem direction for individual notes by using the Flip Stem function, see page 152.

❐ There is a special Stem feature for voice 1: If you set this to Auto, the stem direction will 
depend on the pitch of the note as usual - except if there are voice 2 notes in the bar, 
because then the voice 2 stems will automatically be set to Up!

10.If you want the notes in a voice to be smaller than regular notes, put a tick mark in the 
Cue column for the voice.

11.Decide if you want to use Auto Move To Voices.
This is described in detail below. If you want to use it, activate one or more of the options be-
low.

12.Close the dialog box and the Staff settings dialog.

If the “Some Notes Do Not Belong To Voices...” Dialog appears

When you close Staff settings, a dialog box may appear saying “Some notes do not 
belong to any voice and may be hidden, Correct/Ignore”.

This dialog appears when you have set up polyphonic voices without using “Auto 
Move To Voices”, and there are notes with MIDI Channel settings which do not 
match any of the active Voices.

If you click the “Correct” button, these notes will be moved to active voices. if you 
click “Ignore”, nothing will be changed, and some notes will be hidden. However, 
they are not lost, they appear in all other editors and will appear again in Score Edit 
if you for example use “Auto Move To Voices”.
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About the Polyphonic Presets

The Presets pop-up menu in the Polyphonic Settings dialog contains three very us-
able setups. Instead of making settings by hand, you can select one of the Presets, 
thereby saving some time. The Presets are:

Variable Split

This sets up the dialog for two voices, one on each staff, each with auto stem direc-
tion. This is a good starting point for a piano staff when the fixed split option doesn’t 
suffice.

Optimize Two Voices

With this Preset, only Voices 1 and 2 are activated with settings like this:

This way the first voice behaves as in Single Staff mode, but if there are notes in the 
second voice, the stems of the first one are set to up.

Optimize Four Voices

This is like “Optimize Two Voices”, but with two staves. Voices 5 and 6 are activated 
as well, with the same settings as Voices 1 and 2. This is the recommended way to 
write piano music.
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Strategies: How many Voices do I need?

Well, it depends...

• If you are scoring for vocals, you simply need one voice for each voice, so to speak.
• Often you will use voices for resolving the problem of overlapping notes (see page 131), for 

example when scoring for piano. In this case, you will need two voices each time two notes 
overlap. If three notes overlap, you will need three voices. In other words you will need to 
check for the “worst case” (largest number of overlapping notes at a certain position) and ac-
tivate that many. If you don’t know how many notes you need when starting out to prepare 
a score, don’t worry, you can add more voices later.

• Voices 1 and 2 on the upper staff and 5 and 6 on the lower are special. These handle “colli-
sions” (notes with small intervals, accidentals that otherwise would come too close, etc.) au-
tomatically which the other voices don’t. Always use these voices first!

• An example: in the situation below, three voices are required. The lowest note overlaps both 
the “melody” and the chords, so it can’t share a voice with the chords. The chords overlap the 
melody, so they can’t share a voice either.

Using Auto Move To Voices

If you have a Track already recorded and you want to use polyphonic voicing for it, 
you have the option of letting the program automatically put notes into voices. 
This is done by activating “Auto Move To Voices” in the Polyphonic Settings dialog.

1. Open the Staff settings dialog box for the staff.

2. Switch the system to Polyphonic.

3. Click Edit and set up the Voices as described above.

4. Activate “Auto Move to Voices” and turn on the options you need.
See below for details.
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5. Close the Polyphonic Settings dialog and the Staff Settings dialog.
The notes are now moved to the voices.

If things didn’t turn out exactly as you expected it, just repeat the procedure and try 
other settings. Some trial and error might be required to find the right combina-
tion. But there are of course cases which no computer program can handle auto-
matically. If you for example need crossed voicings, some manual adjustments are 
necessary, see page 145.

❐ Please note that graphical “collisions” are only handled automatically for Voice 1 and 2 
on the upper staff and Voice 5 and 6 on the lower. If you use more than two voices on a 
system you might have to use the Layout Tool to perform “Graphic Moving” of notes, 
to make the score more legible.

Activate This: When:

No option When you “only” want the program to automatically resolve overlapping 
notes. The program does this by moving notes to different voices. For example 
if a whole note starts at the same time as four quarter notes, the whole note will 
wind up in its own voice. To make this work, you must of course have enough 
voices activated in the Polyphonic Voices dialog.

Split Note When you want to move all notes below a certain pitch to the “lower voices”, 
that is, to move them to the bass clef. This of course requires you to have at 
least one of the lower voices activated. Overlapping notes will also be treated 
as described above. Make sure the Split Note is set to a reasonable value if this 
option is activated!

Lines To Voices When you want all musical “lines” to be put in one voice each, regardless if the 
is need for resolving overlapped notes or not. Select this option for example for 
vocal scoring.

The notes with the highest pitch are picked to the top voice and so on. Make 
sure you have enough voices activated, or the lowest voice will contain more 
notes than you expect!

If you want “bass” notes moved to the bass clef, make sure one or more of the 
“lower” voices are activated.

Bass To Lowest When you want the lowest note to be put in its own voice on the bass clef. This 
of course assumes you have at least one of the “lower” voices activated. Other-
wise, the notes will be put on the lowest of the “upper” voices.
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Entering Notes into Voices

When you add new notes, you need to decide which voice they go into:

1. Make sure the Score Toolbar is visible.

2. Select the Arrow Tool.

3. If you have a split system, check the Voice Insert buttons.

The Voice Insert buttons – here three voices are activated on the upper staff.

These are displayed after the text “Insert” on the left side to the Score Toolbar. Only the Voices 
that are activated in the Polyphonic Settings dialog are shown. If the upper Staff is active, the 
Voice Insert buttons are numbered 1, 2, etc., otherwise they are numbered 5, 6, etc.

4. If you need to switch the voice icons to the right “clef”, click somewhere in the system 
you want to insert notes in.

5. Select one of the voices by clicking on the corresponding button.
Any notes you enter from now on will now be inserted into that voice.

6. Insert the notes as usual.

7. If you want to switch to another voice, click on the corresponding button.

8. If you want to insert notes into a voice on the other clef, click on that clef and then se-
lect a voice using the buttons.

Symbols and Voices
Later in this manual you will learn about symbols that can be added to the score. 
Many of these symbols must also put into a particular voice. See page 190.

Recording and Step Input

When you record or use Step Input in Score Edit, you can have all notes automati-
cally inserted into the active voice:

1. Open the Preferences–Scores–Editor Behaviour dialog and make sure the option 
“Send Recorded Notes to Active Voice” is activated.

2. Make the Staff active where you want the notes to appear.
This is probably most easily done by clicking somewhere in the staff.

3. Click on a voice “Insert” button to select which voice you want the note to appear in.

4. Record or use Step Input.
The notes appear in the selected voice on the active Staff.

Voice 3 activated for insertion.
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Checking which Voice a Note belongs to

• When you select one (and only) one note, the corresponding Voice button on the Score Tool-
bar gets selected. This allows you to quickly find out which voice a certain note is in (after a 
Move To Voice for example).

• When you step through the notes using the arrow keys, you will only step through the notes 
in one voice at a time. This can be used as quick way to check which notes belong to the 
same voice as some other note.

Selecting all Notes in a Voice

There are two ways to select notes in one voice only:

By using the Edit menu

1. Pull down the Edit menu and display the Select submenu.

2. Display the Voice graphical submenu and select one of the voices.
Voices that are not activated are “greyed out” on the submenu.

All notes in the indicated voice are selected.

By double clicking

1. Hold down [Shift].

2. Double click on one of the notes in the voice you want to select.
The note and all following notes in the voice are selected. This means that if you want to se-
lect all notes in a voice with this method, you have to click on the first note in the voice.

Voice 1,2,3,5 and 6 are activated 
and Voice 1 is selected.

Voice 4,7,8 are not activated and are therefore “greyed out”.
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Moving Notes between Voices

There are two major situations when you will need to manually move notes be-
tween voices:

• When you have recorded something and switched the system to Polyphonic without using 
“Auto Move To Voices”.

• When you have used Auto Move To Voices and need to make manual adjustments to the 
voicing you got.

1. Select the Note(s) you want to move to a particular Voice.

2. Select Move to Voice from the Staff Functions submenu found on the Score menu.

Move to Voice and the submenu it invokes.

3. In the submenu, select the Voice you want to move the notes to.
Voices not activated are shown in grey.

Alternatively, you can use the computer keyboard.

1. Select the Note(s) you want to move to a particular Voice.

2. Hold down [Option] and press the number key on the computer keyboard corre-
sponding to the Voice you want to move the notes to.
This is the default key command. As usual, you can specify custom key commands for this if 
you wish, in the Preferences–Key Commands–Score dialog.
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Alternative Ways of handling Voices

Below we suggest some other “advanced” ways of putting notes into Voices. This is 
based on the relation between voices and MIDI Channels, so please make sure you 
understand how this connection works.

• You can use Logical Edit (described in its own chapter in the Getting into the Details docu-
mentation) to put notes into voices, based on other more complex criteria, like for example 
their pitch and length. This is done by setting up Logical Edit so that the notes that meet the 
criteria get their MIDI Channel changed to that of Voice.

• When you enter notes using Step Input you can change the MIDI Channel on your input de-
vice and thereby directly enter notes into separate Voices.

• You can play back each Voice on a different MIDI Channel, simply by setting the Track to Any. 
This can for example be used as a convenient way of “proof-hearing” each voice separately.

• You can use the Input Transformer to assign a certain key range to a MIDI Channel, and 
thereby automatically put notes into voices when recording.

• For brass and vocals, you might record each voice on its own Track, and use the “Merge All 
Staves” function to automatically copy each recording to a separate voice on a new Track 
(see page 147).

• When you have assigned parts to voices, you can use the Extract Voices function to create 
one Track out of each voice (see page 148).

Handling Rests

With Polyphonic Voices, you often get more rest symbols than you desire.

• If a Voice doesn’t need any rests at all, you can turn off rests for each voice individually 
in the Polyphonic Voices dialog.

• If you only need rests from one voice on a staff, turn Rests–Center on for that voice 
(this is done in the same dialog). If two or more voices have rests, turn Rests–Center off. 
The program then automatically makes sure the rests don’t “collide” in the score, by 
adjusting their vertical position.

• To avoid having several rests displayed in empty bars, you can activate the Rests–Re-
duce option for all voices (that have rests) except one. This option causes the program 
to hide Rests in empty bars.

• You can use Hide (see page 274) to totally remove individual superfluous rests from 
the Score.

• You can use the Arrow Tool to manually move rests up/down or sideways to adjust the 
“picture”.

• If needed you can add “rest symbols” (rests that don’t affect the playback data in any 
way) by using the Symbol Palette.
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Converting a Piano Staff into Polyphonic Voicing

You might have created a Piano Staff using the Split (Piano) Staff in the Staff settings 
dialog. This uses a fixed split point, which is not always good enough. If you run into 
a situation where you find that notes that are on the upper clef should be on the 
lower, and vice versa, you should set the staff to use Polyphonic voicing.

1. Make sure the To pop-up menu is set to All, so that the entire part will be affected.
Even though the Staff mode (Single, Split or Polyphonic) is “global” for the whole Track, the 
actual voice assignments you make (manual or automatic) are affected by the To pop-up 
menu, just like any function.

The To menu set to “All”.

2. Open the Staff settings dialog.

3. Memorize the current split point.

4. From the pop-up Staff Mode menu, select Polyphonic.

5. Click the Edit button.

6. Activate at least voice 1 and 5, and make settings for them.
You will want rests to be shown, and you probably will not want Cue Notes. You might also 
activate additional voices for the upper or lower clef, if you need to for example resolve over-
lapping notes on either clef.

A minimal piano system with two voices, one on each staff.

7. Activate “Auto Move To Voices”.
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8. Activate Split Note and set the Split Note to the same note as you had when using the 
Split (Piano) Staff option.

Auto Move To Voices activated with a Split Note option.

9. Optionally, turn on other options.
See page 135 for details.

10.Click OK.

11.Close Staff Settings.

12.Examine the Score.
Look for two things: notes which are on the wrong staff and situations where overlapping 
notes cause an illegible score.

13.Use the Move To Voice function to move notes to the correct voices.
For example, notes that are on the upper staff but should be on the lower, should probably 
be moved to Voice 5.
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Voices and Display Quantize

When you insert Display Quantize changes (see page 78), you can either apply the 
settings to all voices (click “All Voices” in the dialog) or to the current voice only 
(click “OK” in the dialog).

❐ If the option “Display Quantize Tool affects all Voices” is activated in the Preferences–
Score–Additional Settings dialog, the Display Quantize settings will always affect all 
voices (even if you just click “OK”, rather than use the “All Voices” option).

Making Display Quantize settings affect one voice only (by clicking “OK”) allows 
you to do two things:

• Make each voice have its own Display Quantize settings by inserting a Display Quantize Event 
for each voice, at the beginning of the staff. This will then be valid for the entire staff, until an-
other Display Quantize event is inserted.

• Insert Display Quantize “exceptions” anywhere in the score, independently for each Voice. 
Proceed as follows:

1. Make sure the option “Display Quantize Tool affects all Voices” is deactivated in the 
Preferences–Score–Additional Settings dialog.

2. Select the Voice for which you wish to insert a Display Quantize Event.
This is done by clicking at the corresponding Voice button on the Score Toolbar as described 
above, or by selecting a note that belongs to this Voice.

3. Select the Display Quantize tool.
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4. Click at the position you want to insert the event.
The Display Quantize dialog appears.

5. Fill out the dialog as described on page 70. 
For additional hints, see page 78.

6. Click the “OK” button.
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Creating Crossed Voicings

Often, for example in vocal scoring, you will have crossed voicings on one system. 
You can of course move notes manually into voices to get the stem direction and 
other note properties right, but there’s a quicker way. Let’s explain how to do this 
by example. Without using polyphonic voicing, you have entered this:

1. Make sure the To pop-up menu is set to All, so that the all notes will be affected.

2. Open the Staff settings dialog.

3. From the Staff Mode pop-up menu, select Polyphonic.

4. Click the Edit button.

5. Activate voice 1 and 2, and make settings for them as in the picture below.

6. Activate “Auto Move To Voices” and “Lines To Voices”.

For this example, the dialog box should be set up like this.

7. Click OK.

8. Close Staff Settings.

9. Examine the Score.
From the middle of the bar, notes that are in voice 1 should be in voice 2 and vice versa.
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10.Select the two notes that should be moved from Voice 1 to Voice 2.
The To menu is automatically set to “Selected”.

Two notes in Voice 1 selected.

11.Move the notes to Voice 2.
By default, the quickest way to do this is to press [Option]-[2].

Two notes moved to the right voice.

12.Select the two notes that should be moved to Voice 1 and move them too.

All notes in the right voices.

The voicing is now correct, as you can tell from the stem directions. However, there's 
still some work to do on the notes graphical positions (see page 173) and the stem 
lengths of some of the notes (see page 170). When you have made those adjust-
ments, the score may look like this:

After graphical adjustments.
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Automatic Polyphonic Voicing - Merge All Staves

If you have already created some Tracks which look and play back as they should, 
and you want to combine these into one Track with polyphonic voices, there is a 
special function on the Score menu for this:

1. Open the Tracks (up to four) in Score Edit.
As previously described, you could either select the Tracks in the Arrangement first, or add 
Tracks to the Score Edit display using the Display Tracks feature.

2. Pull down the Score menu and select “Merge All Staves” from the Staff Functions sub-
menu.
Now a new Track is created and added to the Score Edit display. The Track will have Poly-
phonic Voices activated, and the four original Tracks will be assigned to one voice each 
(voices 1, 2, 5 and 6 will be used).

Furthermore, all non-linked symbols, that belongs to the staff that will become the first poly-
phonic voice in the merged staff, will be copied. They will have same positions as the original 
symbols. 

❐ When you later play back the music, you need to mute the four original Tracks, or you 
will get double notes. 
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Converting Voices to Tracks - Extract Voices

This function does the opposite of “Merge All Staves” - it extracts polyphonic voices 
from an existing Track and creates new Tracks, one for each voice. Proceed as fol-
lows:

1. Open a Track containing 2-8 Polyphonic Voices in Score Edit.

2. Pull down the Score menu and select “Extract Voices” from the Staff Functions sub-
menu.
A number of new Tracks are created and added to the Score Edit display. Each Track will con-
tain the music from one polyphonic voice. If there were non-linked symbols in the original 
Track, each new Track will get a copy of these symbols. 
Each new Track will also automatically get a Layout (a copy of the original Layout for the 
Polyphonic Voicing Track, with Size set to 100% and Multi Rests set to 1). For more info on 
Layouts, see page 263.

❐ When you later play back the music, you need to mute the original Track (the one with 
polyphonic voices), or you will get double notes. 



- 149 - 

8
Additional Note and Rest Formatting



- 150 - 

In this Chapter you will learn:

• How to control Stem Direction.
• How to control Beaming, and create cross staff beaming.
• How to make detailed adjustments to note appearance.
• How to perform “Graphic Moving” of notes.
• How to create Grace Notes.
• How to create Tuplets.

Background: Note Stems

The direction of stems is governed by six things:

• How notes are grouped under beams.
• Any manual manipulation of beams.
• The Flip Stem function.
• How the Note Info is set for each note.
• How the Polyphonic voicing dialog is set up (if you use Polyphonic Voices).

Also, there is a priority system with these steps, as they are listed above. In other 
words, if you have adjusted the beam slant “by hand” (see below), it doesn’t matter 
if you previously flipped the stems, or how the note was set up. If you have flipped 
the stems it doesn't matter how the notes or voices were set up, etc.

❐ If you have edited the stem length of a note and then flip it, the stem will be reset to de-
fault length.

❐ If you have activated the “Fixed Stems” option in the Staff Options dialog (see page 
127), a lot of the automatic stem length settings are ignored. However, you can still 
edit the stem length and direction of individual notes.
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Setting Stem Direction

In Poly Voices

Stem direction can be set separately for each voice.

This is the stem setting with the lowest priority. It is only valid if no other settings 
were made specifically.

In the Note Info dialog you find stem direction settings for each voice (see page 153):

Select This: When:

Up When you want the stems in the voice to point upwards.

Down When you want the stems in the voice to point downwards.

Auto When you want the program to take decisions about stem direction, based on the 
other voices, the notes’ pitches etc.

The Voice Stem settings
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Using Flip Stems

Flipping the Stem of a single Note

1. Select the Note.

2. Invoke Flip Stems.
There are three ways of doing this:

• Click the Flip icon on the Score Toolbar.

• Select Flip from the Do pop-up menu.

• Use the “Flip” key command (by default [Option]-[X]).

Flipping the Stem of a number of selected Notes

1. Select the Notes.

2. Invoke Flip Stems as described above.
All the stems in the selection are now flipped. Those that pointed up now point down and 
vice versa.

Flipping the Stems of Notes grouped under a Beam

1. Select any note in the Group.

2. Invoke Flip Stems as described above.
The entire group is now flipped. 

Before and after the flip. No matter which note you select, the entire group is flipped.

❐ This will not work if you have adjusted the slanting of the beam by dragging. If you 
have, you must first reset the beam as described on page 154.

Independent Stem Direction under a Beam

If you need stems attached to the same beam to go in different directions, this is 
achieved by dragging the beam’s start and end points, as described on page 170. 
This feature is available in Page Mode only.

Independent stem direction under a beam.

Flip Stem 
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Stem Direction in the Note Info Dialog

The Note Info Dialog can be opened by double clicking on a note head, as described 
below. To the right in the dialog you will find a pop-up for setting stem direction.

The Note Info dialog with the Stem pop-up.

• Setting this to Up or Down is the same as using Flip Stems, see above. 
• Setting it to Auto makes the program take decisions about stem direction, as described 

above. 
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Stem Length

Adjusting Stem Length (Page Mode)
1. To change the Stem Length, proceed as follows:

2. Click on the end of the stem so that a handle appears.

The Stem handle selected.

3. If you want to change the lengths of several stems at the same time, hold down [Shift] 
and select these stems as well.

4. Drag the stem handle (on one of the selected stems) up or down.

Dragging the stem.

All selected stems will be lengthened or shortened by the same amount.



- 155 - 

Resetting Stem Length and Beam Slants
1. Select Show Invisible from the Global Settings submenu on the Score menu.

The Show Invisible dialog appears.

2. Make sure “Stems/Beams” is activated.

• This can also be done using the “Show Invisible” Filter Bar (see page 55).

3. Click OK.
Now, below the notes where stems have been changed or beam slant adjusted manually, 
the word “Stem” will appear.

4. Click on the “Stem” text to select it.

5. Press [Backspace].

Before and after deleting the “Stem” item.
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Accidentals and Enharmonic Shift

Making Global Settings

In the Preferences–Scores–Accidentals dialog you will find a number of options for 
how accidentals are displayed in the score. Once set, these are valid for all Tracks in 
the Arrangement. Proceed as follows:

1. Select “Scores” from the Preferences submenu on the Edit menu.
The Preferences–Score dialog opens.

2. Select the “Accidentals” page.

The Accidentals page in the Preferences–Score dialog.
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3. Activate one of the four main options by clicking on the graphics:

4. With the radio buttons to the right, you can decide how five of the most common inter-
vals outside the scale should be displayed, as sharps or as flats.

5. If so desired, activate “Use Chord Track for Accidentals”.
This option is described on page 234.

❐ There is a further option for accidentals in the Preferences–Scores–Modern Style dia-
log, called “Accidental for Each Note”. When this is activated, all notes get accidentals -
even tied notes.

Enharmonic Shift

If one or several notes are not displayed with the accidentals you wish, you can per-
form an Enharmonic Shift on them.

1. Select the notes to be shifted.

2. If you want to put further restrictions on which notes get shifted, set up a Cycle or a 
Loop and set the To menu to “Cycled Events” or “Looped Events”.

3. Click the desired option on the Score Toolbar.

Automatic Enharmonic Shift

It is possible to create automatic enharmonic shifting of notes by using a chord Track. 
This is described in detail on page 234.

Select This: When You Want:

Regular Notes outside the scale to get accidentals. In this mode, accidentals are not re-
peated within a measure.

Help As above, but if a note “outside” the scale is followed by one “inside” the scale (in a 
following measure), this second note will be displayed with an accidental.

All not in key As Regular, but accidentals get repeated even within the same measure.

All Every single note in the score gets an accidental.

Select This: When:

You want regular Enharmonic Shifting (select one option).

You want to turn off Enharmonic Shifting for the note(s).

You want to Hide the accidental completely.

You want to create a “help accidental” for the selected note(s) only. For more 
info see the Global Help option described above.

You want to enclose the accidental in parentheses. To remove these, select 
“Off”.
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Changing the Note Head Shape

1. Select the notes whose note head shape you want to change.
Make sure not to select the stems, only the note heads. The To pop-up menu is automatically 
set to “Selected”. You may also set up the To pop-up menu so that all notes in the Loop or Cy-
cle get affected, as with all editing functions.

2. Select “Get Info” from the Edit menu or click the “i” button on the Score Toolbar.
The Note Info dialog opens.

3. Pull down the “Note Head” pop-up menu at the top left corner of the dialog.
The pop-up menu contains all the available head shapes and an “Auto” option, which selects 
the normal default shape for the note.

The Note head menu.

4. Select one of the note heads.

5. Click Apply.
The settings are applied to the selected note(s).

6. If you like, select other notes and make settings for them.
When you are done, close the dialog by clicking its Close box.



- 159 - 

Changing the Note Head Color

You can give a note or a group of notes a certain color using the color palette pop-
up menu on the Status Bar:

1. Select the note or notes that you want to color.
The To pop-up menu applies as always. If you want to color all notes, make sure the To pop-
up menu is set to “All”.

2. Select a color from the color pop-up menu on the Status Bar. 
The color is applied to the note head(s) and accidentals.
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Editing the Colors

You can edit the existing colors and names, or add new colors, in the Preferences–
Scores–Score Colors dialog:

1. Select the “Edit...” option at the bottom of the color pop-up menu.
The Score Colors dialog opens. You can also access this by selecting “Score Colors” from the 
pop-up menu in the Preferences–Scores dialog.

2. To edit a color, double click on the color box to the left of the name.
A standard Macintosh color dialog appears (for details, see the Macintosh documentation).

3. Adjust the color and click OK to close the dialog.

4. To change the name of the color, double click on its name field.

5. To add a new color, click the Add button.
A new color is added to the list. You can change its color and name as described above.

6. To remove a color, select it and click the Remove button.

7. If you want the Score Colors to be saved with the Song, activate the Save with Song 
checkbox.
If this is deactivated, the color settings are saved in the Cubase Preferences instead (and will 
be available for other Songs as well - see the Getting Started book).

8. When you are done, click on the OK button to return to Score Edit.

About Additional Colors

If you have activated the option “Use Colors for Additional meanings” in the Prefer-
ences–Scores–Editor Behaviour dialog, some objects will automatically be displayed 
in color, to indicate that they are “special” in any way. For example, slurs and note 
symbols that are moved from their default positions (see page 214) will be displayed 
in red.
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Other Note Details

Each note has a number of settings accessed in the Note Info dialog. There are four 
ways to open the Note Info dialog:

• Double click on a note head.

• Select one or several notes and select Get Info from the Edit menu.

• Select one or several notes and click the “i” icon on the Score Toolbar.

• Select one or several notes and use a key command (by default, [Command]-[I]).

The Note Info dialog contains the following settings:

Setting: Description:

Note Head Used for selecting custom note head shapes (see page 158).

Tablature On/Off 
and number

Used for creating or editing Tablature (see page 304). This feature can be 
used for individual notes or together with the automatic “Make Tablature” 
function.

Bow Up/Bow Down Used for adding bow up/bow down articulation.

Bow Up and Down

Display Length This allows you to change the displayed length of notes, without affecting 
playback. Note that the Display Quantize settings still apply (see page 125). 
To reset this value to “Auto” (so that notes are displayed according to their 
actual length), scroll the value down to zero.

“Get Info”
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• After changing a setting, you can apply the change to the selected note(s) by clicking 
the Apply button.
Note that you can select other notes while the dialog remains open, adjust their settings and 
click Apply.

When you are done with all settings, close the dialog by clicking its Close box.

Accidental Distance Use this to specify how far from the note, horizontally, you want the acci-
dental. The higher the number the further away.

No Help line Turns off help lines for notes with high or low pitches.

With and without help lines

No Stem Hides the note stem completely

Bracket Head When this is activated, notes will be displayed with brackets:

Bracket Head off and on.

X-stem (spoken) When this option is activated for a note, it is displayed with an x across its 
stem. This is normally used to indicate spoken words.

Stem pop-up Determines the stem direction, as described above.

Tie pop-up Determines the direction of ties. When this is set to “Auto” (the default set-
ting) the program will choose a tie direction depending on the stem direc-
tion of the tied notes.

• You can also flip the direction of a tie directly in the score, by selecting a 
tied note, holding down [Command] and clicking the “Flip” button on 
the Score Toolbar.

Type pop-up Determines the note type. There are four options:

• Normal. This is how notes usually are displayed.
• Grace. When this is selected, notes will be displayed as grace notes. This 

is described in detail on page 176.
• Cue. When this is selected, notes will be displayed as cue notes (smaller 

notes, often used as “guide notes” or optional lines). See page 174.
• Graphic. These are special notes, useful for example for guitar notation 

(pull-offs) and trills (as “help notes”, indicating which notes to trill be-
tween). In both these cases the “No Stems” option could be useful. 
Graphic notes are not included in the “automated cutting” (see page 
172). They are positioned after the note(s) they “belong to” (as opposed 
to grace notes).

Grace Note options These options are enabled when Grace is selected on the Type pop-up 
menu. See page 176.

Hide Note Ticking this checkbox will hide the selected note(s), just as if you had se-
lected “Hide” from the Do pop-up menu.

Setting: Description:
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Copying Settings between Notes

If you have made various settings in the Note Info dialog for a note, and want to use 
these settings for other notes as well, there is an easy way to do this:

1. Set up the first note as desired.
This includes the Note Info settings, but also any note-related symbols (such as accents, stac-
cato, articulation, etc. - see page 192).

2. In the score, select the note and select “Copy” from the Edit menu.

3. Select the notes to which you want to copy the attributes.

4. Pull down the Do pop-up menu and select “Paste Note Attributes”.
The selected notes will now get the attributes of the first, copied note, but their pitches and 
note values will remain unchanged.

Handling Beaming

Turning Beaming on/off

Beaming is turned on/off independently for each staff.

1. Open the Staff Settings dialog.
See page 68 and page 119 for details.

2. Click the “Staff Options...” Button.

3. To turn off beaming, activate No Beams.

Even if beaming is turned off for the staff, you can put some notes under beams, as 
described below.
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Grouping

When beaming is on, the program automatically groups notes under beams. How-
ever, there are a number of ways to determine how notes are grouped.

Using the Time Signature Dialog

The Time Signature for the piece naturally affects grouping. But you can control this 
yourself by creating a composite Time Signature used only for Grouping:

1. Open the Time Signature Dialog.

2. Set up the Numerator with the Grouping you desire.
If you for example want eighth notes in two groups of three and one group of two, enter 
3+3+2.

3. Set the Denominator, if needed.

4. Activate “For Grouping Only”.

The Time Signature dialog with “For Grouping Only” activated.

5. Click OK.

❐ Please note that the “For Grouping Only” only refers to how the numerator is divided. 
Any changes you make to the “sum” of the Numerator number or the denominator will 
result in a change of actual Time Signature in the piece. If you need a grouping which 
can’t be entered in the current time signature, you will have to group notes manually, 
see below.
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Grouping a number of Notes

If the Grouping the program assigns isn’t the one you want, you can put any selec-
tion of eighth notes or smaller under a beam:

1. Select at least two notes, where you want the beam to begin and end.
You can also select notes in between these two if you wish, it doesn’t matter.

2. Group the notes, either by selecting “Group” on the Do pop-up menu or by clicking the 
Group icon on the Score Toolbar.

Before and after Grouping.

Group Options

You can choose individually for each Group whether you want it to be shown with 
regular beaming or as “Repeats”:

1. Display the “Show Invisible” Filter Bar in the Score window (by clicking the “F” button 
in the lower right corner) and make sure the “Grouping” checkbox is activated.
Now, you will see the text “Grouping” below all created Groups.

2. Double click on the “Grouping” text for the Group you want to make settings for.
A dialog box appears.

The Group icon
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3. Use the two radio buttons at the bottom of the dialog to select whether you want reg-
ular beaming (“None”) or Repeats.

In this example, the “Repeat” feature is used to display two pairs of sixteenth notes, as two 
eighth notes with “repeat bars”. Note that the second and fourth sixteenth note have been 
hidden - the playback is not affected!

4. If you selected “Repeat”, use the radio buttons to select the note value for the repeats.

5. Click OK to close the dialog.

Grouping Quarter Notes (or larger)

It is possible to use the Grouping feature for notes that are not displayed with 
beams (quarter notes, half notes, etc.). The result is “spectacle bass” symbols, com-
monly used for indicating tremolo, etc.

• Double clicking on the “Grouping” text opens the Grouping dialog, allowing you to ad-
just the “note value” for the symbols.

Removing Groups

If you have made a Grouping as described above, and wish to remove this, proceed 
as follows:

1. Pull down the Score menu and select “Show Invisible” from the Global Settings sub-
menu.
The Show Invisible dialog appears.

2. Make sure “Grouping” is activated and close the dialog.
Now, you will see the text “Grouping” below all created Groups. This can also be achieved by 
activating the “Grouping” checkbox on the “Show Invisible” Filter Bar.

3. Select a Group by clicking on its “Grouping” text.

4. Press [Backspace].
The Grouping is removed.

• If you need to remove all Groups from the score, hold down [Shift] and double click on 
the first “Grouping” text. 
This selects all “Grouping” symbols, so you can delete them all at once by pressing [Back-
space].
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Removing a Note from a Group

There is no special “Ungroup” command, simply because it isn’t needed. A Group 
can consist of one note if you wish. In other words... 

• To remove one note at the end of a Group, select it and proceed with Grouping as above.
• If you select notes in the middle of a beam and then Group, three Groups are created.

Before and after Grouping.

Automatic Grouping

The Program can also run through the score and create Grouping for you. Proceed 
as follows:

1. Select all notes (for example by using the Select All command on the Edit menu).

2. Select “Auto Grouping” from the Do pop-up menu.
You can also do this by holding down [Command] and clicking the Group Icon on the Score 
Toolbar.

In 4/4 you will for example get two groups of eighth notes per bar, in 3/4 you will get one 
group per bar, etc.

Before and after using Auto Grouping in 4/4.

Cross Staff Beaming

To create a beam that extends from one staff to another, proceed as follows:

1. Set up a Split or Polyphonic Voicing system or open the Score Editor with more than 
one Track.

2. Set up a beam of notes (using the Group command) and adjust the pitches of them so 
that they are correct even though some of the notes are on the wrong staff.
You want to use the Info Line to edit the pitches if they are very low or high.

3. Select the note(s) that should appear on the other staff.



- 168 - 

4. Select “Move To Staff” from the Staff Functions submenu on the Score menu. Select a 
Staff from the submenu that appears.

The Move To Staff submenu.

The notes are “graphically” moved to the selected system, but keep their actual 
pitch.

Before and after moving a note to the lower staff.

5. If needed, adjust the beam appearance (see page 170).

Cross staff beaming with the beam in the middle.

The Move To Staff operation does not actually move the note to another Track. It 
only makes it “look” like the note belonged to the other staff.
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Handling Beam Groups

There are two settings for groups under a beam, “Beam subgroups” and “16th Sub-
groups”, both found among the Staff Options (accessed from the Staff Settings dia-
log). If Beam Subgroups is activated, the program displays subgroups after four 
sixteenth notes under a beam. If you also activate 16th Subgroups, subgroups ap-
pear after only two sixteenths.

Beam Subgroups Off, On and On with 16th Subgroups activated.

Beam appearance and Slant settings

Global Settings

In the Preferences–Scores–Beams and Bars dialog, you will find three options for 
how Beams should appear:

• Thick Beams.
Activate this if you want beams to be displayed as thick lines.

• Show Small Slants as Flat Beams.
When this is activated, beams that would be only slightly slanted will be displayed flat.

Without and with “Show Small Slants as Flat Beams”.

• Slanted Beams only Slightly Slanted.
Activate this if you only want a slightly slanted beam even though there might be a signifi-
cant pitch difference between the notes under the beam.

Without and with “Slanted Beams only Slightly Slanted”.

❐ Please note that these settings apply equally to all staves.
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Staff Settings

In the Staff Options dialog, you will find a couple of settings for Beams as well. 

Manual Adjustment of Beams

For very detailed control you can manually adjust the beam slant:

1. Group and Flip Notes and adjust the settings described above until the beams are as 
close as possible to how you want them.

2. Click on the corner made up by the beam and the stem.
Handles appear.

Beam handles.

3. Drag the handle up or down.

Dragging a handle and the effect it has.

Mixed Staff Direction

By dragging the beam handles you can put the beam between the note heads:

Putting the beam between the notes.

Activate This: When:

Flat Beams When you don’t want any slant at all, no matter the pitch difference of the 
notes under the beams.

No Beams When you don’t want any beams at all.
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About Tied Notes

Sometimes, notes will be displayed as two or more notes tied together. Generally, 
there are three different occasions when this will happen:

• When a note is of an “uneven” length, that cannot be displayed without tying together two 
or more notes of different note values.

• When a note crosses a bar line.
• When a note crosses a “group line” within a bar.

The last case requires some explanation: Cubase VST uses a “cutting mechanism” 
that automatically creates tied notes depending on the length and position of the 
notes. For example, a quarter note is cut in two and tied, if it crosses a half note 
beat, and an eighth note is cut in two and tied, if it crosses a quarter note beat:

However, this isn’t always what you want. There are three ways to affect the cutting 
mechanism:

Syncopation

When the Syncopation option in the Staff Settings dialog is activated, Cubase VST 
will be less prone to cut and tie notes. For example, the second quarter note in the 
figure above would not have been cut if Syncopation had been activated.

The Syncopation setting in the Staff Settings dialog affects the whole Track, but you 
can also make Syncopation settings for separate sections in the score, by inserting 
Display Quantize Events (see page 78).

Time Signature Changes

By inserting time signature changes, you can change the way notes are cut. This is 
done in the same way as when you specify how beamed notes should be grouped 
(see page 164).

This quarter note is cut. This eighth note is cut.

With a regular 4/4 time signature.

With a composite time signature (3+2+3 eighth notes).
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The Cutflag Tool

By using the Cutflag tool, you can disable the automatic cutting mechanism in a 
bar, and insert manual cuts at any given position in the score:

1. Select the Cutflag tool.

2. Set the Snap pop-up menu to an appropriate value.
As usual, this determines where you will be able to click.

3. Click in the bar containing the note(s) you want to cut manually, at the position you 
want them cut.
This inserts a Cutflag Event in the bar at the position you clicked. If you press [Command] 
while clicking, a Cutflag Event is inserted for all staves. If you hold down [Option], a Cutflag 
Event is inserted for all voices in a polyphonic staff.

The following rules apply to Cutflag Events:

• If a bar contains a Cutflag Event, the automatic cutting mechanism is disabled within 
that bar.

• All notes or rests that start before and end after a Cutflag Event, will be cut at the posi-
tion of the Event.

• To display Cutflag Events, make sure that “Cutflag” is activated on the Filter Bar or in 
the Show Invisible dialog on the Global Settings submenu.

• To remove a Cutflag Event, either click again with the Cutflag tool at the same position, 
or select it and press [Backspace].

When you click at the position 2.2.1.0, a 
Cutflag Event is inserted....

A half note, positioned at 2.1.3.0. This is by default cut at 2.3.1.0 (in the middle of the bar).

As a result, the regular cutting mechanism is disabled and 
the note is cut at the position you clicked instead.
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Other Options for Tied Notes

Tie direction

As described on page 162, you can set the direction of the tie manually in the Note 
Info dialog. You can also flip the direction of one or several ties, by selecting their 
notes in the score and [Command]-clicking the Flip icon on the Score Toolbar.

The Flip icon.

Flat Ties

If you prefer ties to be displayed as flat lines, rather than regular “curved” ties, acti-
vate the option “Flat Ties” in the Preferences–Scores–Modern Style dialog.

Graphic moving of Notes

There might be instances where the “graphical” order of the notes isn’t the one you 
want. In this case you can move the note without affecting the score or playback in 
any way. There are two ways to do this:

By using the Layout Tool
1. Select the Layout Tool from the Toolbox.

The Layout tool in the Toolbox.

2. Click on the note and drag it right or left.
Movement is restricted to horizontally only.

Before and after changing the “graphical order” of notes.

By using the computer keyboard
1. Select the note(s) you want to move.

2. Hold down [Option].

3. Press the left and right arrow keys to move the note(s) left or right.
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Cue Notes

You can create Cue notes by using Voices or by converting individual notes into 
cue notes.

Setting a Voice to display Cue Notes

1. Open the Polyphonic Settings Dialog.
This is described on page 132.

2. Click in the “Cue” column for the voice, so that a tick mark appears.

3. Decide for a rest handling for the voice.
You might for example leave the “Rests–Show” activated and activate “Reduce”. If you do, 
you will get rests in this voice, but not as many as otherwise. Empty bars, for example, will 
not have any rests at all.

4. Close the dialog.

5. Move the notes into the Cue Voice.
Polyphonic Voicing is described in detail on page 129.

An example of a Cue note Voice.

A quick example

Let’s say you have a flute part and want some cue notes for it.

1. Switch on Polyphonic Voices and activate Voice 1 and 2.

2. Set Voice 2 to “Auto” stem direction and centered rests.

3. Set up Voice 1 to be a Cue voice, with hidden rests and stems pointing up.

4. Insert the cue notes into Voice 1.

“Cue” activated for Voice 3.
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Turning individual Notes into Cue Notes

1. Select one or several notes.

2. Select “Get Info” on the Edit menu or click the “i” icon on the Score Toolbar.
The Note Info dialog appears.

3. Select Cue from the Type pop-up.

Note type set to Cue.

4. Click Apply.
The settings are applied to the selected note(s).

5. If you like, select other notes and make settings for them.
When you are done, close the dialog by clicking its Close box.
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Grace Notes

You can turn any note into a grace note. Grace notes are considered to be notes 
without lengths. That means that once a note is turned into a grace note it doesn’t 
affect the rest of the score display in any way.

Before and after converting to grace notes. Note that after the conversion, the grace notes no 
longer “interfere” with the interpretation of the other notes.

❐ Grace notes are always automatically positioned just before the next note on the staff. 
If there is no note after a grace note on the staff, the grace note will be hidden!

Creating Grace Notes Manually

1. Locate the note for which you want a grace note.

2. Insert one or more new notes just before it.
The note value and exact position of the note isn’t important. However, the pitch of course is.

From here on there are two ways to go:

• Select the note(s) and select “Get Info” from the Edit menu.
The Note Info dialog appears and you can activate Grace Note and other settings if needed.

• Select the note(s) and then select “Grace Note” from the Staff Functions submenu on 
the Scores menu.
This turns the note into a Grace note without opening any dialog.

Grace Notes and Beaming

• If two Grace notes are at exactly the same position (the same tick), they will be put onto the 
same stem, as a chord.

• If multiple Grace notes in front of the same note are put on different positions (even if they 
are only on tick apart), they will be grouped under a beam.

• Please note that it is possible to have beamed grace notes overlapping a beam of regular 
notes, as in the example below:

Grace notes in the middle of a group of regular notes.
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Creating Grace Notes Automatically

The program allows you to search for notes that make good candidates for grace 
notes and convert them automatically. It does this by looking for notes that are 
very close to other notes.

1. Set up the To menu.
This allows you to have the function only work on the selected notes, on the notes inside the 
Cycle etc.

2. Select “Find Grace Notes” from the Staff Functions submenu on the Scores menu.

3. Enter a ticks value.
This number will determine how close a note has to be to another to be considered a grace 
note.

4. Click OK.
The new grace notes now appear.

5.  If you didn’t get what you expected, Undo and try again.

Editing a Grace Note

1. Select one or several grace notes and open the Note Info dialog.

The Grace Note settings in the Note Info dialog.

2. Select a note value for the stem.

3.  Activate crossed, if you wish.
When this is activated, the stem will be crossed by a slanted line, to further indicate that the 
note is a grace note.

4. Click Apply.
The settings are applied to the selected note(s).

5. If you like, select other notes and make settings for them.
When you are done, close the dialog by clicking its Close box.
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Using the “As Default” button

If you double click on a grace note, set it up as described above and then click on 
“As Default”, the settings you have made will be used as default values. All grace 
notes that you will create and all that you have created and not edited specifically 
will use these settings.

Converting Grace Notes to normal Notes

1. Select the notes you want to convert.
If you want to make sure that all notes in the score are normal notes, you can select all notes 
(using the Select All command on the Edit menu).

2. Double click on one of the selected grace notes.
The Note Info dialog appears.

3. Select “Normal” from the “Type” pop-up.

4. Click Apply and then close the dialog by clicking its Close box.
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Tuplets

The regular Display Quantize values do not apply to any other divisions than triplets. 
To create quintuplets, septuplets etc., follow the instructions below. 

There are basically two methods of creating tuplets:

• With permanent alteration to the MIDI data. This is the “drawing” mode to use when you 
want to build the tuplet from scratch. It doesn’t put any demand on the notes’ positions be-
fore the tuplet is created.

• As Display Quantize. This is the method you use when the tuplet is recorded and plays back 
as you want it, but it is not displayed correctly.

Actually, in the first case, you make permanent alterations and set Display Quantize 
settings, all in one go. In the second case you only make Display Quantize settings.

With permanent change to MIDI Data

1. Insert as many notes as the tuplet consists of.
This would typically be 5, 7 or 9. If the Tuplet contains rests, simply leave space for those, but 
make sure the current Display Quantize value allows them to be shown.

Five sixteenth notes, about to be converted to a quintuplet.

2. Select all the notes that make up the tuplet.

3. Select “Build N-Tuplet” from the Staff Functions submenu on the Score menu.
The tuplet creation dialog appears.

4. Set the type of tuplet in the Type field.
“5let” means a quintuplet, “7let” means a septuplet etc.

5. Set the length of the entire tuplet using the “Over” field.
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6. Activate Change length, if you need it.
If you do, the program will alter the length of all notes so that they are exactly the note value 
the tuplet indicates. If you don’t, the lengths of the existing notes won’t be affected in any way.

7. If you want any other text than the standard above the tuplet, type it in the “Text” 
field.
The standard text is simply the number in the type field. If the tuplet is put under a beam (see 
page 181) the “Text” is put just above it. If there is no beam, the “Text” is found in the middle 
of a bracket.

8. Click OK.
The tuplet appears. The notes have now been moved to the tuplet positions and their length 
might have changed. 

The tuplet just after being created.

9. If needed, edit the lengths and pitches of the notes in the tuplet.
You can also make various settings for the appearance of the tuplet - see below.

Without Permanent Change To MIDI Data

1. Select the notes in the tuplet group.
In this case, these are notes that play back correctly but aren’t displayed as a tuplet (yet).

2. Pull down the Do pop-up menu and select “Insert Tuplet”.
A dialog appears. This is essentially the same dialog as with the “Build N-
Tuplet” function, but without the “Change Length” option.

3. Make settings in the dialog, as described above.

4. Click OK.
Now the tuplet is displayed correctly. You can make additional settings for how the tuplet 
should appear, as described below:

5. If needed, adjust the notes.

❐ Lengths and positions in a Tuplet group are probably best edited using the Info Line. 
Or at least with Snap set to Off!
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Editing Tuplet Settings

1. Double click on the Text above the Tuplet group.

2. The Build Tuplet dialog appears.

3. Adjust the settings as needed.
You may change the Type and Over fields, but this will affect the display of the current tuplet, 
so be careful.

4. Click OK.

Grouping

If the Tuplet is a quarter note long or shorter, the notes will be automatically 
grouped under a beam. If it is longer you have to perform the grouping manually. 
See page 164 for details.

Tuplet Display Options

In the Preferences–Scores–Additional Settings dialog you will find the following 
settings for Tuplets:

Display Tuplets without 
Brackets and 
Always Show Tuplet 
Brackets

These two options are mutually exclusive - turn one on and the other is 
turned off. When Display Tuplets without Brackets is activated, tuplets 
never have brackets. When the other option is active, tuplets always have 
brackets. When neither option is activated, tuplets may have brackets, 
depending on the position of the beam (above or under the note heads).

Display Tuplet values by 
the Beams

When this is activated, Tuplets will be displayed on the “beam side” of 
the notes instead of on the note head side.

Suppress Recurring 
Tuplets

When this is activated, and you have several Tuplets of the same type in 
the same bar, only the first of these are displayed as a Tuplet.

Show Tuplet Brackets as 
“Slurs”

When this is activated, the Tuplet brackets will be “slur-like” (rounded).

Double Click here.



- 182 - 

9
Working with Symbols
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In this Chapter you will learn:

• What the different types of symbols are.
• How to insert and edit symbols.
• Details about special symbols.

Background: The Layout Layer

A Scoring page is always made up of two layers – the Note Layer and the Layout 
Layer. When you add Symbols, these will be inserted into either layer, depending on 
the type of symbol. Those symbols that have a general relation to notes – accents, dy-
namic markings, slurs, lyrics etc. – will be put in the Note Layer. Other symbols – such 
as repeats, rehearsal marks, some types of text, etc. – are put in the Layout Layer. 
Later in this chapter you will find detailed information about which symbols belong 
to which layer.

We will now look at the symbols in these two layers, in more detail:

Note Layer Symbols

Let’s look at the Note Layer symbols first. These come in three flavors:

• Note symbols. These are each tied to a single note. Examples of Note symbols are accents 
and lyrics. When you move the note, the symbols moves with it. The same is true if you Cut 
the note and then Paste, the symbol is Cut and Pasted at the same time.

• Note dependant symbols. Only a few symbols belong to this category, for example the ar-
peggio lines. In one way, these behave just like grace notes (see page 176). They must always 
be in front of a note or chord. If there is no note “after them” on a staff, they will disappear.

• All other Note Layer symbols (Tempo, dynamics, chords etc.). These have their position re-
lated to the bar. No matter what you do to notes, they remain unaffected. However, their po-
sitions are tied to their position within a measure. If you for example change the spacing of 
the bars across the page (see page 281) this will affect the symbols’ positions.

Layout Layer Symbols

Now let’s examine the Layout Layer Symbols. As described above, there is a certain 
collection of symbols, which are drawn in a different “layer” on the page than all 
other graphic elements. These are called Layout Layer symbols. All these Symbols 
are collected in the “Layout” section of the Symbols Palette, see below.

Layout Layer 
Symbols

Note Layer 
Symbols
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How the Layout Layer is stored

❐ It is very important to understand how the Layout layer is handled to avoid some oth-
erwise potential confusion.

The Layout layer is not stored individually for each Track, as the other symbols are. 
Instead it is common to a “set of Tracks”. Let’s illustrate this with an example:

You have four Tracks that make up a string quartet. You edit them all at the same 
time and add Symbols to the score, both Note Layer Symbols and Layout Layer 
Symbols.

Now let’s say you close the Score editor and open only one of the Tracks for editing. 
All your Note Layer symbols are there just as you left them, but the Layout Layer 
Symbols have disappeared!

Don’t worry, close the Editor again, and open all four Tracks for editing and the 
Symbols are back.

You have probably got a clue to what is going on by now. The Layout Layer symbols 
are part of a “bigger entity” called – the Layout. And a Layout is something that is 
stored not per Track, but for a group of Tracks. Each time you open the same combi-
nation of Tracks for editing, you get the same layout.

There are also other things that are part of the layout — apart from he Symbols in 
the Layout Layer. You will find more info about this in “Working with Layouts”.

Why two Layers?

There are two reasons for this division into layers:

• Many of the Symbols that are in the Layout Layer can be stretched to span over several Staves, 
or for other reasons make more sense to think of as belonging to a certain group of Tracks.

• The Layout Layer is only one part of the bigger concept of Layouts. Layouts allows you to 
easily extract parts from a full score and perform automatic formatting. This is all described in 
“Working with Layouts”.

Hiding the Note Layer

To view the Layout Layer only, go into Page Mode and select “Layout Layer Only” 
from the Score menu. This view is redrawn very fast on the screen and may for ex-
ample be used to quickly scan through many pages to find a certain part of the 
score which can be identified by its Layout Layer symbols.

“Layout Layer Only” activated for the example in the previous illustration.

On page 187 and onwards you will find out which symbols are part of the Note 
Layer and which are part of the Layout Layer.
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The Symbol Palettes

Displaying Palettes

From the main menus

1. Select Symbol Palettes from the Score menu.

2. From the submenu that appears, select any of the Symbol Palettes.

3. If you want one more Palette, of some other type, select it as with the first one.

You can have more than one Symbol Palette on the screen at a time.

Directly from the Palette

1. If the Symbol Palette is displayed as a vertical window (see below), you will find a small 
“name label” at the top of the window. Point at this label and press the mouse button.
A pop-up menu appears.

The Symbol Palette pop-up.
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2. If you want the new Palette to replace the current one, simply select the desired Palette 
from the list.
The window will now show the selected Palette.

3. If you want to display the new Palette without closing the current one, hold down 
[Command] and select a Palette from the list.
A new window opens with the selected Palette. The first Palette window remains open.

Moving and Handling Palettes

Palettes are handled as any window, which means that you can:

• Move a Palette around by dragging its title bar. 

• Close a Palette by clicking its Close box.

There are also a few special features for handling Palette windows:

• You can decide whether you want a Palette to be displayed vertically or horizontally, 
by clicking on the window’s zoom box.
This is possible for all Symbol Palettes except the “Clef” Palette, which is always displayed 
horizontally.

• You can close all open Palettes by selecting “Close All” from the Symbol Palettes sub-
menu on the Score menu, or by holding down [Option] and double clicking on the close 
box of one of the Palettes.

• You can have all open Palettes automatically arranged around the Score Edit window, 
by selecting “Arrange Palettes” from the Symbol Palettes submenu on the Score menu.
This ensures that all open Palettes are fully visible.
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The Available Symbols

The illustrations below show all the symbols available, divided by group (see above). 
The captions contain additional information about the symbols in the Group.

The “Clef etc.” Palette.

Clef Change

Key Sig. Change

Time Sig. Change

Line

Octave

Tuplet Bracket

Line

Octave

Tuplet Bracket

Beam Beam

Beam Beam

Staff Separator Turn

Trill

Mute etc.

Arpeggio

Hand 
Indication

Arpeggio

Arpeggio

Trill

Trill

Trill

Trill

Hand 
Indication

Strum Strum

Staccato Tenuto

Accent

Pizzicato

Accent

Tremolo

Closed Hihat

Open Hihat

Accent

Accent

Articulation

Tremolo

Bow Up

Fall

TremoloTremolo

Bow Down

Articulation

Glissando

Articulation

Articulation

Articulation

Fermat

Thumb Pos.

Damped

DoitFall

Fermat

Fermat Spoken Tone

Accent

Diamond Note Glissando

TremoloTremolo Bracket Beam

Accompanying 
Voice

Main Voice

Bracket Beam

Articulation

Staccato

StaccatoStaccato

Staccato

The “Note Symbols” Palette. These 
symbols are always tied to a note.

The “Lines and Trills Palette. Please note that 
the Arpeggios, Hand Indications and Strum 
symbols are all “note dependant”!

Staccato Staccato
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The “Dynamics” Palette.

The “Graphic” Palette. This contains note heads, accidentals and rests that can be “drawn in” 
without affecting the score in any way. They do not affect MIDI playback!

The “Other” Palette.

Crescendo/
Diminuendo

Slur Down

Tie Down

Dynamics

“Double” Crescendo/
Diminuendo

Slur Up

Tie Up

Lyrics

Chord

Pedal Down

Tempo as number

Triplet Feel

Regular Text

Fret Symbol

Pedal Up

Tempo as note value

Triplet Feel

RepeatRepeat

Scale Event Program Change
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The “Layout” Palette. All these symbols are drawn in their own “layer”.

The “Words” Palette. This is described on page 251.

The “Pictures” Palette. 

Further details about many of the Symbols can be found on page 218.

Page Text

Bar Line

Rehearsal Mark

Segno

Coda

Ending

System Text

Multiple Rest

Rehearsal Mark

Coda

Ending

Line

Brackets

Brackets

Box

Keyboard
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Creating a Custom Palette

On the Symbol Palette menu, you will find a Palette called Custom. Cubase VST al-
lows you to fill this Palette with any selection of Symbols from other Palettes. In this 
way, you can have instant access to the Symbols you use often:

1. Open the Custom Palette.
If it’s the first time you are using this, it will be empty.

2. Open another Palette from which you want to copy a Symbol.

3. Hold down [Option] and click on the Symbol you want to add to the Custom Palette.
The Symbol appears on the Custom Palette.

4. Repeat this with other Symbols.

• To remove a Symbol from the Custom Palette, hold down [Option] and click on it.

• You can assign key commands for the first ten symbols on the Custom Palette.
Pressing the assigned key combination will perform a “Multi Insert”; inserting the corre-
sponding symbol for the selected notes.

Important! – Symbols, Staves and Voices

Most Symbols belong to a Staff when inserted. Only Note Symbols, slurs and ties 
are an exception. They belong to notes and therefore to Voices. 

It is extremely important that the correct Staff is active when you insert a symbol (if 
you are editing multiple staves, of course).

If you for example insert a symbol with the wrong staff active it might later appear 
like the symbol has disappeared simply because you edit another configuration of 
Tracks (the Track you actually inserted the Symbol to might not have been opened 
for editing).

The same is true for Note Symbols and their relation to Voices. Make sure the cor-
rect voice is active when inserting symbols or they might wind up at the wrong po-
sition, fermats may be turned upside down etc.

Layout Symbols work slightly differently. Instead of belonging to a certain Staff or 
Voice, they belong to a Layout. Since different Track combinations use different 
Layouts, this means that if you insert a Layout Symbol in the score when you are ed-
iting two Tracks (for example a trumpet and a saxophone part), it will not be there 
when you view each Track by itself in Score Edit. However, you can copy Layouts 
between Track combinations. 
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Adding Symbols to the Score

Making Space and handling Margins

• If you find there isn’t enough space between staves to add symbols (like for example text) 
please see page 286 for info on how to separate the staves.

• If you find the score looks crammed after adding symbols, check out Automatic Layout on 
page 290.

❐ Symbols you add outside the margins will not be printed!

About the Pencil tool

Unlike the other MIDI Editors, there is no Pencil tool in the Score Edit Toolbox. In-
stead, the Pencil tool is “automatically” selected when you insert Symbols. There 
are various rules for how this is done:

• Normally, the Pencil tool is automatically selected when you click on a Symbol in a Pal-
ette.

• However, if the option “Double Click Symbol to get Pencil Tool” is activated in the Pref-
erences–Score–Editor Behaviour dialog, you need to double click the Symbol to get 
the Pencil tool.
This is useful if you want to insert Symbols using the Do pop-up menu or computer keyboard 
as described below (and therefore don’t want the Pencil tool to appear every time you select 
a Symbol).

• In the same Preferences dialog, you will find an option called “Display Arrow Tool after 
Inserting Symbol”. When this is activated, the Arrow tool is automatically selected af-
ter you have inserted a symbol.
If you want to insert a lot of symbols with the Pencil tool, you may want to deactivate this op-
tion. Remember that you can use a key command (by default [Command]-[Tab]) to toggle 
between the Arrow tool and the previous tool.
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Adding Note Symbols

Adding a Symbol to one Note

1. Make sure the Note Symbol Palette is visible.

2. Click (or double click) on the desired Symbol in the Palette.
As mentioned above, the “Double Click Symbol to get Pencil Tool” preference determines 
whether you need to double click. In any case, the Pencil tool is automatically selected.

3. Either click on the note or above or below it.
If you click on the note, the symbol is put in at a predefined distance from the note. If you in-
stead click “above or below” the note, you decide for a vertical position yourself. In either 
case, the symbol is aligned vertically with the note. It can later be moved up/down.

Clicking on a note inserts the Note Symbol (in this case a tenuto) at a predefined distance from 
the note head.

There are two options in the Scores–Additional Settings dialog that affect the verti-
cal positioning of note symbols:

• Accents above Stems.
When this is activated, accent note symbols are displayed at the stem side of notes instead of 
the note head.

• Accents above Staves.
When this is activated, accent note symbols are displayed above the staff, regardless of the 
stem direction of the notes. This setting overrides the “Accents above Stems” option.

Adding a Symbol to several Notes using the Pen

You might for example want to add a staccato symbol to all notes within a few 
measures. Proceed as follows:

1. Make sure the Note Symbol Palette is visible.

2. Select the notes to which you want to apply the Symbol.
You may also want to use the To pop-up menu, to restrict which notes should be affected.

3. Click (or double click) on the desired Symbol in the Palette.

4. Hold down [Option] and click on any note in the score.
The symbols are put in at a predefined distance from all of the notes that meet the criteria on 
the To pop-up menu. The symbols can be moved later.

Clicking with [Option] down inserts the symbol to a number of notes.
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Adding a Symbol to several Notes using the Do pop-up menu

1. Select the notes to which you want to apply the Symbol.
You may also want to use the To pop-up menu, to restrict which notes should be affected.

2. Select the desired Symbol from the Palette.

3. Pull down the Do pop-up menu and select “Multi Insert”.
The Symbol is added to the selected notes (taking the To pop-up menu into account), at a 
predefined distance from the note heads. The symbols can be moved later.

Adding a Symbol without tying it to a Note

Note dependant symbols can be entered freely too. This for example allows you to 
add a fermat to a rest symbol.

1. Click or double click the symbol so that the Pencil tool is selected, as described above.

2. Hold down [Command].

3. Click anywhere in the score.
Make sure that the symbol ends up in the correct Staff!

Editing a Note Symbol

If you hold down [Command] and click on a note symbol, a pop-up palette appears, 
allowing you to select another note symbol. Note that this affects all selected sym-
bols of the same type (taking the To pop-up menu into account). 

This makes it very easy to e.g. exchange all accent symbols for staccato symbols: 

1. Hold down [Shift] and double click on the first accent symbol.
All the following accent symbols are selected.

2. Press [Command] and click on one of the symbols.

3. Select the staccato symbol from the pop-up palette that appears.
All the accent symbols are replaced with staccato symbols.
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Adding other Symbols

1. Make sure the desired Symbol Palette is visible.

2. Click (or double click) on the desired Symbol in the Palette.
As mentioned above, the “Double Click Symbol to get Pencil Tool” preference determines 
whether you need to double click. In any case, the Pencil tool is automatically selected.

3. Click once or click and drag somewhere in the score.
The symbol appears. For many symbols with a length, you can drag while holding the mouse 
button down, to set the length of the symbol directly. The symbol appears with its handles 
selected (if it uses handles) so that you can change its size directly if you wish. This is all de-
scribed in detail on page 215.

Press the mouse button — drag — and release!

About Note Dependant Symbols

Note dependant Symbols like arpeggios and strum directions must be put in front 
of a note or they will be “invisible”.

Adding Text

There are special methods for working with text, described in “Working with Text”.

Adding Slurs and Ties

Slurs can be drawn manually or inserted automatically for a group of notes. Ties are 
normally added by the program but can also be drawn in as “graphic” symbols. 

Slurs, Ties and the Snap Value

Since a slur or tie “musically” always spans from one note (or chord) to another, the 
beginning and end of a slur/tie in Cubase is always related to two notes in the score.

When you draw in a tie or slur, the program uses the Snap value to find the closest 
two notes to “attach” the symbol to. In other words, if you want to add the slur/tie 
to a note at a sixteenth note position, make sure snap is set to 16 or smaller (this is 
only true for manual drawing of slurs and ties).

Please note that this does not mean that the symbol has to start or end exactly 
above/below two notes. You can position the end points as you like. Instead, what it 
means is that when you use the Layout Tool to move the note graphically to adjust 
the look of the bar, the slur/tie moves with it (see page 173). The same is true if you 
adjust the width of the measure, the slur/tie is adjusted accordingly.
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Drawing the Slur/Tie

1. Check the two notes that the slur/tie should span and set the Snap value accordingly. 
For example, if one of them is at a quarter note position and the other at an eighth note po-
sition, set Snap to 8 or smaller (16, 32 etc.).

2. Click or double click on the correct slur/tie in the Symbol Palette, so that the Pencil is 
selected.

3. Position the mouse close to the first note and drag to a position close to the second 
note.
The end points of the slur/tie will snap to their default positions - holding down [Command] 
allows you to move the end points freely.

There are two special functions for inserting a slur or tie that automatically spans 
from one note to another.

Adding a Slur/Tie between two Notes

1. Select two notes.

2. Click or double click the correct slur/tie symbol from the Palette, so that the Pencil tool 
is selected.

3. Hold down [Command] and click on one of the two notes.

Inserting a Slur/Tie over a Selection of Notes

1. Select a span of notes.

2. To insert a slur, pull down the Do pop-up menu and select “Insert Slur”.
A slur is created, starting at the first selected note and ending at the last.

3. To insert a tie, select the tie symbol, pull down the Do pop-up menu and select “Multi 
Insert”.
This method can of course also be used to add slurs, but if you use the “Insert Slur” function, 
you don’t need to have the Symbols Palette visible. You can even create a key command for 
the “Insert Slur” function, for instant access.
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Creating Trills

If you have recorded or entered a trill, Cubase VST can help you display this prop-
erly:

1. Select the notes that make up the trill.

2. Pull down the Do pop-up menu and select Build Trill.
A dialog appears.

3. Select the options you want.
The radio buttons determine how the trill should look. Activate the “Help Note” option if you 
want an extra note to indicate between which notes the player should trill.

4. Click OK.
Now the following happens:

• All notes except the first one (and possibly the second) are hidden.
• The first note automatically gets a Display Length matching the length of the whole trill.
• If you chose to include a help note, the second note is converted to a “Graphic” note, with 

brackets but without stem. Otherwise, the second note is hidden as well.
• The trill symbols you indicated in the dialog are inserted.

Inserting Symbols across Staves

• If you hold down [Option] while adding a symbol to one staff in a grand staff, this symbol will 
be put in at corresponding positions on all staves. This allows you to for example insert re-
hearsal marks, repeats, etc. for all instruments at the same time.

• By the same token, if you hold down [Option] when inserting braces/brackets, they are in-
serted to all grand staves.
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Adding a Keyboard Symbol

The Layout Palette contains a piano keyboard symbol, useful for example in educa-
tional scores. The symbol has the following properties:

• To insert the keyboard symbol, select it from the Palette, click with the Pencil tool at 
the desired position and drag a box to specify the approximate size of the keyboard.

• After you have inserted the keyboard symbol, you can drag its edges to resize it verti-
cally or horizontally.

• If you double click on an inserted keyboard symbol, a dialog appears, allowing you to 
specify further properties of the symbol.

Governs the width of 
the keys.

The leftmost note in the 
keyboard symbol

When this is activated, each C key is 
displayed with note name and 
octave (C1, C2, etc.).

Activate these if you want white or 
black keys to be transparent.



- 198 - 

Adding Guitar Chord Symbols

A fretboard symbol of a guitar chord can be inserted anywhere in the score. There 
are two ways to do this: by using the “Other” Symbol Palette or by using the Guitar 
Lib dialog.

Using the “Other” Symbol Palette

1. Make sure the “Other” Palette is visible.

2. Click or double click on the Guitar Chord symbol, so that the Pencil tool is selected.

3. Click in the score, at the position you want the symbol.
A symbol with an “empty” fretboard is inserted. Now you need to specify a chord:

4. Double click on the symbol with the Arrow tool.
The Guitar Symbol dialog appears.

• To put a black dot on any fret and string, click on it. 
To remove it, click again.

• To input a symbol just above the string, outside the fretboard, click there.
Consecutive clicks allow you to select between a ring (open string), a cross (don’t play this 
string) and no symbol.

• To add a Capodaster number, click to the left of the symbol.
Consecutive clicks allows you to step through the possibilities.
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• You can also add a Capodaster symbol (a line over the strings), by setting the “Capo 
Frets” parameter to a value higher than 0.
By adjusting the Capo End and Start values, you can create Capodaster symbols that span 
fewer strings.

• If you want a bigger symbol than the default one, activate the “Large” checkbox.

• If you want the symbol to be horizontal, activate the “Horizontal” checkbox.

• If you want to display more or fewer frets than the default six, change the “Frets” 
value.

• If you have defined chord symbols in the Guitar Library (see below), these are available 
for selection on the “Library” pop-up menu.

5. Click OK to close the dialog.
The guitar symbol appears in the score. 

• You can edit the symbol by double clicking it. 
The Edit Guitar Symbol dialog appears. This has the same parameters and settings as the di-
alog that appeared when you first created the symbol, with two additions:

• [Command]-clicking on a guitar symbol brings up a pop-up menu, listing all chords de-
fined in the Guitar Library (see below).
This allows you to quickly change chords for the symbols you have inserted.

Insert Notes Clicking this button inserts the notes of the chord into the score, at the correct 
position.

Apply Clicking the Apply button applies the changes you have made in the dialog to the 
selected guitar symbol. Note that the dialog is non-modal, that is, it can remain 
open while you select other guitar symbols and edit them. The dialog will change 
to reflect the currently selected guitar symbol.
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Using the Guitar Lib

This is fine if you only want to add a few chord symbols to your score. If you need a 
lot of chord symbols, or if you are using chord symbols in a lot of different scores, 
you can gather all your chord symbols in a “Guitar Library” instead. This way you 
don’t need to recreate the same chord symbol over and over again:

1. Pull down the Score menu and select “Edit Guitar Lib...” from the Global Settings menu.
The Guitar Lib dialog appears.

2. To add a guitar chord symbol to the library, click the New button.
A chord symbol appears in the list to the left.

3. To edit the chord symbol, double click it in the list.
This opens the Guitar Symbol dialog, as when editing a chord symbol in the score. 

• The symbol you create will also be “interpreted” and displayed as a written chord to 
the right of the fretboard symbol.
This can also be edited by double clicking if you like.

4. To add a chord symbol from the Guitar Lib window to the score, drag it into the score 
window and drop it at the position you want it.
Guitar chord symbols added this way behave like “regular” guitar chord symbols from the 
“Other” Palette. You can double click them to edit them in the Guitar Symbol dialog.
Aside from the guitar chord symbol, you will also get a “written” chord symbol when you 
drag and drop from the Guitar Lib window. This can be edited like any chord symbol.

❐ There is no connection between the guitar chord symbol and the written chord symbol, 
once you have dragged them into the score! Editing one of them will not affect the other.
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• To remove a symbol from the library, select it in the list and click Remove.

• To save the current library as a separate file, click the Save button.
A file dialog appears, allowing you to specify a name and location for the file.

• To load a guitar library file, click the Load button.
In the file dialog that appears, locate and open the desired Guitar Lib file. 

❐ Loading a Guitar Lib file replaces the current library!

There are also three additional checkboxes in the Guitar Lib dialog:

Checkbox: Description:

Use for Make Chords When this is activated, and you use the “Make Chords” function (see page 
229), the program will insert guitar symbols as well as regular chords (if any 
fitting guitar symbols can be found). If there are several guitar symbols for a 
certain chord in the Guitar Lib, the first one will be used.

Small Display If this is activated, the chord symbols in the list will be displayed in the 
size they will have in the score. If it is deactivated, the symbols will be dis-
played in a larger size, for easier editing.

Save with Song When this is activated, the Guitar Library is saved with the Song. Other-
wise, it is saved with the Cubase Preferences (and thus available to other 
Songs).
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Adding Pictures

With the “Pictures” Symbol Palette, it is possible to insert custom-made symbols or 
background pictures into your scores! 

Adding Pictures to the Palette

1. Set up the picture in an external drawing program, etc.
For best results when printing the scores, we recommend that you use “vector” pictures, 
rather than bitmaps.

• Note that pictures will be inserted in their actual size - if you need to scale the picture 
you have to do this in the drawing program.

2. Copy the picture onto the Macintosh Clipboard.

3. In Cubase VST, make sure the Pictures Symbol Palette is visible.

4. Click on an empty “slot” in the Pictures Palette.

5. Pull down the Edit menu and select Paste.
The picture is added to the Palette in the “slot” you selected.

• If you have pictures you will use in several scores, you might consider adding these to 
the Pictures Palette in the Autoload Song.

Inserting Pictures into the Score

1. Make sure the Pictures Palette is visible.

2. Click or double click on the desired Picture in the Palette, so that the Pencil tool is se-
lected.

3. Click in the score at the position you want the picture.
The picture appears. You can move, duplicate and delete the picture as with any symbol (see 
the following pages).
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Using Global Symbols

The symbols in the “Global” palette belong to the Layout layer. When you are edit-
ing a layout containing several Tracks, you can have inserted Global Symbols auto-
matically copied to any combination of Tracks in the layout. You decide which 
Tracks should display Global Symbols by ticking their “Glob” column in the Layout 
Settings dialog.

Here, Global Symbols will be displayed for the Tracks “Strings” and “String 3”.

• Any editing you perform to Global Symbols is automatically duplicated in the other Tracks.
• You can turn on and off the display of Global Symbols for different Tracks at any time.
• Global Symbols can be copied between layouts, by using the “Get Form Only” or “Get Lay-

out” functions in the Layout Settings dialog.

One example of how to use Global Symbols: 

Let’s say you are editing a full orchestra score, and want Rehearsal Marks inserted 
for more than one staff (typically, above each instrument group - brass, strings, per-
cussion, etc.). Now all you need to do is insert the Rehearsal Marks from the Global 
Symbols palette for one of the Tracks, open the Layout Settings dialog and tick the 
“Glob.” column for the desired Tracks. When you close the Layout Settings dialog, 
the inserted Rehearsal Marks are automatically duplicated to the specified Tracks.
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Selecting Symbols

Almost all symbols can be selected simply by clicking on them. For symbols that 
have a length or size, one or more handles appear.

A selected crescendo.

An exception to this are the slurs and ties which can be selected by clicking on the 
end points or by making up a selection rectangle.

• If you hold down [Shift] and double click on a symbol, all following symbols of the 
same kind are selected.
This can be very useful, as it allows you to select all symbols of a certain kind and move them, 
delete them or exchange them for another symbol type (by [Command]-clicking, as de-
scribed on page 219).
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Using the Lock Layers

Sometimes it can be very hard to click on a symbol or other object in the score, 
without accidentally selecting other symbols near by. To remedy this, you can as-
sign different types of objects to different “Lock Layers” (up to three) and instruct 
Cubase VST to “lock” one or two of these layers, making them “unmovable”. Pro-
ceed as follows:

Setting up the Lock Layers

1. Double click on the Lock Layer button on the Status bar.

The Lock Layer button.

The Lock Events dialog appears. You can also access this by selecting Preferences–
Scores–Lock Events on the Edit menu.

2. Assign each Event type to a layer (1, 2 or 3).
It is a good idea to assign Event types that might “conflict graphically” to different layers. For 
example, you might want to assign “Bar Numbers” and “Note Symbols” to different layers, if 
you find that you accidentally move bar numbers when editing note symbols and vice versa.

3. Click OK to close the dialog.
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Locking a Layer

To “lock” a layer, click on its number in the Lock Layer button, so that it goes “dark”.

In this figure, layer 2 is locked. Event types assigned to layer 2 cannot be selected, moved or 
deleted.
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Moving and Duplicating Symbols

There are four general ways to move and duplicate symbols: 

• By dragging them with the mouse (see below).
• By using the computer keyboard (moving only - see page 210).
• By using the Copy Events function (see page 211).
• By using the Paste Note Attribute function (duplicating note symbols only - see page 214).

Moving and Duplicating by using the Mouse

This is done much as with other objects in Cubase VST. The following rules apply:

• Note Symbols and Note Dependant symbols move with the notes/chords they belong to. In 
other words, if you move the note/chord, the symbols move with it/them.

• Note symbols (like for example accents and lyrics) can only be moved vertically. Some other 
symbols (like braces and brackets) can only be moved horizontally.

• All other symbols without handles can be moved freely. If you hold down [Shift], movement 
is restricted to one direction only.

• If the symbol has one or more handles when it is selected, don’t drag it by the handles, or you 
will change its shape instead of moving it.

• The slurs and ties are an exception, they can only be moved by first dragging one handle and 
then the other. However, if you use the Layout Tool (see page 173) to move the notes they 
belong to, or if you change the measure width, they will be adjusted automatically.

• Duplicating is done by moving with [Option] pressed, as always in Cubase. Slurs, ties, braces, 
brackets and bar lines can not be duplicated with this method.

There are three features to help you position symbols (and other score objects) cor-
rectly: the Rulers, the Non-note Position Display and the Position Window.
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The Rulers 

Unlike other editors, Score Edit does not have a meter/time position-based ruler. 
Instead, the ruler is “graphical”, that is, they indicate the actual x-y position of ob-
jects (with “zero” at the upper left corner).

• To hide the Rulers, pull down the Ruler pop-up menu at the bottom of the Score Edit 
window, and select “Off”.

• To display the ruler again, pull down the Ruler pop-up menu and select one of the units 
(inches, centimeters or points).
This setting will also affect the units used in the Position Window (see below).

The Non-note Position Display

There is a special position display in the Score Toolbar for non-note Events such as 
pauses, symbols, etc. This is useful for checking and adjusting the exact position of 
non-note objects, e.g to make sure symbols “belong to” the correct bars.

• For the Position Display to be active, you need to select a single non-note object.

• You switch the Position Display between meter and time position by clicking on the 
Mouse Box, in the same way as with the Info Line, Song Position Display, etc.

The Position Window

If you need to fine-tune the graphical positions of symbols and other objects, you 
should use the Position Window. This makes positioning easier in two ways:

• You get a numerical indication of the exact position of the mouse pointer (and any object 
you are dragging).

• You can move objects or staves by typing in position values.

The white lines indicate the 
current position of the 
mouse pointer.
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You display and hide the Position Window by clicking in the Ruler.

The window contains the following settings and values:

• The Staff position settings can be hidden by clicking the Position Window’s Zoom box.

Setting / Value: Description:

Measure in 
Inch/cm/mm/pt

Click this label to change units for the Position Window. This choice will also af-
fect the units used in the Rulers.

Abs/Rel. Pos Click this label to select whether X-Y position values should be “absolute” (re-
ferring to the upper left corner of the current page) or “relative” (referring to 
the upper left corner of the Active Staff).

X, Y When a single object is selected, these values show the horizontal and vertical 
position of this object.
When no objects or several objects are selected, these values show the current 
horizontal and vertical position of the pointer.

• If a single object is selected, you can click on these values and type in a 
new position for the object.

∆X, ∆Y When you are moving an object, these values indicate the horizontal and verti-
cal distance you have moved it.

• If one or several objects are selected, you can click and type in values - 
the objects will be moved the specify distances.

Sel. Staff If “Abs. Pos” is selected (see above), this value shows the distance from the top 
of the score page to the top of the Active Staff. 

• You can click and type in a value to move the Active Staff.

If “Rel. Pos” is selected, this value will always be 0, since vertical positions are re-
lated to the top of the Active Staff!

∆Prev Staff The distance between the Active Staff and the Staff above it.

• Clicking and typing in a value will move the Active Staff.

∆Next Staff The distance between the Active Staff and the Staff below it.

• Clicking and typing in a value will move the staves below the Active Staff.

Click somewhere in 
the ruler to display 
the Position 
Window.
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Dragging Symbols across Staves

If you drag a symbol across the staves, you will note how the “Active Staff” indicator 
to the left follows the mouse pointer. Use this as an indication, to make sure that 
symbols end up in the correct Staff.

• If you are editing several Tracks at the same time, and want to make sure that a symbol 
isn’t accidentally moved to another Track when you drag it vertically, click on the “L” 
button on the Score Toolbar.
When this is activated, you cannot move symbols across Tracks by dragging.

Moving by using the Computer Keyboard

You can move symbols (and even notes and rests) graphically, by using the com-
puter keyboard. This is the same as dragging them with the Layout tool, but this 
method offers higher precision. Proceed as follows:

1. Select the symbols you want to move.

2. Hold down [Option].

3. Use the arrow keys to move the symbols in steps of one point.
Depending on the symbol type, you may only be able to move symbols horizontally or verti-
cally.

❐ Don’t confuse this with holding [Command] and using the arrow keys, which moves 
notes and rests in steps of one snap value. 
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Moving and Duplicating with the Copy Events function

This function allows you to move or copy the contents of a whole bar to one or sev-
eral other bars. You can select which elements in the bar should be included in the 
operation. Proceed as follows:

1. Pull down the Score menu and select “Show Invisible” from the Global Settings sub-
menu.
The Show Invisible dialog appears.

2. Make sure the “Bar Handles” option is checked, and close the dialog.
Now, each bar in the score is shown with a handle in the upper left corner.

• You can also show/hide the bar handles by using the “Show Invisible” Filter Bar, as de-
scribed on page 55.

Bar Handles
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3. Double click on the handle of the bar from which you want to copy or move symbols.
The Copy Events dialog appears.

4. Make sure that only those symbol types are checked, that you want to move/copy.

5. If you have several subsequent bars to which you want to copy symbols, set the “Re-
peats” value to this number of bars.
If you only want to copy symbols from one bar to another, make sure “Repeats” is set to 1. 
This option is only available for copying, not for moving.

6. If you want this dialog to appear every time you perform the move/copy operation (see 
below), activate “Show Dialog”.

7. Click OK to close the dialog.

8. To copy the specified Event types to another bar, hold down [Option], click on the bar 
handle of the first bar and drag it to the “target” bar.
To move the Event types instead of copying them, drag the bar handle without holding 
down [Option].

• If you activated “Show Dialog” in step 6 above, the Copy Events dialog appears, allow-
ing you to confirm your settings.
Click OK to close the dialog and perform the operation.
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Now, the following happens:

• If you activated “Note Symbols” in step 4 above, the note symbols are copied from the 
“source” bar and pasted onto notes at the same positions in the “target” bar. If there is a note 
symbol for a certain note in the “source” bar, but no note at the corresponding position in 
the “target” bar, the symbol will simply be removed.

The actual position of notes are used as a basis for this operation - not the displayed position.

• If you activated other types of symbols in step 4 above, these will simply be moved to the 
same graphical position in the “target” bar.

• If you set “Repeats” to a number larger than 1 in step 5 above, the same symbols will be 
pasted into that number of bars (starting from the one you drag the bar handle to).

Copying note symbols with “Repeats” set to 3.

• If you didn’t hold down [Option] when dragging the bar handle, the symbols (and other 
Event types specified in the dialog) are removed from the “source” bar.

❐ If there already are symbols (or other objects) of the specified types in the “target” 
bars, these will be removed!

If you move the Note Symbols from the first bar to the second bar...

...only symbols that find corresponding note positions in the second bar 
will be moved. The other symbols will be removed.
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Duplicating Note Symbols with the Paste Note Attributes function

By using the “Paste Note Attributes” function on the Do pop-up menu, you can 
copy the properties of one note (including all note symbols) to any number of 
other notes. This is described on page 163.

About Moving Note Symbols

Note symbols, slurs and ties all have “Default Positions”. This determines the verti-
cal distance between the note head(s) and the symbol. 

• You can manually adjust the vertical positions of individual symbols, but if you move 
or transpose their notes, the symbols are automatically reset to their Default Positions. 
This also ensures that note symbols and slurs are positioned sensibly when you change the 
Display Transpose settings.

• To reset the vertical positions of all note symbols and slurs in a score, hold down [Com-
mand] and click on the Force Update (“UPD”) icon on the Score Toolbar.
All note symbols are reset to their default positions, and all slurs and ties are set to their orig-
inal lengths and shapes (see below).
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Changing Length and Shape

Generally you can change the shapes of any symbol that has a length. Proceed as 
follows:

Resizing

1. Select the Symbol.
The Handles appear.

Symbols with a length have two handles when selected.

2. Drag one of the handles.
You might be restricted to vertically or horizontally only, depending on the type of symbol.

❐ In the Preferences–Scores–Editor Behaviour dialog, there is a preference called “Keep 
Crescendi Horizontal”. When this is activated, crescendo and diminuendo symbols will 
never be slanted.

Altering the Shape and Direction of Slurs and Ties

There are two types of slurs and ties in the Symbol Palette. The up/down variation 
of each actually represent the same symbol but with different initial direction. You 
can perform the following editing to slurs and ties:

• By dragging the middle handle up/down you can change the shape of the curve. 

Dragging the middle handle of a slur changes its shape.

• By selecting a slur or a tie and clicking the “Flip” symbol on the Score Toolbar, you can 
change the direction and positioning of the slur or tie.
Actually, there are three “modes” for a slur or tie. You step through these three modes by 
clicking the button:

• By holding down [Command] and dragging the end points of a slur or tie, you can 
change its shape without affecting its “relation” to the notes it belongs to. 
In other words, the end point of the slur/tie will then keep its relative distance to that note 
when the note is moved with the Layout Tool or when the measure width is adjusted.

❐ You can restore all shape changes to the default, by [Command]-clicking the Force Up-
date icon on the Score Toolbar. See page 214.
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• To change the default shape and spacing of slurs and ties, open the Preferences–
Scores–Spacing dialog and edit the settings “Slur’s Start & End Distance from Note 
Head” and “Slur’s Middle Distance from Note Head”.
These settings will be used for all new slurs and ties you create, as well as for all existing slurs 
for which you haven’t manually changed the shape.

Multi Editing of Brackets and Braces

If you hold down [Option] while editing brackets/braces (shortening, lengthening, 
or moving), the change is applied to all brackets/braces that span the same set of 
staves.

Double clicking Symbols

A number of symbols can be double clicked upon. In these cases, a dialog or menu 
appears where you can input information that either affects the look of the symbol 
or the MIDI Data it creates. This is described for each type of symbol, in the “Symbol 
Details” section on page 218.

Deleting Symbols

This is also done as with all other objects in Cubase, either with the Eraser Tool or by 
selecting and pressing [Delete] or [Backspace].

Copy and Paste

All symbols except those in the Layout part of the Symbols palette can be copied 
and pasted just as any other object in Cubase. The following rule applies:

• Symbols that were tied to notes (like for example accents) will become “free-floating” 
objects when pasted. 
That is, they are not tied to any note any more. If this is not what you want, consider using 
the “Copy Events” function instead, as described on page 211.
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Alignment

Symbols can be aligned as in drawing programs. Proceed as follows:

1. Select all objects you want to align.

2. Select Align Elements from the Format menu on the Score menu.

3. Select the desired option from the pop-up that appears.
The object(s) will now be moved.

❐ Note symbols, like staccato and accents can only be aligned horizontally.

The “Dynamics” option is a special function for aligning dynamic symbols, as de-
scribed on page 222.

Select This: When You Want This:

Left Sides

Right Sides

Top Edges

Bottom Edges

Horizontal Centers

Vertical Centers
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Symbol Details

This section contains additional information about some of the Symbol Palette 
options.

The “Clef” Palette

Clefs

You can insert a clef symbol anywhere in the score. This will have an effect on the 
notes, just as the first clef on the staff has. And just as with the first clef, the type is 
selected from a dialog that appears as soon as you click. More details on page 116 
and page 56.

When you double click on an existing clef the same dialog appears allowing you to 
change the type.

Time Signatures

You can insert a Time Signature symbol at the beginning of any bar. Inserting a new 
Time Signature will insert a change into the Master Track, as described on page 116.

When you click with the pen, a dialog box appears allowing you to specify the Time 
Signature. When you double click on an existing Time Signature symbol the same 
dialog appears allowing you to change the type. This dialog is described in detail 
on page 56.

• You can select a font and size for Time Signatures in the Preferences–Scores–Global 
Text dialog.
The default font for this is the included “Score Font 4.0” font.

Key Signatures

Inserting a Key Signature change is functionally similar to inserting a new Clef (see 
above). Details about Key Signatures in general is found on page 60.
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The “Dynamics” Palette

Dynamics

There are dynamic symbols ranging from ffff to pppp, plus “special” dynamic sym-
bols such as sforzando, fortepiano, etc. 

• By defining a key command for Next and Previous Dynamic (“Next/Prev Dynamic/Text 
Size/String” in the Preferences–Key Commands–Scores dialog) you can quickly edit dy-
namic symbols in the score.
You can use this feature to step between ppp, pp, p, mp, mf, f, ff and fff:

• You can also hold down [Command] and click on a dynamic symbol.
A pop-up menu appears, allowing you to select another dynamic symbol. Note that this af-
fects all selected dynamic symbols (taking the To pop-up menu into account). 
This makes it very easy to e.g. exchange all “mp” symbols for “mf” symbols: hold down [Shift] 
and double click on the first “mp” symbol (to select all the following “mp” symbols), [Com-
mand]-click on one of the symbols and select the “mf” symbol instead!

• The common dynamic symbols (fff to ppp) can be double clicked and then be used to 
alter the MIDI data. 
This is described on page 321.

• In the Lines and Trills Palette you will find a line symbol which allows you to create the 
following type of change in dynamics:

• The program can also automatically “connect” dynamic symbols by inserting the ap-
propriate crescendo/diminuendo sign between them.
This is described on page 221.

Select the dynamic symbol you want to edit.

Press the Previous Dynamic key to change 
to the next softer Dynamic symbol...

...or press the Next Dynamic key to change to 
the next louder Dynamic symbol.
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Crescendo and Diminuendo (Decrescendo)

In the Dynamics palette, there are two kinds of crescendo symbols: regular cre-
scendo and a “double” crescendo (diminuendo - crescendo). Furthermore, the di-
rection in which you draw the symbol determines the result, in the following way:

• To insert a crescendo ( < ) symbol, select the crescendo symbol from the Palette and drag 
from left to right.

• To insert a diminuendo ( > ) symbol, select the crescendo symbol from the Palette and drag 
from right to left.

• To insert a crescendo-diminuendo ( <> ) symbol, select the double crescendo symbol from 
the Palette and drag from left to right.

• To insert a diminuendo-crescendo ( >< ) symbol, select the double crescendo symbol from 
the Palette and drag from right to left.

• When you have inserted a crescendo/diminuendo symbol, you can move it and resize it 
by dragging its handles.

• If the option “Keep Crescendi Symbols ‘Horizontal’” is activated in the Preferences–
Scores–Editor Behaviour dialog, crescendo/diminuendo symbols will never be slanted 
when you draw them, but stay horizontal.
Also, this option prevents you from accidentally dragging an endpoint up or down when 
moving the symbol.
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• If you double click on a crescendo or diminuendo, a dialog box opens where you can 
make the symbol have an effect on MIDI.
See page 320.

• It’s also possible to “flip” crescendo symbols, by using the Flip command on the Do 
pop-up menu or the Flip button on the Score Toolbar:

You can do the same thing by [Command]-clicking on the symbol and selecting “Flip” from the 
pop-up menu that appears.

Connecting Dynamic Symbols

Instead of manually inserting crescendo and diminuendo symbols, you can have 
this done “automatically” by Cubase VST:

1. Select the two dynamic symbols between which you want a crescendo/diminuendo 
symbol.

2. Select “Connect Dynamics” from the Do pop-up menu.

A crescendo/diminuendo symbol is inserted between the symbols, and all three symbols are 
automatically aligned horizontally.

Selecting a crescendo symbol and using 
the Flip command...

...turns it into a diminuendo symbol.
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Aligning Dynamics

There is a special command for aligning dynamic symbols (including crescendos) 
horizontally. Unlike the regular Align function (see page 217), Align Dynamics takes 
the “baseline” of the dynamic letters into account, aligning them as text rather than 
as graphic symbols. Furthermore, the Align Dynamics feature doesn’t require that 
you select the dynamic symbols by hand:

1. Use the Select All command to select all objects in the Score.
This selects all dynamic symbols, along with other symbols, notes, etc. 
If you only want to align some of the dynamic symbols, select these manually instead of us-
ing Select All.

2. Pull down the Score menu, and display the Format hierarchical submenu.

3. Select the Dynamics option from the Align submenu.
The dynamic symbols are correctly aligned, leaving all other symbols and elements untouched.

The “Graphic” Palette

There are a number of note head, rest and accidental symbols in the “Graphic” Sym-
bol Palette. These work only as drawing elements, they do not insert any note data 
into the Track.

The “Line and Trills” Palette

Octave Symbols

The octave symbols (8va and 15va) act as a “local Display Transpose” (see page 62), 
they shift the display of the score one/two octaves down.

• By dragging the end of the dotted line, you can specify exactly which notes should be 
affected by the octave symbol.
Only notes beneath the dotted line are display transposed.

Tuplet Group Symbols

These are “graphical” tuplet group symbols, as opposed to the “real” tuplets.

• After inserting a tuplet group symbol, you can double click on its number and enter 
any number from 2 to 32.

• You can specify globally how tuplets should be displayed in the Preferences–Scores–
Additional Settings dialog.
You can also select a font and size for the tuplet numbers in the Preferences–Scores–Global 
Text dialog. 

Vertical Symbols

The Vertical symbols in the Lines & Trills Palette are “note dependant”, This means 
that they must be inserted in front of a note. For more information see page 183 
and the text about Grace notes (which behave similarly) on page 176.
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The “Other” Palette

Lyrics and Text symbols are described in “Working with Text”. Chord Symbols are 
described on page 227.

Pedal Down and Up Symbols

When you insert a Pedal Down or Up symbol, you will also insert an actual MIDI 
Event (Damper Pedal, Control Change 64) at that position. Similarly, inserting or re-
cording a Damper Pedal Event in another Editor will display a Pedal Down/Up sym-
bol in the score.

• If the option “Hide Pedal Markers” is activated in the Preferences–Scores–Additional 
Settings dialog, all Pedal Markers are hidden.
Use this if you have recorded a lot of Damper Pedal messages, but don’t want these to show 
in the score (for example if you are writing for another instrument than piano).

Tempo

This always shows the current tempo according to the Master Track. In other words, 
to make this symbol display a certain tempo, insert the value into the Master Track.

Normally this symbol shows the number of beats (quarter notes) per minute but if 
you double click on it and keep the mouse button pressed, a menu appears that al-
lows you to select any note value. The number then changes accordingly.

❐ This symbol is also available as Global Symbol (see page 203).

Tempo Change as Note Symbol

This symbol allows you to specify a tempo change as a change from one note value 
to another. The example above would mean “lower the tempo by a third.

To change the note value for either symbol, double click on it and keep the mouse 
button pressed. A pop-up with the available note values appears.

❐ This symbol is also available as Global Symbol (see page 203).

Repeats

Repeat signs (one and two bars) have a special feature: if you hold down 
[Shift]+[Command] when entering them, notes in the bars they relate to are auto-
matically hidden (for more info on Hiding symbols, see page 274).
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Scale Events

These are used together with StyleTrax.

Program Change Symbols

When you insert a Program Change symbol, you will also insert an actual MIDI Pro-
gram Change Event at that position. Similarly, inserting or recording a Program 
Change Event in another Editor or the Arrange window will display a Program 
Change symbol in the score.

• If the option “Use Inspector GM Names” is activated in the Preferences–General–Ar-
rangement dialog, the Program Change symbols will be displayed as General MIDI in-
strument names.

• To change the Program number of a symbol, double click on it.
If you have specified a Patchname Source for the Track’s Instrument (see the Getting into the 
Details document), a pop-up menu will appear, allowing you to select a patch.

If the “Use Inspector GM Names” option is activated, you can instead double click, keeping 
the mouse button pressed, and select an instrument from the pop-up menu that appears.

• If the option “Hide Program Changes” is activated in the Preferences–Scores–Addi-
tional Settings dialog, all Program Change symbols are hidden.
Use this if you have a lot of Program Change Events, but don’t want these to show in the 
score.

The “Layout” Palette

Bar Lines

There are two things you can do with bar lines:

• Edit or replace the ones you have with one of another type. This is done by double clicking on 
a bar line, and selecting another in the dialog that appears.

• Insert additional “graphical” bar lines “inside” existing bars. This will split the bar into two, 
which still together have the length of a “normal bar”. This can for example be used to create 
upbeats, see page 279.

• Double bar lines can be added automatically, at the start position of each Marker Part 
in the Arrangement.
This is done using the “Marker Track to Form” function.
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Rehearsal Marks

These come in two flavors, as numbers and as letters.

When you place the first of these in the score, it will be labelled 1 or A (depending 
which you chose in the palette), the second will then automatically be labelled 2 or 
B, the next 3 or C etc. If you delete one, the labelling of the others will be shifted so 
that they always make up a complete series of numbers/letters.

• You can select a font and size for Rehearsal Marks in the Preferences–Scores–Global 
Text dialog.
This dialog also allows you to add a box or an oval around the Rehearsal Mark.

• Rehearsal Marks can be added automatically, at the start position of each Marker Part 
in the Arrangement.
This is done using the “Marker Track to Form” function.

❐ Rehearsal Marks also available as Global Symbols (see page 203).

Endings

There are two types of endings, closed (“1”) and open (“2”). Both can be stretched 
to any length or height by dragging the handles. You can also double click on the 
existing number and enter any text you like.

Boxes and Lines

These are “generic” boxes and lines, which may be useful for different purposes. If 
you double click on a box, a dialog opens in which you can specify whether the box 
should be transparent or not, and whether the border should be visible.

The Keyboard Symbol

This is described on page 197.
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10
Working with Chords
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In this Chapter you will learn:

• How to use the Make Chords function.
• How to create a lead sheet.
• How to use Chord Tracks to get enharmonic shifting right.
• What Scale Events are.

Chord Symbols

Inserting Chord Symbols manually

How to use the Pen and the Symbols Palette to enter symbols is described in general 
in “Working with Chords”, see page 191.

When you insert a chord symbol, a dialog box opens up where you can fill in the 
type of chord.

The Chord Symbol dialog.

1. Enter the root note in the “Root” field.
You can either type in a chord letter or select a note from the pop-up menu to the right.

2. Specify a chord type in the “Type” field.
You can either type it in (for example, by typing a “7”) or select an option from the pop-up 
menu to the right. 
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Note that there are several display options for some chord types:

3. If you wish, specify a tension in the “Tension” field.
Again, this can be done by typing or by using the pop-up menu. However, there are some 
special display options which you can only get by typing (see the table below). You might 
also want to add some text here (such as “no third”, etc.). If you wish, you can select the basic 
tensions from the pop-up menu, and then add special options by typing.

4. If you want to have a special bass note (like for example to have a C major with a D 
bass note) set the “Bass” pop-up menu to anything but the Root Note.
The program will “remember” the relation between root and bass note, so that if you change 
the root note, the bass note will follow.

Character: Description: Example: Result:

( ) The tensions will be 
enclosed in brackets.

/ The tensions will be 
separated by a slash sign.

| The tensions will be placed 
above one another.

You can also combine several options. This is 
a combination of two options, along with a 
space to put the “9” above the “5”. Note that 
only one “(“-sign is needed when the “|” op-
tion is used.

Major 7th

Minor

Dim

Other types

Half Dim
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5. If you want the Root note to be displayed in lower case, activate the “Lower Root” 
checkbox.

6. If needed, click on the button labelled “Enharm. Shift”, to turn this on or off.

7. Click OK to close the dialog.
The Chord Symbol appears in the score.

❐ You can make further settings to determine how the chords should be displayed - see 
page 231.

• If you want to edit a chord, double click on the symbol.
A dialog appears, similar to the dialog you got when inserting the chord. The difference is 
that this dialog is non-modal, that is, it can remain open while you continue to work in the 
score. Typically, you would double click on a chord, adjust its properties and click Apply. 
Then if you like, select another chord in the score. The dialog is continuously updated to re-
flect the currently selected chord, allowing you to edit several chord symbols without having 
to close the dialog in between. Finally, to close the dialog, click its close box.

About the Library function

The Library pop-up menu in the Chord dialog allows you to add commonly used 
chord types and tensions to a list of “presets”, for quick access:

1. Set up the desired chord in the dialog.

2. Pull down the Library pop-up menu and select “Add”.

3. If you pull down the pop-up menu again, you will see that the specified chord type has 
been added to the list.

• Selecting an item from the Library pop-up menu applies the stored chord type and ten-
sion.
The root and bass notes are not affected.

• You can also access this pop-up menu from the score, by pressing [Command] and 
clicking on a chord symbol.
This allows for very quick editing of chord types, without having to access the Edit Chord di-
alog.

• The Chord Library is stored in the Cubase Preferences.

Using Make Chords

If you have already recorded the chords for a song, Cubase can analyze them and 
create Chord Symbols:

1. Open the recording in the Score Editor.
If you want the chords to be inserted on another Track, you can create an empty Part on that 
Track and open it along with the recording.

2. If you like, make settings for how the chords should be displayed in the Preferences–
Scores dialog.
You can change all these settings after you inserted the chords as well.
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3. Use the To pop-up menu to decide which part of the score to create chords for.
This allows you to create chord symbols for all chords inside the loop, for all selected notes 
etc.

4. Activate the Staff where you want the chords by clicking in it.

5. Select “Make Chords” from the pop-up Do menu.
The chords appear. They can be moved, duplicated and deleted as any other symbol. You 
can also double click on a chord symbol to edit it in the Chord Symbol dialog (in the same 
way as when creating Chords manually - see above).

A staff after using Make Chords.

• Instead of using the “Make Chords” item in the Do pop-up menu, you can click on the 
Make Chord icon on the Score Toolbar.

• If the option “Use for Make Chords” is activated in the Edit Guitar Lib dialog (see page 
198), guitar chord symbols will be added as well (if the Guitar Lib contains any guitar 
symbols that match the chords).

About the analysis

• The MIDI Chords are expected to be played in their most basic inversion. If not, an extra bass 
note is added. For example, the notes CEG are interpreted as C major, but GCE is interpreted 
as C Major with a G bass note. If you don’t want any interpretation of the inversion (no spe-
cial bass notes) hold down [Command] while selecting Make Chords.

• All notes on all staves are taken into consideration. Whenever there is any change on any 
staff, the notes are reinterpreted and a new Chord Symbol added. This means you should 
probably avoid having the melody Track in the Score Editor when you use Make Chords, or 
you will get a lot more Chords than you expect, possibly with strange tensions.

• In addition to the above, the Quantize value is used. At the most, there will be a new chord at 
each Quantize position.

• There must be at least three notes at a certain position for the program to interpret it as a 
chord. Also some combinations of notes simply don’t make any sense to the program and 
won’t produce any chords.

• The analysis method isn’t infallible. It can’t be because the same set of notes can be inter-
preted differently depending on context. Some editing may be needed. If you record the 
track solely to create chords automatically, play the chord as simple as possible, in the cor-
rect inversion, without added octaves, etc.

The Make Chords icon
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Global Chord Settings

In the Preferences–Scores dialog, there are several global settings that affect how 
chords are displayed. These settings affect all chords in the Song.

Selecting a Font and Size for the Chords

1. Open the Preferences–Scores–Chord Font dialog.

2. Use the Font pop-up to select a font for the chords.
Cubase comes with a special font for this (ChordFont 4.0), but you can use any font you like.

3. Use the four Size value fields to select sizes for the four different chord “elements”.
You can type in values or use the pop-up menus. Normally, you would want the “Root” size 
to be the largest and the “Tension” size the smallest.

4. Use the radio buttons to the left to select a chord display mode.
This affects how the Root and Bass notes are displayed:

5. Click OK to close the dialog.
If you want to try out your settings without closing the dialog, you can click the “Apply” but-
ton at the upper right corner.

English Regular notation.

DoReMi “Do-Re-Mi-...” are used instead of “C-D-E-...”

German As English notation, but “B” is displayed as “H”, and “Bb” or “A#” are displayed as “B”.
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Making Additional Chord Settings

1. Open the Preferences–Scores–Chord Types dialog.

2. Use the four sections of radio buttons to specify how the four most common chord 
types should be displayed.

3. If you want the Root note to be aligned with the Bass note, so that they both are dis-
played at the same vertical position, activate “Align Root Note”.

4. If you want the tensions to be displayed at the same vertical position as the Root note 
(rather than a bit above the Root note), activate the “Tension Bottom” checkbox.

5. Activate the “Scale Chords” option if you want to scale a staff (using the Size setting in 
the Staff Options dialog), and want the chords to be scaled accordingly.

6. To apply the settings to the currently displayed score, click “Apply to Chords”.

7. To close the dialog and save the settings as “default” settings for the next time you use 
the Make Chords function, click OK.
This does not apply the settings to the currently edited score (with the exception of the settings 
of the three checkboxes, which affect all chords in the Song).
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Creating a Lead Sheet

Below follows a quick description of how to create a Lead sheet. Use it as an inspi-
ration source!

1. Make up one Track into which you record the chords for the song.
There should be one chord at each place you want a chord in the song.

2. Quantize the Part as “heavily” as you can.

3. Create an empty Part with the same length, on another Track.

4. Open both Parts together in Score Edit.

5. Make the empty Part the active Staff and use Make chords.

The empty Part with chord symbols only.

6. Close Score Edit.

7. Create another Track and record the melody on this.

8. Format this Track in Score Edit, add lyrics etc.

The melody Track.

9. Close the Score Editor again.

10.Merge the chord and melody Tracks by holding down [Command] and [Option] and 
dragging the Part(s) on one Track onto the other Track.
Make sure not to offset the parts time-wise.

11.Open the merged Track again and perform any necessary Layout adjustments.

The final lead sheet.
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Chord Tracks and Accidentals

There’s a special Track Class in the Arrange window called Chord Tracks. These are 
used with StyleTrax, but also come to good use with accidentals in Score Edit.

Often when creating a score, you spend a lot of time manually adjusting enhar-
monic shifting. By Chord Tracks, enharmonic shifting will be automatic, saving you 
hours of work!

Creating a Chord Track

1. Create a Chord Track.
This is done by creating a Track and switching it’s Class to “Chord Track”, using the Track 
Class pop-up in the Track List.

2. Open this new Track and the MIDI Tracks that contains the chords, in the Score Editor.

3. Click in the Chord Track to make it the destination for the Chord Symbols.

4. Proceed with “Make Chords” as described on page 229.
The chord symbols appear on the Chord Track.

5. If needed, edit the automatically created Chords.

❐ Chord Tracks do not handle enharmonic shifting in chords as well as regular MIDI 
Tracks do. Sometimes for example a bass note maybe be indicated with the wrong en-
harmonic shifting.

Applying the Chord Track to the Score

As described above, the whole purpose of creating the Chord Track with the Scale 
events is to make the program automatically apply enharmonic shift according to 
the current chord/scale at every position in the song.

1. Make sure the Chord Track is the only un-muted Chord Track in the 
Arrangement.

2. Open the Preferences–Scores–Accidentals dialog.

3. Activate the “Use Chord Track For Accidentals” option.

The Use Chord Track for Accidentals option in “Global Settings: Accidentals”.

4. Select an accidental display option.
The options are described in detail on page 156.



- 235 - 

Now, the notes in the score will have correct accidentals. There might be situation 
where you will need to apply “manual override” as described on page 157, but such 
situations should be very rare!

“Use Chord Track For Accidentals” turned off.

“Use Chord Track For Accidentals” turned on.

❐ You don’t have to have the Chord Track visible in the Score for this function to apply!
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11
Working with Text
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In this Chapter you will learn:

• About the different types of text.
• How to enter and edit text.
• How to set Font, Size and Style.
• How to enter lyrics.
• How to change fixed text elements.

Adding and Editing Text Symbols

This section describes the general procedure for adding and editing Text Symbols 
(as opposed to fixed text elements such as title, Staff Names etc. - see page 254). As 
described on page 246, there are several different types of text symbols, but the ba-
sic procedures are the same:

Inserting a Text Symbol

1. If you wish, select a font, size and style for the text (or select a Text Attribute) as de-
scribed on page 240.
The text you insert will use the text settings made when no text is selected, but you can 
change all settings after you inserted the text.

2. Make sure the desired Symbol Palette is visible.
The different Text Symbols are found on the “Other”, “Layout” and “Global Symbols” Palettes.

3. Click or double click on the Text Symbol in the Palette, so that the Pencil tool is selected.

4. Make sure the correct Staff is selected, and click in the score at the position you want 
the text.
If you are inputting Lyrics, you should click above or below a note (lyrics are centered around 
each note and positioned vertically to where you clicked). See page 246.

5. Enter the text in the text box that appears.
You can use [Backspace] to delete letters, and move the cursor with the arrow keys. 

6. If you want to enter several lines of text, press -[Return] to insert a line break (this is not 
possible for lyrics).
The text lines can be left, right or center aligned, depending on the Text Style setting (see 
page 241).

7. If you wish, you can insert special score symbols in the text.
This is described on page 239.

8. When you are done, click outside the text box to close it.
The text appears. You can move, duplicate or delete it as with any symbol.
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• It is also possible to drag text from another application and drop it in the score.
The text will appear as a Text symbol with the Style, Font and Size settings currently selected 
on the Score menu. Note that you have to drag the text from an application that supports 
dragging of text blocks, such as SimpleText or Microsoft Word.

About the Melisma Lines

When you add a text symbol, you will find a handle at the right edge of the text 
block. By dragging this handle to the right, you can extend a “melisma line” from 
the text. This has several uses:

• If you are adding lyrics and want to indicate that a syllable should be sung over several notes:

• If the text is an advice about articulation or playing style, and you want it to apply to a certain 
musical phrase only:

• If the text is an advice about articulation or playing style, and you want it to apply from that 
point on in the score:

On the Text Style submenu you will find a number of options to determine the ap-
pearance of the melisma lines:

Option: Description:

Solid Line When this is activated, the line will be solid. Otherwise, it will be dotted.

End Line Down When this is activated, the line will be turned down, forming a “bracket”.

End Line Up When this is activated, the line will be turned up, forming a “bracket”.

End Line Arrow When this is activated, the line will end with an arrow.
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About “Special” Characters

If you want to use special score symbols in your text, this is possible using the fol-
lowing method:

1. When you are entering the text, position the text cursor where you want the score sym-
bol to be.

2. Hold down [Option] and press [f].
A ƒ sign appears in the text box. This indicates to the program, that the next character should 
be displayed with the “Score Font 4.0” font.

3. Enter a character.
The characters associated with some of the most common score symbols are listed in the ta-
ble below.

4. Continue entering text as usual.
It is only the first character after the ƒ sign that will be interpreted as a “special” character.

Some common Score Symbols and their Characters:

Making Space

• If you find there isn’t enough space between staves to add for example lyrics please see page 
286 for info on how to separate the staves.

• If you find the score looks crammed after adding text, check out Automatic Layout on page 
290.

Editing the Text

If you made a mistake when typing or for some other reason wish to change text, 
double click on a text block with the arrow tool, edit the text and click outside the 
text box to close it.

• It is also possible to replace all occurrences of a certain word in the score, without hav-
ing to edit the texts manually - see page 253.

O

P

Q

R

S

T

U

V

W

F

G

W

\
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Selecting Font, Size and Style for the Text

1. Select the Text Symbol(s) you want to make settings for.
If nothing is selected, the settings you make will be the “default settings”. The next time you 
insert text, these settings will be used.

2. Pull down the Score menu and select a font from the “Text Font” submenu.
How many and which fonts appear depends on what typefaces you have installed on your 
computer. 

❐ For regular text you should probably avoid the items “Score Font 4.0” and “ChordFont 
4.0”. These are the fonts Cubase uses for all scoring symbols. If you don’t know exactly 
what you’re doing, using these fonts will probably just produce garbage.

3. Select a text size from the “Text Size” submenu.
If you need a text size not available on the submenu, select the “Other...” option, and enter a 
custom size in the dialog that appears.
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4. If you wish, add one or several text style options from the “Text Style” submenu.

Most of the options are common text style variations such as bold, italic, underline, etc. But 
there are also a few special style options:

5. Click Apply to apply the settings to the selected text.
Note that you can select other text blocks while the dialog remains open - the dialog will be 
updated to reflect the settings of the currently selected text.

6. When you are done, close the dialog by clicking its Close box.

Option: Description:

Line options These determine the appearance of the “melisma line”, as described on 
page 238.

Box When this is activated, the text will be displayed in a box.

Oval When this is activated, the text will be displayed in an oval.

Right Edge Position When this is activated, the right side of a text block (rather than the left 
side) is used for calculating its position. This has an effect in situations 
where that text block is moved automatically (as a result of an Auto Layout 
function, when you move bar lines manually, etc.). If, for example, the text 
block appears just in front of a note (to the left of it), it will appear in a 
more sensible position after the adjustment, if this option is activated.

Align
Middle/Right

When any of these are selected, text will be aligned to the right or cen-
tered. If none of these are selected, the text will be left-aligned.
These options are only valid for texts with more than one line (when you 
have used [Return] to insert line breaks).
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• If you just need to change the text size for a block of text, you can simply select it and 
use the key commands for Next/Prev Dynamic/Text Size/String.
By default, these are [+] (larger) and [–] (smaller) on the typewriter part of the computer key-
board, but you can assign other key commands for this in the Preferences-Key Commands-
Score dialog if you like.

• You can also access the Font, Size and Style menus by holding down [Command], 
pointing on a text block and pressing the mouse button.
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Using Text Attribute Sets

A Text Attribute Set can be seen as a “preset” containing all font, size and style set-
tings. By creating Text Attribute Sets for the settings you use most often, you can 
save a lot of time.

Creating a Text Attribute Set

1. Pull down the Score menu and select “Edit...” from the Text Attribute Set submenu.
The Text Attribute Set dialog appears. You can also access this from the Preferences–Scores 
dialog.

2. If you want the Set to be saved with the current Song, activate “Save with Song”.
Otherwise, the Set will be saved in the Cubase Preferences, and thus be available for other 
Songs as well.

3. Click the Add button.
A name box opens.

4. Enter a name for the new Text Attribute Set.

5. Select a font, specify a size and add style options with the checkboxes.
The options are the same as when you make text settings on the Score menu (see above). 
The display in the dialog will help you by displaying a sample text with your current settings.
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6. When you are done, click OK to close the dialog.
The Set you created will now be listed on the Text Attribute Set submenu on the Score menu.

Using a Text Attribute Set

To apply the settings in the Text Attribute Set to one or several text blocks, select 
them and select the Set from the Text Attribute Set submenu on the Score menu. 
You can also access this submenu by holding down [Command], pointing on a text 
block and pressing the mouse button.

• If you select a Text Attribute Set when no text is selected in the score, the settings will 
be used the next time you insert some text.

Note that there will now be a “link” between the text and the Attribute Set. Any 
changes to the Attribute Set (see below) will affect all texts that use it. You can still 
edit any text settings manually (on the Score menu) but then the “link” to the At-
tribute Set will be removed.

Editing Text Attribute Sets

If you edit the settings in a Text Attribute Set, all texts using that Set will be af-
fected. This is very practical, since it allows you to use the same number of “generic” 
Sets for all your Songs (for titles, comments, lyrics, etc.), and simply change the 
fonts, sizes, etc. for a different Song if necessary. This will also make it easier to 
move Songs between computers (which may not have the same fonts installed).

1. Open the Text Attribute Set dialog.

2. If you want the changes to apply to the current Song only, activate “Save with Song”.
Otherwise, the edited Set will be saved in the Cubase Preferences, and thus be available for 
other Songs as well.

3. Select the Set you want to edit from the “Attribute Set” pop-up menu.

4. Change the settings as desired.

5. Click OK to close the dialog.
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Deleting Text Attribute Sets

❐ You should only remove text sets with “Save with Song” activated. Otherwise all Songs 
that uses the removed Text Attribute Set will display text in a wrong font/size/style.

1. Open the Text Attribute Set dialog.

2. Select the Set you want to delete from the “Attribute Set” pop-up menu.

3. Click the Remove button.

4. Click OK to close the dialog.
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Different Types of Text

Regular Text

The Regular Text option selected.

This type of text is inserted by selecting “Text” in the “Other” Symbols Palette. 

The text is tied to the bar and staff position. If you move the bar or the entire staff, it 
moves with it.

Inserting the same Text to all Staves

If you hold down [Option] when clicking with the Pencil, the text you type in will be 
added to all staves you are currently editing.

Lyrics

The Lyrics option selected.

This type of text is inserted by selecting “Lyrics” in the “Other” Symbols Palette.

When you insert Lyrics, you should click below or above the note the syllable belongs 
to. The text will then appear horizontally centered around the note and vertically po-
sitioned to where you clicked. You can later move it up or down, as with any symbol.

This text is tied to note position. If you move the note, the text moves with it. The 
spacing between notes is also adjusted to make the lyrics fit.

Inserting Lyrics for a number of Notes

1. With Lyrics selected, click below or above the note with the pencil tool.

Click below the first note.

2. In the text dialog that appears, type in the syllable for that note.
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3. Hit [Tab].
The program moves on to the next note.

4. Input text for this note and hit [Tab] again.

5. Proceed until the last note and then press [Return] or click outside the text box.

❐ Lyrics can also be added automatically, see below.

Lyrics and Measure Widths

When you first enter lyrics, it will probably look crammed, since the words take up 
more space than the notes (the lyrics are also selected just after entering the last 
word, which make them look a bit odd when overlapping). To remedy this, use Auto 
Layout to automatically adjust the measure widths (see page 290).

Before and after using Auto Layout.
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Adding a Second Verse

To insert a second line of lyrics, proceed as follows:

1. Enter the new lyrics above or below the existing verse.

2. Select all the words that should be in the new verse.

3. Pull down the Score menu and select “Move to Verse” from the Text Functions sub-
menu.
Another submenu appears, listing Verse 1 to 6.

4. Select the appropriate verse from the submenu.
To indicate that the words belong to another verse, they are automatically displayed in an-
other color. However, all verses will print in black as usual.

• To select all words in one verse only, select one of the words and use the “Select - Same 
Verse” function on the Edit menu.

Inserting Lyrics into Voices

Each voice can have it’s own lyrics. If you for example have a vocal arrangement 
with several voices, you can add lyrics to them, one by one.

1. Click or double click on the Lyrics Symbol in the “Other” Palette, so that the Pencil tool 
is selected.

2. Make sure the right voice is selected (on the Score Toolbar).

3. Click on the first note in the selected voice.

4. Enter the lyrics for this voice, with [Tab] as described above.

5. Start over, by activating the next voice, clicking on the first note in that voice and pro-
ceed as with the first voice.

6. If needed, adjust the position of the lyrics for each voice (see below).

Inserting the same Text to a number of Notes

If you select a number of notes and hold down [Option] when clicking with the 
Pencil to add text to them, this text is added to all notes. This allows you to for ex-
ample add fingering or “handing” (left/right) to a number of notes at the same 
time.

Moving Lyrics

If you want to move the lyrics up or down, for example to make room for a second 
verse, proceed as follows:

1. Hold down the [Shift] key and double click on the first word in the lyrics.
All lyric “blocks” get selected.

2. Drag one of the lyric blocks up or down.
All selected lyric blocks are moved accordingly.
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Adding Lyrics from the Clipboard

If you want to prepare your lyrics in another program, you can import them into Cu-
base VST the following way:

1. Create the lyrics in another program.
You need to put either a dash (-) or a [Tab] sign between each syllable!

2. Copy the text to the Macintosh clipboard.

3. In Cubase VST, select the first note to which the lyrics should be added.

4. Pull down the Score menu and select “Lyrics from Clipboard” from the Text Functions 
submenu.
The lyrics are added, starting at the selected note.

❐ The “Lyrics from Clipboard” function can also be used if you wish to copy 
lyrics between staves or between Cubase Songs.

Adding Lyrics and Automatically Generating Notes

If you have copied lyrics to the clipboard as above, you can also add them to an 
empty staff - automatically generating notes in the process:

1. Set up the lyrics and copy them to the Macintosh clipboard.

2. In Cubase VST, open the empty staff in Score Edit.

3. Use the Snap pop-up to specify how closely spaced you want the generated notes.

4. Set the Song Position to where you want the lyrics to start.

5. Pull down the Score menu and select “Fill with Clipboard Lyrics” from the Text Func-
tions submenu.
A dialog appears.

6. If your text is separated into lines, use the “Bar step after new line” to determine the 
minimum distance between lines in the text. 
If you for example set this to 4, there will always be at least four bars between the beginning 
of each text line. If the text is not separated into lines, you don’t have to care about this.

7. Click OK.
Now, notes are inserted, starting at the Song Position and spaced according to the Snap 
value. Each note will have a “lyric block” attached to it.
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Page Text

This type of text is inserted by selecting “Page Text” in the “Layout” Palette.

Since this symbol is in the Layout section of the Palette, you should note that it is 
part of the Layout layer, not the staff. The text’s position isn’t tied a note, bar or staff 
position. In other words, it doesn’t matter if you move other objects on the page, 
the Page Text stays where you put it.

Inserting the same Text to all Pages

If you hold down [Option] when clicking with the Pencil, the text you type in will be 
added to “all pages” from the one you are currently editing and onwards.

System Text

This type of text is inserted by selecting “Sys Text” in the “Layout” Symbols Palette.

Just as Page text, this is stored in the Layout layer. In all other ways it is exactly the 
same as regular Text (see above). This means it is tied to the bar and staff position. 
If you move the bar or the entire staff, it moves with it.

Inserting the same Text to all Grand Staves

If you hold down [Option] when clicking with the Pen, the text you type in will be 
added to all grand staves you are currently editing.

Global Text Symbols

This type of text is inserted by selecting “Glob. Text” in the “Global Symbols” Pal-
ette. It is stored in the Layout layer and has the same properties as System Text, but 
with one special feature: Like the other Global Symbols (see page 203), you can de-
cide for which Tracks in a layout you want the Global Text to be displayed. This is 
done by ticking the “Glob.” column for the Track in the Layout Settings dialog.

❐ Don’t confuse Global Text Symbols with the Global Text items for which you can make 
settings in the Preferences–Score–Global Text dialog.
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Text Functions

The Words Palette

If you have certain words that you use a lot, you can “store” these on the Words pal-
ette. This will save time, since you don’t have to type the same word several times.

Storing a Word

1. Display the Words symbol palette.

2. Double click on an “empty” symbol field in the palette.
The Edit Words dialog appears.

3. Type in the desired word(s) in the text field at the top of the dialog.

4. Specify the text type (normal, lyrics, page or system) with the Type pop-up menu.

5. Make settings for font, size and style.
You can also use a Text Attribute Set if you like.
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6. Click OK to close the dialog.
The word(s) you entered appear in the selected symbol field on the palette.

The Words palette, set up for a brass score.

Inserting a Word

You insert Words from the palette as you would insert any regular symbol, by se-
lecting the appropriate Word and clicking in the score. However, you can edit the 
Word after inserting it, just as with text inserted by typing.

“Replace Text Font”

This feature allows you to search for any type of text and replace it with any other.

1. If you have a text block on screen which matches the text you want to look for, select it.

2. Set up the To menu so that the change affects as much of the score as you want.

3. Pull down the Score menu and select Replace Text Font from the Text Functions sub-
menu.
A dialog appears.

The “Replace Text Font” dialog.

4. Set up the “Search For” criteria.
If you had a text block selected, the dialog will be automatically set up with its specification.

5. Set up the “Replace With” criteria.

6. Click Replace.
All text blocks that meet the To menu and “Search For” criteria will now have their Font, Size 
and Style replaced by those set in the “Replace With” section of the dialog.
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Find and Replace

This function allows you to replace all occurrences of a certain word or group of 
words, with another word or group of words. The replacement is done once and for 
all, for all text symbol types, regardless of font, size and style settings. Proceed as 
follows:

1. Pull down the Score menu and select “Find and Replace” from the Text Functions sub-
menu.
A dialog appears.

2. Enter the word(s) to replace in the “Find” value field.

3. If you want all instances of the word(s) to be replaced, regardless of upper/lower case, 
activate the “Ignore Case” option.

4. If you don’t want to replace the word(s) if they are a part of another word, activate the 
“Entire Word” option.
For example, if you want to replace the word “string” but not the word “stringendo”, you 
should activate “Entire Word”.

5. Enter the word(s) that should be used as replacement in the “Replace” field.

6. Click OK.
Now all occurrences of the “Find” word(s) will be replaced with the “Replace” word(s).
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Fixed Text Elements

There are a number of text elements that appear automatically on the page. How-
ever, you still have very detailed control of this text’s appearance.

Score Title, Comment and Author

These text elements normally appear at the top of the first page.

• The Title is at the absolute top. The default for this is the title of the Arrangement.
• The Comment is displayed just below the title.
• The Author text is displayed on the right side of the score, slightly below the comment.

You can adjust the position of the Title, Comment and Author texts individually by 
clicking and dragging.

To edit the different text “strings”, proceed as follows:

1. Double click on any of them.
With a new Arrangement, only the title is visible, so double click on this. The Title, Comment 
& Author dialog appears.

2. Use the Text Element pop-up menu to select the text element you want to make set-
tings for.

3. Type in the text for the selected text element in the field to the right.
If you want to hide any of the elements, just make sure its text field is empty.

4. Make font, size and style settings in the area to the left.
You can also select a Text Attribute Set (see page 243).

5. Repeat the steps above for the other text elements.

6. Click OK to close the dialog.
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Page Numbers

There are two ways to display the settings for page numbering:

• Double click on the page number on any page.

• Open the Preferences–Scores–Page Numbering dialog.

The Preferences–Scores–Page Numbering dialog.

The options in the dialog are used like this:

This Option: Is Used To:

Prefix Add a text before the actual page number.

Show Page Number Turn page numbering on/off completely.

Font, Size And Style Specify how the page number and Prefix should appear. See page 240.

Page Number Offset Offset the page numbering, for example if you want the first score page to 
be numbered 2 (in which case you would set Page Number Offset to 1).

Align Decide where on the page you want the text vertically (Top/Bottom) and 
horizontally (Left, Center Right). If you choose Left or Right you can also ac-
tivate Toggle Position, which makes the page number alternate between 
left and right on even/odd pages.

Number On First Page Hide/show the page number on the first page.
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Copyright

If you wish, you can have Cubase VST automatically insert a “Copyright text” on 
each page you print. To make settings for this, open the Preferences–Score dialog 
and select “Copyright” from the pop-up menu at the top of the dialog.

In the dialog that appears, you can specify the “Copyright text” and make various 
text settings. The options are basically the same as with Page numbers (although 
you cannot exclude page one from the Copyright text, like you can with Page num-
bers).

• To display the Copyright Text, make sure the “Show Copyright” checkbox is activated.

Staff Names

Settings for Staff Names are done in several places:

Turning Staff Names on and off

1. Pull down the Score menu and select “Layout Settings...”.
The Layout Settings dialog appears.

2. Select the Track for which you want to make settings in the “Track” list.

3. Activate the “Staff Name” checkbox to the right.
The check mark in the Name column for the Track indicates that names will be shown.

4. If you want the actual name of the Track in the Arrangement to be used in the score, ac-
tivate “From Track”.

5. If instead you want to specify custom Staff Names, deactivate ”From Track” and enter a 
“Long” and a “Short” name.
The Long name will be displayed for the first system only, and the Short name will be dis-
played for the following systems. If you want a name at the top of the page only, leave the 
“Short” name field empty.
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❐ If the option “Show Long Staff Names on new Pages” is activated in the Preferences–
Scores–Additional Settings dialog, the Long name will be displayed for the first system 
on every page.

6. Click Exit to close the dialog.

Making Text Settings

1. Open the Preferences–Scores–Global Text dialog.

2. Use the “Font for” pop-up menu to select “Track Names”.

3. Select font, size and styles for the Staff Names (or use a Text Attribute Set).

4. Click OK to close the dialog.
You can also edit the text settings for staff names directly from the score, as described on 
page 261.

Additional Staff Name Settings

• If you activate the option “Show Staff Names to Left of Staff” in the Preferences-Scores–Addi-
tional Settings dialog, the Staff Names will be shown to the left of the staves, instead of above 
them.

• You can fine tune the vertical and horizontal position of Staff Names in the Preferences–
Scores–Spacing dialog. There are separate settings for Long and Short names.



- 258 - 

Bar Numbers

Bar number settings are made in two different pages of the Preferences–Scores dia-
log:

General Settings

1. Open the Preferences–Scores–Beams and Bars dialog.
The upper section of this dialog contains the Bar and Bar number settings.

2. Use the “Show Bar Numbers every X bars” setting to specify “how often” bar numbers 
should be shown.
The options are “First” (bar numbers shown for the first bar on each staff), “Off” (no bar num-
bers shown) and any number.

3. If you like, activate the “Show Bar Number Range with Multi-Rests” option.
When this is activated, and you have a multi-rest, the bar number at the beginning of the 
multi-rest will show a range, indicating the length of the multi-rest.

“Show Bar Number Range with Multi-Rests” activated.

4. If you want the bar numbers to be displayed below the bar lines, activate the “Show 
Bar Numbers below Barlines” option.

5. Click OK to close the dialog.

Text Settings

As with many of the other fixed text elements, you can select a font, size and style 
for the bar numbers in the Preferences–Scores–Global Text dialog, or directly from 
the score, as described on page 261.
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Spacing

In the Preferences–Scores–Spacing section you will find four settings that relate to 
bar numbers:

Offsetting Bar Numbers

If you double click on a bar number, a dialog appears allowing you to skip a number 
of bars in the otherwise continuous bar numbering.

This is used for example when a section repeats. Say, you have a repeat of bar 7 and 
8, the first bar after the repeat should have the number 11, not 9. To achieve this 
you double click on the “9” and insert an offset of “2”.

It is also useful if the score starts with an upbeat, and you want the first “real” bar to 
be numbered 1. In that case you would specify an offset of “-1” for the second bar, 
and make sure the bar number for the upbeat bar is hidden.

• Bar Number Offsets are global for all Tracks.

This Option: Is Used To:

First Barnumber - 
Horizontal Offset

Set the horizontal distance between the bar number and the bar line for 
the first bar on each staff.

First Barnumber - 
Vertical Offset

Set the vertical distance between the bar number and the bar line for the 
first bar on each staff.

Other Barnumbers - 
Horizontal Offset

Set the horizontal distance between the bar number and the bar line for all 
other bars.

Other Barnumbers - 
Vertical Offset

Set the vertical distance between the bar number and the bar line for all 
other bars.



- 260 - 

Bar Numbers as Time Code

If you are working with time based material, you may want to include time position 
markers in the score. Clicking on the mouse position box on the Status bar causes 
all bar numbers to display the corresponding time position instead.

To return to regular bar numbers, click on the mouse position box again.

Settings for other Fixed Text Elements

You can make text settings for virtually all text and numbers that appear in the 
score. There are two ways to do this:

Making Text Settings in the Preferences dialog

1. Open the Preferences–Scores–Global Text dialog.

2. Use the “Font for” pop-up menu to select a text type to make settings for.

3. Use the options in the dialog to change the settings.

4. Click OK to close the dialog and apply the settings to all elements of the selected type.
You can also click the Apply button, to apply the settings without closing the dialog.
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Making Text Settings in the Score

Most of the Global Text settings can be edited directly in the Score window, without 
having to open the Preferences dialog:

1. Select an object for which there is a Global Text category.
These include Bar Numbers, Track Names, Time Signatures, Marker Parts, Tuplets, Rehearsals, 
Tablatures and Multi Rests.

2. Pull down the Score menu and use the Text submenus to choose a new font, size, style 
or Text Attribute Set.
The settings for the Global Text category are changed, and the changes are applied immedi-
ately to all objects of the category.



- 262 - 

12
Working with Layouts
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In this Chapter you will learn:

• What Layouts are and what they contain.
• How to Create Layouts.
• How to use Layouts for opening combinations of Tracks.
• How to Apply, Load, Save and Delete Layouts.
• An example of how Layouts can be used.
• What the General MIDI Setup is.

Background: Layouts

Layouts can be viewed as “presets” containing settings for the Layout layer: Staff 
spacing, bar lines, layout symbols etc.

When to use Layouts

• You will need to format the score differently when you print the entire score and when you 
extract parts for single instruments (or groups of instruments) Layouts allow you to keep dif-
ferent sets of “looks” for the same Track or set of Tracks. You might for example have one 
Layout for each single Instrument and one for the entire Score.

• Layouts can be named and appear on the Select menu in the Arrange window. This allows you 
to open a certain combination of Tracks directly into the Score Editor, without selecting the 
Parts on each Track one by one.

What is in a Layout?

Below you will find a list of what is included in a Layout. When you use the Get Lay-
out command (explained below) you get all the properties of a Layout “imported” 
from one set of Tracks to another. When you use “Get Form Only”, only some of the 
properties are included. This is indicated in the table below:

The idea is then that you can extract all the things listed above out of a number of 
Tracks and apply it to another set of Tracks, even in another Arrange window!

Property Get Layout Get Form Only

Symbols from the Layout Palette All Rehearsal marks
Segno
Codas

Endings

Symbols from the Global Symbols Palette Yes Yes

Bar line types Yes Yes

Bar number offsets Yes Yes

All settings in the Layout Settings dialog Yes No

The vertical spacing of the staves Yes No

Bar line spacing (identical on all Tracks) Yes No

Staff Spacing Yes No

Broken bar lines Yes No
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How Layouts are stored

Layouts are created automatically when you edit a single Track or a combination of 
Tracks. They are an integral part of the specific Track combination, which for one 
thing means you do not have to store the Layout separately.

❐ You can create several different Layouts for each single Track or combination of 
Tracks. However, only one Layout at the time can be “activated”.

Creating a Layout

Layouts are created automatically when you perform the following steps:

1. Open a new combination of Tracks for editing.
Each Track may have been edited before, individually or together with other Tracks, it 
doesn’t matter. What matters is that you open precisely these Tracks. For example, to create 
a Layout for a string quartet, select Parts on the Tracks Violin 1, Violin 2, Viola and Cello, and 
press [Command]-[R].

❐ The order of the Tracks does not matter - you can reorder them in the Arrange window 
without removing the Layout. However, the spacing of the staves in the Layout is re-
lated to the order of the Tracks.

2. Perform some type of editing that affect the Layout.
Check the list above. You might for example add Layout symbols to one or more staves, drag 
bar lines, adjust staff spacing, turn on staff separators, etc.

3. Close the Editor by Keeping.
If you instead Cancel all changes made in the editor, no Layout is created.
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Opening the Tracks in a Layout

You can use Layouts as a short-cut for opening a certain collection of Tracks for ed-
iting:

From the Arrange window

1. Pull down the Edit menu and select the “Score Layout” item on the Select submenu.
Another submenu appears which lists all the Layouts in this Arrange window.

The Arrange window Select menu and its Layout submenu.

2. Select one of the Layouts.
All Parts on the Tracks that make up the Layout get selected.

3. Open Score Edit by selecting Score from the Edit menu.

❐ Please note that all Parts on the Track(s) are opened. If you want to edit some specific 
selection of Parts, select them and open Score Edit as usual.

From within Score Edit

1. Select “Display Layouts” from the bottom of the Score menu.
A submenu appears, listing all available Layouts.

2. Select one of the Layouts from the menu.
The associated Tracks appear. This is the same as closing Score Edit, selecting all Parts on the 
Tracks in the Layout and opening Score Edit again.
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The Layout List

In the Score Editor, all the Layouts in the current Arrangement are collected in one 
list. This list is found in the “Layout Settings” dialog on the Score menu. Make sure 
you are in Page Mode.

Layout Settings with a Layout list to the left.

• To the left is a list of the Layouts in “this” Arrange window. 
You can import Layouts from other Arrange windows, see below.

• The Layout that is used by the current combination of Tracks is indicated by a black 
bullet symbol.

• Layouts that are used by other combinations of Tracks are displayed in plain text in the 
list (without a bullet).
If you select one of these Layouts in the list, the Tracks that use it are indicated by black dots 
in the Track list to the right.

• Layouts that are not used by any Tracks are displayed in italics.
If you select one of these, the Track(s) for which it was created are displayed with a bullet in 
the Track list to the right. 
If the Track combination for the Layout doesn’t exist (you might for example have deleted 
Tracks), the word “(Unused)” will be displayed after the name in the Layout list.

• You can rename a Layout by double clicking on its name and entering a new name.
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Applying a Layout

You may have created a Layout for a certain Track or Track combination, and want 
to use it for the Track(s) you are currently editing. Proceed as follows:

1. Open the Tracks to which you want to apply the Layout.
These Tracks may or may not have a Layout already. The current Layout will remain on the 
list, and you will be able to select it again later if you wish.

2. Select Layout Settings from the Score menu.

3. From the pop-up menu at the top, select the Arrangement that contains the Layout 
you want to apply.
By default, the current Arrangement is selected, but you can select any open Arrangement (it 
does not have to be visible, as long as it is present in the Song).

4. Select the Layout you want to apply from the left list. 

5. Click Get Layout or Get Form Only.
The difference between the two is listed in the table at the beginning of this chapter.

The dialog is closed and the Layout you selected is applied to the currently edited 
Track(s). The following rules apply:

• If the Layout was created for a different number of Tracks than the combination to which you 
apply it, things that relate to staves (like vertical Staff distance) are picked from top to bottom.

• Symbols from the Layout section of the Palette appear at the same absolute bar numbers as in 
the “source” Arrangement. This means that if you for example had a symbol in measure 2 and 
now apply the Layout to a Track the doesn’t even start until measure 3, this symbol will not ap-
pear at all!

• Bar line adjustments are made relative to the first bar “currently being edited”. In other 
words, if you selected a new bar line type for the first bar in the piece and then apply this as 
a Layout to another Track, the first bar you are now editing will get that bar line, regardless if 
it is the first bar of the piece or not.
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Deleting Layouts

Deleting one Layout

You can delete Layouts from an Arrangement. However, you can not delete the 
Layout you are currently using (the one with a bullet in front of its name).

1. Open the Layout Settings Dialog.

2. Locate a Layout and select it by clicking on it.

3. Click the Remove button.
The selected Layout is removed from the list.

Deleting all unused Layouts

If you click the Clean Up button, all Layouts that no longer have a Track combination 
to be assigned to, will be deleted. 

❐ This does not delete Layouts that have a Track combination but are currently not used!

Loading From and Saving To Disk

Layouts can be saved to disk as individual documents.

Saving a Layout

1. Open the Layout Settings Dialog.

2. Locate a Layout and select it by clicking on it.

3. Click the Save button.

4. Type in name and save as usual.

Loading a Layout

1. Open the Layout Settings Dialog.

2. Use the Arrangement pop-up menu at the top of the dialog, to specify into which Ar-
rangement you want to load the Layout.

3. Click the Load button.

4. Locate the file and open it as usual.
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Using Layouts – An Example

The following text outlines the basic steps for extracting a musical part from a full 
score.

1. Prepare the entire Score, including all formatting. Create a named Layout for it (for 
example “Full Score”).
Make notes of which changes you make that are actually part of the Layout and not the indi-
vidual Tracks.

2. Close the Score Editor.

3. Open a single Track, for example a woodwind part.

4. If you need, open the Layout Settings, select the “Full Score” Layout and use “Get Form 
Only” to extract the Layout symbols and the bar line types from the woodwind Track as 
it appears in the Full Score Layout.

5. Prepare a Layout for the woodwind part.
You might for example move bar lines, add endings, turn on multiple rests, etc. 

❐ Be careful not to change any of the properties of the Track which are not part of the 
Layout (or you will modify the “Full Score” too!).

6. Name this Layout.

7. If you later change any of the form elements in the Full Score, you can use the Get 
Form Only to apply these changes to the single Track Layout, too.

Marker Track to Form

If you have created Marker Parts in the Arrange window, so that each Marker Part 
encompasses a “section” in your music (verse, bridge, chorus, etc.), you can auto-
matically transfer these sections to the current layout:

1. Make sure Page Mode is selected.

2. Pull down the Score menu and Format.

3. From the submenu that appears, select “Marker Track to Form”.
Now, Rehearsal markers and double barlines are inserted in the score, at the start position of 
each Marker Part in the Arrangement. You will also see the names of the Marker Parts.

4. If you don’t want the names of the Marker Parts visible in the score, pull down the 
Score menu and select “Hide Markers” from the Format submenu.
You can display the Marker names again at any time, by selecting “Show Markers” from the 
same submenu.
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13
Designing your Score - Additional Techniques
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In this Chapter you will learn:

• About Page Mode settings such as note spacing and Real Book.
• How to change the Staff size.
• How to create multi rests.
• How to add and edit bar lines.
• How to create upbeats.
• How to set measure spacing and the number of bars across the page.
• How to control staff and grand staff spacing.
• How to use Auto Layout.
• How to use Clean Up Layout
• How to break bar lines.

❐ Before you start designing the score page layout, you should open the Page Setup dia-
log on the File menu, and make settings for paper size, print scale and margins!

Page Mode Settings

These are found in the Layout Settings dialog on the Score menu. As the name im-
plies, these settings have no relevance to Edit mode. The dialog is also devoted to 
handling Layouts, but this is described in the previous chapter.

Spacing

This pop-up contains three methods for how the program should set the spacing of 
notes within the bar. The only way to find out which method suits a particular score 
best is to try them all out!

Select This: When:

Regular The note spacing is compacted automatically. We recommend this option if you 
have melody lines and there is a lot of syncopated notes.

Optimize The note spacing is compacted automatically. This is the method we suggest for 
chord parts and parts without syncopation. 

Equal When you want a note to take up space according to its note value. In this mode two 
sixteenths will take up as much space as one eighth note, for example.
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Multi Rests

Whenever more than one-bar rests occur, the program can replace these with a 
multi-rest symbol. See page 276 for more info on Multi Rests.

The parameter allows you to set how many empty bars should be “allowed” before 
Cubase should collect them into a multi-rest. “Off” means “never”.

Size

Changes the size of all Staves. See page 273.

Real Book

When this option is turned on, Clef symbols are not set out at the beginning of each 
staff, only on the first staff on each page.

Staff Separators

When this option is turned on, separator symbols are inserted at the beginning of 
each grand staff.

A Staff Separator between two systems.

Modern Time Signature

When this is activated, Time Signatures are shown above the staves rather than in 
them. You can set the size of the Modern Time Signature in the Preferences–Scores–
Additional Settings dialog. Also note that when Modern Time Signature is selected, 
you can use the “Sign” column in the Track list in the Layout Settings dialog, to spec-
ify for which Tracks time signatures should be displayed.

• If you generally prefer to display the score in a more modern way, check out the op-
tions in the Preferences–Scores–Modern Style dialog!
For descriptions of the options in the dialog, see the Menu and Dialog Reference document.
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Staff Size

For one System

You can set the Staff Size as a percentage of normal size.

1. Open Staff Settings for the Staff you are interested in.

2. Click the “Staff Options...” button.

3. Adjust the Size parameter in the lower left corner.
The values range from 25% up to 250% of normal size.

For all Systems in a Layout

1. Open the Layout Settings dialog.

2. Change the Size parameter.
The values range from 25% up to 250% of normal size.

3. Close the dialog.

All Staves will now get the desired size. Staves that have individual size settings (as 
described above) will still be proportionally smaller/larger. 

This setting is part of the Layout and can for example be used when printing a full 
score slightly smaller than the parts for each instrument. 
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Hiding/Showing Items

“Any” object on a Page can be hidden, including notes, rests, symbols, clefs, bar lines, 
even entire staves, you can make a page totally blank by hiding! (well, actually, one 
staff has to remain shown). Applications are found below.

Hiding

To hide items proceed as follows:

1. Select all the items you want to hide.

2. Select Hide from the Do pop-up menu or click on the Hide button on the Score Toolbar.

• Notes can also be hidden by selecting them, selecting “Get Info” from the Edit menu, 
and ticking the “Hide Note” checkbox in the Note Info dialog (see page 161).

Hiding in this Layout only

If you want the Hiding to be “local” to the current layout, hold down [Command] 
when selecting Hide as described above.

❐ This is not possible when hiding notes, only other symbols.

Viewing Hidden Objects

If you switch the Score Editor to Edit mode, all objects will be visible. Switch back to 
Page mode, and hidden objects will be invisible again.

If you pull down the Score menu and select “Show Invisible” from the Global Set-
tings submenu, the Show Invisible dialog appears.
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This contains two items related to hidden objects:

• If you activate the “Hidden Notes” option, all hidden notes in the score are shown.
Deactivating “Hidden Notes” will hide the notes again.

• If you activate the “Hidden” option, all hidden objects (except notes) will be indicated 
by a “Hide” text marker.

These options are also available on the “Show Invisible” Filter Bar (see page 55).

Showing one Object

1. Make sure “Hidden” is activated in the “Show Invisible” dialog.

2. Click on the “Hide” text marker below the object you want to reveal.
The text gets selected.

3. Press [Backspace].
The object appears. Undo is available if you change your mind.

Showing all Objects

If you pull down the Do pop-up menu and select “Show”, all hidden objects are re-
vealed.

• You can also use the Clean Up Layout function to permanently reveal hidden notes and 
objects, as described on page 292.

Applications Of Hiding

Printing Scales

If you for example want to create scale examples, enter the notes and hide time sig-
natures, bar lines and other unnecessary objects.

A scale created with hidden bar lines, time signatures etc.

Creating Upbeats

If you want an upbeat at the beginning of a Song, you may want to hide the rests 
preceding the upbeat.

Graphic Notation

By hiding bar lines and perhaps using Equal Spacing (see page 271), you can pro-
duce graphic notation.
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Multiple Rests

Multiple consecutive rests can be automatically consolidated into multi-rest mea-
sures as follows:

1. Open the Layout Settings dialog.

2. Set Multi Rests to specify how many empty bars should be “allowed” before Cubase 
should collect them into a multi-rest. 
For example, a value of 2 means that three or more consecutive empty bars will be collected 
into a multi-rest. The value “Off” means “never”.

3. Click Exit to close the dialog.
The multi rests now appear in the score.

A Multi Rest over three bars.

Splitting Multi Rests

To divide one long multiple rest into many shorter, proceed as follows:

1. Double click on the Multi Rest symbol.
The Split Multi Rest dialog appears:

2. In the dialog box, enter the bar number where you want the first split.

3. Click OK.

4. If you need more splits, double click on any multi rest symbol and proceed as above.

❐ The program automatically splits multi rests wherever there is a change of Time signa-
ture, at double bar lines or repeat signs, or if a Rehearsal mark appears.
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Multi Rest Appearance

If you open the Preferences–Score–Beams and Bars dialog, you will find a couple of 
settings that determine the appearance of multi rests:

It is also possible to adjust the height and width of the multi-rest symbol (in the 
Preferences–Score–Spacing dialog) and to select a font for the multi-rest numbers 
(in the Preferences–Score–Global Text dialog).

Adding and Editing Bar Lines

Editing existing Bar Lines

For each bar line, you can choose whether you want a regular, single bar line, a 
double bar line, a repeat sign, etc.:

1. Double click on the bar line for which you want to edit the settings.
A dialog appears with a number of bar line types.

2. If you wish the bar line to be shown with “brackets”, activate the Brackets checkbox.
This is only relevant for repeat signs.

3. Click on the desired bar line type.
The dialog closes and the bar line type is changed.

Show Multi-Rest number 
above Symbol.

When this is activated, the numbers are shown above the multi-rest 
symbol, instead of below it.

Show Multi-Rests in 
Church Style

When this is activated, multi-rests are shown in “church style” (vertical 
bars), rather than with the regular, horizontal symbols.

Show Barnumber Range 
with Multi-Rests

When this is activated, and barnumbers are displayed, the barnumbers 
of a multi-rest will be shown as a range.
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The “Hide” option

One of the options in the bar line dialog is called Hide. This can be used as an op-
tional way of hiding bar lines. Bar lines hidden this way will not get a “Hide” text 
marker, nor will they be revealed if you select the “Show” command on the To pop-
up menu. The bar spacing, bar numbers etc. will behave just as if the bar line was vis-
ible. To show the bar line again, double click on it and select another type of bar line.

• If you have trouble finding a “hidden” bar line, try selecting it by dragging a rectan-
gle around it.
When selected, the bar line will be visible and it will be easy to double click it.

Inserting extra Bar Lines

You can also insert additional Bar Lines from the Symbols Palette as with any other 
Symbol. When you do, the same dialog appears and you can select any of the avail-
able bar line types.

Inserting a bar line in the middle of the bar splits it up in two halves. For example, if 
you have an empty bar in 4/4 and insert a bar line at 1.4.1.0, you will get one bar with 
a half note and a quarter note rest followed by one with a quarter note rest. This can 
for example be used to create upbeats in the middle of the song, as described below.

Notes that stretch over bar lines are always tied.
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Creating Upbeats

In the Beginning of a Song - by using the Pickup Bar feature

With this method, the upbeat actually contains exactly the number of beats dis-
played. That is, if you have a upbeat of one beat, your Song starts with one bar in 1/
4 time.

1. Change the time signature of the first bar to the length of the upbeat.

2. Insert a time signature of the correct kind (the time signature used throughout the 
Song) in the second bar.
Time signatures are inserted by selecting the time signature symbol from the “Clefs etc.” 
symbol palette and clicking with the Pencil tool.

3. Enter the notes in the upbeat into the first bar of the song.

The first bar before any adjustments.

4. Double click the time signature for the upbeat bar.
The Edit Time Signature dialog appears.

5. Activate the option “Pickup Bar” and click OK.

Now, the time signature of the first bar takes on the look of the second bar’s signa-
ture, while the time signature in the second bar is hidden:

6. If you use bar numbers, double click on the first bar number and enter an offset of -1. 

7. Adjust the display of bar numbers and hide the “0” in the first measure.



- 280 - 

• Another way to change the bar numbering would be to use the Bar Display setting in 
the Synchronization dialog (on the Options menu).
The advantage of that method is that the bar numbers in the Score will still be consistent 
with the Song Position.

In the Beginning of a Song - by hiding rests

With this method, the first bar will actually have the same time signature as the fol-
lowing bars - it will only look like an upbeat bar:

1. Enter the notes in the upbeat into the first bar of the song.

The first bar before any adjustments.

2. Hide the rests that precede the notes.

3. Drag the bar line between measure one and two to adjust the width of the bar.

After hiding the rest and dragging the bar line.

4. If you like, move the notes in the upbeat measure, using the Layout Tool (”graphic 
move”).

5. If you use bar numbers, adjust them as in the previous example.

The final upbeat.

Anywhere else in the Song

1. Insert a bar line where the upbeat begins. Select the type of bar line you need.
You might for example insert a repeat.

2. Enter the notes on each side of the new bar line.

Inserting a bar line in a measure in 3/4.

3. Add Endings as needed.
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Setting the Number of Bars across the Page

“Automatically”

In the Preferences–Score–Beams and Bars dialog, you will find a setting called “De-
fault Bars Across The Page”. In Page mode, this is used for the following:

• To decide how many measures are across the page in a new Layout.
• To specify the maximum number of bars across a staff after performing a “Bars and Staves” 

Auto Layout (see page 290).

Manually

In Page Mode you have full control of how many bars appear across the page, by 
using the Number of Bars dialog or the tools. 

❐ If you want to use the “Bars and Staves” Auto Layout function (see page 290), you 
should do this before you adjust the number of bars manually.

Using the Number Of Bars Dialog

1. Make a Staff active in the system where you want to start making changes.
This means that if everything looks fine until for example the fifth system, make one of the 
staves active in this system.

2. Pull down the Score menu and select “Number Of Bars” from the Format submenu.
The Number of Bars dialog appears.

3. Set the desired number of bars across the page.

4. Select one of the options by clicking the buttons:

Select This: If You Want:

All Systems All systems on all pages to have this number of bars across the page.

All Following
Systems

If you want the system where the active staff is, and all following systems, to 
have this number of bars across the page.

This System Only If you only want the system where the active staff is, to have this number of bars 
across the page.
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Using the Tools

• To make a measure “fall down” on a new staff, use the Scissors Tool to click on its bar 
line.

Before and after moving the third measure one staff down.

• To bring the measure back up to the previous staff, use the Glue Tube Tool to click on 
the last bar line on the upper of the two staves.
This will in fact move all measures in the lower staff up to the upper.
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Inserting and Removing Bars

By using the Insert and Remove Bars functions, you can change the bar structure 
for the edited Track(s), without destroying the layout. Proceed as follows:

❐ These are “destructive” functions; they actually add or remove bars from the edited 
Track(s)!

Insert Bar

1. Move the Song Position to where you want to insert a new bar.
If you want to insert a new bar between bars 2 and 3, move the Song Position into bar 3.

2. Pull down the Score menu and select Insert Bar from the Format submenu.
A new bar is inserted before the bar with the Song Position.

Remove Bar

1. Move the Song Position into the bar which you want to remove.

2. Pull down the Score menu and select Remove Bar from the Format submenu.
The bar is removed.
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Moving Bar Lines

The following operations can be made using the regular Arrow or the Layout Arrow 
Tool, it doesn’t matter.

Moving a Bar Line

If you drag a bar line to the left or right, the surrounding measures are adjusted pro-
portionally.

Moving Bar Lines on All Staves

If you hold down [Option] when dragging a bar line, all bar lines below the one you 
drag will be moved accordingly.

Moving a single Bar Line separately

If you hold down [Command] while dragging a bar line, the widths of the surround-
ing bars are not affected.

Making an Indent on one Line

• To create an indent, simply drag the first or last bar line on a staff.
The sizes of all measures are adjusted proportionally.

Before and after dragging the first bar line on the first staff.

Making Indents on several Lines

If you hold down [Option] and drag the first or last bar line in a system, all following 
systems will get the same indent. If you want all lines on all pages to be indented in 
the same way, hold down [Option] and drag the appropriate bar line on the first sys-
tem of the score.
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The last Bar Line in the Piece

Cubase VST attempts to move the last bar line and space the bars on the last line in 
a sensible way, but you can change this manually by dragging the last bar line if 
you like. You can also double click on it if you want another type of bar line than the 
default.

Resetting Bar Spacing

To reset the bar spacing to standard values for several lines, proceed as follows:

1. Locate the first line for which you want to reset the bar spacing, and make one staff in 
that system active.

2. Select “Number Of Bars” from the Format submenu on the Score menu.

3. Specify the number of bars that you already have on the line.

4. Click on “This System Only”.
Optionally, you might reset “All Systems” or “All Following Systems” lines at the same times, 
as described on page 281.

5. Click OK to close the dialog.
The bar spacing is reset for the currently selected staff and all following staves.
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Dragging Staves

The following operations can be made using the regular Arrow or the Layout Arrow 
Tool, it doesn’t matter. However, dragging staves can only be done in Page Mode.

Adding Space between two Grand Staves

1. Locate the first Staff in the lower of the two systems you wish to spread apart.

2. Clicking just to the left of the first bar line and keep the mouse button down. The entire 
staff is inverted.

3. Drag downwards or upwards and then release the mouse.
The system you dragged has now moved down and all the systems below it have moved 
with it. 

Before...

... and after dragging the upper system, to make room.
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Setting the same Distance between all Grand Staves

1. Hold down the [Option] key.

2. Drag the first staff of the second system, until you have the correct distance between 
this and the first system.

3. Release the mouse button and the [Option] key.
All systems will now be the same distance apart as the one you dragged and that above it.

❐ This operation affects the system you drag and all following systems.

Setting the Distance between Staves within a Grand Staff

1. Locate the Staff you wish to spread apart.
Click just to the left of its first bar line and keep the mouse button down. The entire staff gets 
inverted.

2. Drag downwards or upwards and then release the mouse.
The staff you dragged has now moved down and all the other staves in the system are ad-
justed accordingly. 

Setting the same Distance between Staves in several Systems

1. Hold down the [Option] key.

2. Drag the desired staff as described above.

3. Release the mouse button and [Option] key.
The corresponding staves in all following systems are moved accordingly.

Dragging the staves 
in a piano system 
apart.
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Moving one Staff only

You may wish to move one staff without affecting any other staff in any way:

1. Hold down the [Command] key.

2. Drag any staff as described above.

Moving Staves between Pages

By using the “Move To Next/Prev. Page” commands on the Format submenu, you 
can quickly edit the page breaks:

Moving Staves to the Next Page

1. Locate the staff you want to move to the top of the next page, and make it the Active 
Staff.
This can be any staff except the first staff one on the page.

2. Pull down the Score menu and select “Move To Next Page” from the Format submenu.
The Active Staff (and any following staves on the page) are moved to the next page.

Moving Staves to the Previous Page

1. Make the staff at the top of the page the Active Staff.
If any other staff is Active, Move To Prev. Page will be greyed out. Also, the function will not 
work for the first staff on the first page.

2. Pull down the Score menu and select “Move To Prev. Page” from the Format submenu.
The Active Staff, and as many of the following staves as there are room for, are moved to the 
previous page. If the previous page is “full” already, nothing will happen.
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Adding Brackets and Braces

While it’s possible to add Brackets and Braces (curly brackets) manually from the 
Layout Palette, you can also do this in the Layout Settings dialog:

1. Open the Layout Settings dialog.
In the Track list, you will find columns for “Braces” ( { ) and “Brackets “ ( [ ).

2. Click in one of the columns and drag downwards in the list to encompass the desired 
Tracks.
The column indicates graphically which Tracks will be encompassed by the brace/bracket.

3. Close the Layout Settings dialog.
The score is displayed with brackets or braces according to the settings you made.

• You can edit brackets and braces in the dialog by dragging the ends of the indicator in 
the list.

• To remove a bracket or brace, hold down [Command] andclick on its indicator in the 
list, at the topmost Track.

❐ If the option “Show Braces in Edit mode” is activated in the Preferences-Score-Editor 
Behaviour dialog, brackets and braces are shown in Edit mode as well.

Click at the first Track for which you 
want a Bracket or Brace...

..and drag downwards in the list to 
enclose the desired Tracks.
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Auto Layout

This item on the Score menu brings up a submenu with eight options. Selecting 
one of these makes the program “walk through” the score and make adjustments 
to measure widths, staff distances etc. automatically. Exactly which parts and prop-
erties of the score are affected depends on which option you select, as described 
below. For many of the Auto Layout functions, you can make default settings in the 
Preferences–Scores–Spacing dialog (see the online help).

❐ The Auto Layout adjustments are done just as if you yourself had made them manu-
ally. This means that if there’s something you don’t like, you can always change it man-
ually, as described above.

Move Bars

This option looks at the currently active grand staff, and attempts to adjust the 
measure widths, so that all notes and symbols get as much room as possible. The 
number of bars on the staff is not affected.

• You can perform this function for several staves in one go, by dragging a selection rect-
angle over their left edges, and then selecting Move Bars.

• You can also perform the Move Bars function by clicking on the Auto Layout button on 
the Score Toolbar.

For this to work, an entire staff must be selected (black) - otherwise a “Bars and Staves” oper-
ation is performed (see below).

Move All Bars

This works like Move Bars, but affects all grand staves from the active one to the 
end of the score.

Move Staves

This changes the measure width (as with Move All Bars) but also the vertical staff 
distance, of the active staff and all following staves.
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Hide Empty Staves

This hides all empty staves, from the active staff to the end of the score. Note that 
polyphonic/split staves are in this case treated as one entity, if the clef in the upper 
system differs from that in the lower system. That is, a piano staff is considered 
“empty” only if there are no notes on either staff.

• If you have activated the “Hidden” option in the Show Invisible dialog or on the Filter 
Bar, hidden staves are indicated by a marker with the text “Hidden:Name” (where 
“Name” is the Staff Name).
To reveal hidden staves, either delete their “Hidden” markers, or select Show from the Do 
pop-up menu.

• If you activate the option “Auto Layout-don’t hide the first staff” in the Preferences-
Scores-Editor Behaviour dialog, staves in the very first grand staff will not be hidden, 
even if they are empty.
This is useful for example if you are creating an orchestra score, and want to show the com-
plete “layout” of the orchestra on the first page of the score, without hiding anything.

Bars and Staves

This is a combination of Move All Bars and Move Staves, plus automatic calculation 
of the number of bars across the page.

Before you perform the Bars and Staves operation, you should use the “Default 
Number of Bars across Page” setting (in the Preferences–Score–Beams and Bars di-
alog) to specify the maximum number of measures in each system.

• The Bars and Staves operation can also be performed by clicking on the Auto Layout 
icon on the Score toolbar.

For this to work, no staves must be selected (black) - otherwise a “Move Bars” operation is 
performed (see above).

Spread Page

This corrects the vertical layout of the staves on the current page, so that they “fit 
onto the page”. In other words, this removes white space at the bottom of the page.

Spread All Pages

This is the same as Spread Page, but affects all pages from the current and onwards.

Optimize All

All of the above in one fell swoop. This procedure might take some time but usually 
yields great results.



- 292 - 

Clean Up Layout

This menu item allows you to delete invisible layout elements, which in effect re-
stores the score to default settings.

1. Set up the To menu as desired.
This allows you to delete items only within the Cycle or the Loop, etc.

2. Select “Clean Up Layout” from the Format submenu on the Score menu.
A dialog box appears with options as described below.

The Clean Up Layout dialog.

3. Turn on the items you want delete or reset to standard settings.

4. Click on the Active Staff button to clean up the active staff only, or the All Staves but-
ton to clean up all staves.

Activate this: To:

Hidden Notes Make all Hidden Notes permanently visible again.

Quantize Delete all Display Quantize elements.

Layout Tool Reset all positions of notes, clefs, slurs and ties altered using the Layout tool.

Grouping Reset the grouping under beams to standard values.

Cutflag Delete all Cutflag Events.

Hidden Make all hidden objects permanently visible again.

Split Rests Collect all multi rests split up into several “groups”, into one single multi rest.

Stems/Beams Reset the length of all stems and reset the slant of beams that have been manu-
ally adjusted.

Note Info Reset any settings made in the Note Info dialog.

Bar Offset Delete bar number offsets.

Accent Coords Removes all manual spacing of note symbols and slurs.
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Breaking Bar Lines

Sometimes you may not want a bar line to stretch all the way across a grand staff. In 
this case you might “break it”.

Breaking Bar Lines in one Grand Staff

1. Select the Eraser Tool.

2. Click on a bar line connecting the two staves.
All bar lines between these two staves (except the first and last) are broken. To break the first 
or last bar line in a Grand Staff, you need to click directly on these.

Before and after splitting the bar lines between two staves.

Breaking Bar Lines in several Grand Staves

If you hold down [Option]and click on a bar line as above, the corresponding bar 
lines are broken in all following Grand Staves.
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Re-connecting Broken Bar Lines 

If you have broken the bar lines, you can use the Glue Tube Tool to connect them 
again.

1. Select the Glue Tube Tool.

2. Click on one of the bar lines in the staff above the broken bar lines.
All bar lines between these staves in this Grand Staff are connected.

• To re-connect bar-lines in several Grand Staves, hold down [Option] and click with the 
Glue Tube tool as above.
The bar lines between the corresponding staves are connected in all following Grand Staves.

Copying Settings between Grand Staves

If you have made settings for a Grand Staff, you can copy these to all following 
Grand Staves in the Layout. This allows you to set up broken bar lines, spacing, 
brackets, etc. for the first Grand Staff, and then easily apply these settings to all 
other Grand Staves:

1. Make settings for the first Grand Staff in the score.

2. Pull down the Score menu and select “Copy To All Grand Staves” from the Format sub-
menu.
The settings are applied to all following Grand Staves.
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14
Scoring for Drums
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In this Chapter you will learn:

• How to set up the score Drum Map.
• How to set up a Staff for drum notes.
• How to enter and edit drum notes.
• How to use a Single Line drum staff.

Background: The Drum Map and Score Edit

When scoring for drums, you can assign a unique note head to each pitch. There is 
even the possibility to set up different note heads for different note values!

However, in order for you to make full use of this fact you need to understand a bit 
about drum maps, and the interaction between Drum Edit and Score Edit.

The Score Drum Map

The Drum Tracks concept relies on a Drum Map with named Sounds (this is all de-
scribed in the Drum Editor chapter in the Getting into the Details document). In 
Score Edit, an “additional” map is needed to display different note heads for differ-
ent pitches. This “Score Drum Map” can be looked upon as an extension to the 
Drum Editor Drum Map.

You can score for drums on MIDI Tracks or Drum Tracks. For Drum Tracks, the 
names and pitches of the Drum Sounds in the score are based on the Drum Map 
currently selected for the Track; for MIDI Tracks, the Default Drum Map is used.

❐ This means there is one Score Drum Map (with separate settings) for each “regular” 
Drum Map in the Song. 
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You access the Score Drum Map from the Global Settings submenu on the Score 
menu.

Pitch vs. Display Pitch

In the Drum Maps you will find a Pitch setting and a Display Pitch setting.

• The Pitch setting is the actual note being edited. For a MIDI Track this is simply the pitch of 
the MIDI note recorded. For Drum Tracks this is the In-Note for the Sound. In either case this 
is just a display field so that you know which note you are editing, you can’t change this from 
within this dialog box.

• The Display Pitch value is used to set where vertically on the system the note should be dis-
played. It can be thought of as a display transpose setting that is individual for each note. 
Again this only affects how the note is displayed, not how it is recorded etc.
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Use Score Drum Map On/Off

For the Drum Map settings to actually be used in the score, you need to activate the 
“Use Score Drum Map” checkbox. This is found in two places: in the Staff Options 
dialog (accessed from the Staff Settings dialog) and in the Drum Map dialog. Note 
that these two checkboxes are duplicates - activating one of them will automati-
cally activate the other and vice versa.

Edit in Scores

This is displayed on page 301.
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Setting up the Drum Map

Basic Settings

1. Open Score Edit for the Track for which you plan to score for drums.
This could be a MIDI Track or a Drum Track.

2. Select Drum Map from the Global settings submenu on the Score menu.
The Drum Map dialog box appears.

3. If “Use Drum Map” isn’t active, turn it on.

• When “Use Drum Map” is activated, selecting a note in the score will automatically se-
lect the corresponding drum sound in the Drum Map dialog.
This helps you find the desired sounds quicker.

4. Make settings for the Sounds/MIDI Notes you need.
The Options are described below.

❐ Again, please note that there are as many Score Drum Maps as there are regular Drum 
Maps in the Song. Which one you get only depends on which Track you are editing. The 
Score Drum Maps are totally independent of one another. In other words, each pitch 
can have different settings in different drum maps.

Initializing the Display Pitches

If you click the “Initialize Display Notes” button, all Display Pitch values are reset, so 
that actual pitch and Display Pitch is the same for each Sound/note.

This Field: Displays:

Name This is the name of the Drum Sound. To change the name of a Sound, double click 
on the name and type in a new one. Note that this affects the “real” Drum Map - the 
changed name will appear next time you open this Map in Drum Edit!

Pitch For Drum Tracks, this is the “I-Note” in the Drum Map that plays this Sound. For MIDI 
Tracks it is simply the Pitch of the MIDI note in the Track.

This is only a display value which can’t be edited here.

Display Pitch The vertical position for this pitch in the score. For example you can make all notes 
with pitch F3 appear as if they had the pitch A4. Also note that several different 
Sounds/notes can have the same Display Pitch. You might for example want to 
have all different snare drums displayed as the same pitch (possibly separating 
them by using different note heads).

Head This field contains a pop-up which allows you to select one of a number of note 
heads for this pitch. See also “Using Note Head Pairs”, below.

Voice This allows you to make all notes with this pitch belong to a certain Voice, so that 
they get a common rest handling and stem direction, for example. For more info 
on Polyphonic Voicing, see page 129.
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Using Note Head Pairs

Not only can you have different drum sounds displayed with different note heads, 
you can also display different note heads for different note values:

1. Activate the “Use Head Pairs” checkbox.
The “Head” column now shows two heads for each drum sound. 

As you can see, all head symbols are arranged in pairs - by default an “empty” head paired 
with a “filled” head. Just as with regular notes, the “empty” note heads are used with half 
notes and larger note values, and the “filled” heads are used with quarter notes and smaller 
note values.

2. To select a head pair for a Drum Sound/note, click in the Head column to pull down the 
pop-up menu as usual.
You will only be able to select the left note head in the Head column (the one used for half 
notes and longer) - the right note head is automatically selected.

Customizing the Note Head Pairs

If you don’t like the default pairs of note heads, you can edit these:

1. Click the “Edit” button.
Another dialog appears. 

2. To change a symbol in a pair, click on it and select a new symbol from the pop-up menu 
that appears.

3. When you’re done, click OK to close the dialog.
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Editing the Drum Map in the Score

If you activate the checkbox “Edit in Scores” in the Drum Map dialog, you can 
change the settings for the Score Drum Map directly in the score:

• Transposing a note will change the display pitch of its drum sound - the actual note will 
not be transposed.

• Double clicking a note allows you to make note head settings for that drum sound.

• Using the “Move to Voice” function will change the Voice assignment of the drum 
sound.

❐ This requires that you leave the Drum Map dialog open - closing the dialog will auto-
matically turn this option off, allowing you to perform normal editing.
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Setting up a Staff for Drum Scoring

1. Open Staff Settings and click on the “Staff Options...” button.

2. Make sure “Use Score Drum Map” is activated.
As mentioned above, this can also be activated from the Drum Map dialog.

3. If you want a Single Line Drum Staff, activate this option.
This is described in detail below.

4. If you want Flat Beams, activate this option (see page 163).

5. If you want all stems to end at the same position, activate fixed stems and set a length 
for Up/Down stems.

An example of Drum Staff settings.

• You may also want to use Polyphonic voices, for separate rest and stem handling. 
However, you can still activate “Fixed Stem Length” in the Staff Options dialog if you like. See 
“Polyphonic Voicing” for more information about Polyphonic Voices.

Entering and Editing Notes

This is just as entering notes on a normal note system. However, please note:

• Notes are edited using their Display Pitch when the Drum Map is used. This means that when 
you move a note vertically, you move it to another Display Pitch. What actual pitch it gets de-
pends on which Pitch uses the Display Pitch you now “dropped it on”.

• When the Score Drum Map is on, the Mouse box on the Status bar shows you the name of 
the Drum Sound instead of the pitch.

The Mouse box showing drum names.

• Try to avoid editing pitches from the Info Line when you are working on a Drum Track. The 
reasons for this are described on in the Drum Editor chapter.
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Using Single Line Drum Staff

When this option is activated in the Staff Options dialog, there is only one line in 
the system. Furthermore, notes can only appear below the line, on the line and 
above the line.

To decide which notes go where, proceed as follows:

1. Open Staff Settings and click the Staff Options button.

2. Activate Score Drum Map and Single Line Drum Staff.

3. Set up the two pitch values to decide which pitches go on the line.
Notes below this range automatically wind up below the line and notes above wind up 
above the line.

❐ When you enter and edit the pitch of notes on a single line drum staff, the best way is 
to drag the note up or down while watching the Mouse box on the Status bar.
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15
Creating Tablature
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In this Chapter you will learn:

• How to create Tablature, automatically and manually.
• How to control the appearance of the Tablature notes.
• How to edit Tablature.

Cubase is able to produce score in Tablature format. This can be done automati-
cally, by “converting” recorded MIDI information. You can also create a Tablature 
Staff from scratch and enter the notes “by hand”.

❐ Even though we use the term “converting” in this chapter, pleas note that Tablature is 
a mode. You can switch between regular notation and Tablature at any time.

Automatic Creation
This assumes you have a regular score on screen already. We also suggest you per-
form basic editing like quantizing, to make the score as legible as possible as regu-
lar notes, before converting into Tablature.

1. If you only want to convert a section of the Track/Part, use the To menu to specify this.
You might for example only convert the notes within the Cycle, the selected notes, etc. But 
please note the following:

❐ You might make only a few of the notes into tablature notes, but the entire system will 
be shown in Tablature mode with respect to how many note lines are used, etc.

2. Make sure the notes in the score are inside the range of the instrument.
Notes with a pitch lower than the open tuning of the lowest string cannot be converted.

3. Select Tablature from the Score menu’s “Staff Functions” submenu.



- 306 - 

4. Select one of the predefined instruments from the pop-up menu.

5. Activate “Tablature Mode”.

6. If you are not using one of the predefined instruments, set the open tuning of each 
string using the six value fields.
If one string isn’t used, set it to Off, the lowest value.

7. If so desired, activate the “No Stems/Rests” and “MIDI Channel 1-6” 
features.
No Stems/Rests will give you a score where the notes have no stems and where all the rests are 
hidden. The “MIDI Channel 1-6” feature is described below.

8. Click OK.
The Tablature now appears. You will get as many note lines as you have activated strings. All 
the notes will now have a fret number instead of their regular note heads. 

Before and after using Make Tablature.

9. Edit the Score, if needed.
Generally you can make Display Quantize settings, add symbols etc. as with any Score. How-
ever, editing the actual notes is a little bit different from regular notes. See below.

Using “MIDI Channel 1-6”

This feature will make notes automatically appear on the correct string according 
to their MIDI Channel value.

Normally, the program automatically decides on which string to display a note, by 
looking at the pitch and then putting the note at the lowest possible string. While 
you can then manually move note to the correct strings, using the “MIDI Channel 1-
6” is automatic, at least if you make the right preparations.

1. Many guitar synthesizers are able to transmit each string on a different MIDI Chan-
nel. If you have such an instrument, set it up so that the highest E string transmits on 
MIDI Channel 1, the B string transmits on MIDI Channel 2 etc.

2. Record the piece. Quantize and edit it as desired.

3. Convert the piece into Tablature, as described above, with the “MIDI Channel 1-6” fea-
ture activated.

4. Now, the notes will automatically appear on the right string. 
For example if you played a “B” on the low E-string, it will appear as a “7” on that string, not as 
a “2” on the A-string.
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What the Automatic Tablature Function actually does

The following table describes all the changes made to your staff when you auto-
matically create Tablature. This will help you adjust or “undo” anything you like 
changed. Details about the functions are found in the “Manual Creation” section, 
below.

Score: Function: Setting:

New number of note lines Staff Options – System Lines Changed to the number of 
strings on the instrument

Wider Spacing between note 
lines 

Staff Options – Add Space Raised to “1”

New Clef Staff settings – Clef The Tablature clef is selected

Note heads have numbers Staff Options – Tablature Mode Activated

Stems disappear (If “No Stems/
Rests” was used)

Staff Options – Tablature Mode Activated

Rests disappear (If “No Stems/
Rests” was used)

Staff Options – Tablature Mode Activated
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Manual Creation

To set up an empty system for inputting Tablature, proceed as follows:

1. Change the Clef to the Tablature symbol.

The Tablature clef.

2. Open Staff Settings and click the “Staff Options...” button.

3. Set the “System Lines” to as many strings as the instrument you are scoring for has.

4. Raise the Line Spacing value to 1 or 2.
You will need a little extra space between note lines to make room for the numbered note 
heads.

Suggested system line settings for guitar Tablature.

5. In Staff Options, activate “Tablature Mode”.

Tablature Mode activated.

6. Set up whatever other parameters you need in Staff Settings and the Staff Options dia-
log, and close them.

7. Select the Note Tool and move the pointer over the score.
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8. Press the mouse button (without releasing it) and drag up and down until the note ap-
pears on the desired string with the correct fret number (you can also verify the actual 
pitch on the Status bar, as usual).
When you drag up and down, the program automatically selects the lowest possible string. If 
you want a fret number higher than 4 on a guitar tablature, for example, you have to use 
“Move To String”, see below.

Setting the correct pitch.The Pitch box on the Status Bar can be used as an additional guide

9. Release the mouse button.
The note appears.

Tablature Number appearance

In the Preferences–Scores–Global Text dialog, you will find text settings for the Ta-
blature numbers. This allows you to select any font, size and style for the number 
note heads.
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Editing

Editing Tablature is done as with any score. You can move notes, handle beaming, 
stem direction etc., as described in other parts of the manual.

Move Notes to another String

If you want for example a “C” to appear as a “8” on the low E-string rather than a “3” 
on the A-string, on a guitar, proceed as follows:

1. Select one note or a number of notes that you all want to move to a new string.

2. Pull down the Score menu. From the Staff Functions menu, select Move To String and 
from that menu select the desired string.
The Fret number is automatically adjusted according to the tuning of the instrument (as set 
up in the Tablature dialog).

Move To String.

You can also move the notes one string up/down by using the key commands for 
“Next/Prev Dynamic/Text Size/String” (by default the [+] and [–] keys on the type 
writer part of the computer keyboard).

Moving Notes

Moving notes in pitch in a Tablature score is just as entering notes manually, see 
above.

Editing on the Info Line

Using the Info line you can change the pitch of notes as usual. The string and fret 
number will then be updated automatically in the score.
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Note Head Shape

If all you want is a fret number for your notes, you can use the Note Info dialog on 
regular notes.

1. Double click on the head of a note.
The Note Info dialog appears.

2. Activate the Tablature option and set a fret number in the value field just beside this.

The Tablature settings in Note Info.

3. Click Apply and close the dialog.
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16
Printing and Exporting Pages
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Printing

Printing from the Score Editor

1. Go into Page Mode.
You cannot print from Edit mode.

2. Select Page Setup from the File menu and make sure all your Printer settings are cor-
rect. Close the dialog.

❐ As mentioned earlier in this manual, you should have made settings for paper size, 
scale and margins before you started working on the page layout. Changing these set-
tings at this point may cause the score to look different.

3. Select Print from the File menu.

4. The standard Macintosh Print dialog appears. Fill out the options as desired.
There is one Cubase VST-specific option: the “Print Program Changes” checkbox. Activate 
this if you want program change markers in the score to be printed (for example if you are 
preparing a score for a keyboard player).

5. Click Print.

Printing All Layouts in the Song

If you have made a number of Layouts, for example for different instrumentalists, 
you can print them all in one go:

1. Open the Arrangement with the Layouts you want to print.

2. If required, select Page Setup from the File menu and make sure all your Printer set-
tings are correct. Close the dialog.

3. Pull down the File menu and select Print All.
This can be done from the Arrange window or from within Score Edit.

4. Fill out the dialog and click Print.
You will only be asked for Print options once. All following Layouts will print with the settings 
you make for the first one.

Printing From the Finder

You can print directly from the Finder. This will invoke a Print All command, as de-
scribed above, but allows you to print more than one Song document at a time. Ex-
actly how this is done varies with the version of Mac OS you are using, but the basic 
options are:

• Selecting documents and selecting Print from the File menu in the Finder.

• Dragging and dropping documents onto desktop printing symbols.
In either case, Cubase launches (if not running) and the Song documents are printed, one af-
ter the other, using the Print All function.
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Exporting pages as image files

You can export a section of a page, or a complete page, in various file formats. This 
allows you to import your scores into Desktop Publishing and Painting applications.

Selecting a section of a page for Exporting

If you only want to export a part of a certain page, proceed as follows:

1. Make sure you are in Page Mode.

2. Pull down the Score menu and select Select Range from the Export submenu.
The pointer turns into a cross hair.

3. Drag over the section of the Score you want to include.
The area is indicated by a black rectangle.

4. If needed, adjust the size of the rectangle by dragging its handles (in the corners) with 
the arrow pointer.
The selection rectangle disappears as soon as you click elsewhere in the score.

5. Proceed with Exporting as described below.

Exporting

To Export the Score, proceed as follows:

1. Make sure you are in Page Mode.

2. Pull down the Score menu and select “Export Score...” from the “Export” submenu.
The Export dialog appears.
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3. Use the radio buttons to the left to specify whether you want to export one page, all 
pages or just the selection area (see above).

4. Select a picture format.
The following formats are available:

5. If you selected the PICT format, specify a resolution in the DPI value field to the right.

6. Specify a name and a location for the file and click “Save”.
The specified section of the score is exported and saved as a file. It can now be imported into 
any program supporting the selected file format.

Format: Explanation:

PICT A Bitmap (rasterized) file. If you select this format, you must also specify a resolu-
tion. The higher the value, the better the quality, but also the larger the file.

EPSF Encapsulated PostScript™ File. An advanced and precise object oriented image 
format used by most Layout (DTP) programs.

Illustrator 88 More or less the same as EPSF, but with better compatibility with the Adobe Illus-
trator™ program.
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17
The Score and MIDI
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In this Chapter you will learn:

• How you can make the score affect the actual MIDI Events.
• What MIDI Meaning is.
• About the link between symbols and Damper Pedal/Program Change Events.
• What Crescendo To Velocity is.
• What Dynamics to Velocity is.

MIDI Meaning

This allows you to make note dependant symbols (such as accents and staccato) af-
fect the actual MIDI Events, so that accents make notes louder, staccato symbols 
make notes shorter, etc. In the MIDI Meaning dialog you set up which symbols have 
what effect on the score. Then any note dependant symbols that you add will auto-
matically change the corresponding MIDI notes as specified.

❐ MIDI Meaning is a “destructive” function, meaning that the notes will be permanently 
changed (as opposed to the Playback parameters in the Inspector, for example). How-
ever, if you later delete the symbols attached to the notes, the notes will be restored to 
their original length and velocity.

Setting up the MIDI Meaning Dialog

1. Pull down the Score menu and select MIDI Meaning from the Global Settings submenu.
The MIDI Meaning dialog appears:

The MIDI Meaning dialog.

2. Turn on MIDI Meaning by activating the check box labelled “Active”.
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3. Use the value fields to set up the effect of the symbols on the Velocity and Length of 
notes.
The values represent a percentage of the note's current values. Values can be in-/decreased in 
steps of 25%. For accents, for example, you might set Velocity to 150% and Length to “Off”. 
For the Staccato symbol you might set the Length to 50% and Velocity to Off. If a value field 
says “Off”, the corresponding property of the note will not be affected.

4. Click OK to close the dialog.
Now, if you insert one of the note symbols listed in the MIDI Meaning dialog, the correspond-
ing MIDI note will be changed according to your settings. If you want to insert a symbol with-
out affecting its MIDI note, you need to turn off MIDI Meaning first (by deactivating the 
“Active” checkbox).

• When MIDI Meaning is activated, you can open the dialog by double clicking on any 
note symbol in the score (provided it’s one of the symbols listed in the MIDI Meaning 
dialog).

❐ To restore a note to its original velocity and length, delete the symbols attached to the 
notes.

Damper Pedal Symbols

Damper Pedal symbols (found on the “Other” Symbol Palette) are special, in that they 
are both graphic symbols and actual Events. This means that if you insert a Damper 
Pedal symbol in the score, an actual Damper Pedal Event is inserted at the same posi-
tion. The opposite is also true: if you record Damper Pedal Events (or enter them in 
another editor), they will be displayed as Damper Pedal symbols in the score.

• The Pedal Down symbol ( ) corresponds to a Damper Pedal Event (Control Change 
#64) with a value of 127. The Pedal Up symbol ( ) corresponds to a Damper Pedal 
Event with a value of 0.

• If you have recorded Damper Pedal Events and don’t want them to show in the score, 
activate the option “Hide Pedal Markers” in the Preferences–Scores–Additional Set-
tings dialog.
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Program Change Symbols

Just as with Damper Pedal symbols, there is a link between Program Change Events 
and Program Change symbols in the score. This means that if you insert a Program 
Change symbol in the score (from the “Other” Symbol Palette), an actual Program 
Change Event is inserted at the same position. The opposite is also true: if you 
record Program Change Events (or enter them in another editor), they will be dis-
played as Program Change symbols in the score. Note however, that Program 
Change settings made in the Inspector don’t show in the score, since these are 
playback settings only, not actual Events.

• If the option “Use GM Names in Inspector” is activated in the Preferences–General–Ar-
rangement dialog, Program Change symbols will be displayed with General MIDI in-
strument names, instead of numbers.
Read more about the Program Change symbols on page 224.

• If you have recorded or entered Program Change Events and don’t want them to show 
in the score, activate the option “Hide Program Changes” in the Preferences–Scores–
Additional Settings dialog.

• If you have Program Change symbols in the score, but don’t want them to be printed, 
there is a special setting for this in the Print dialog.
See page 313.
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Crescendo to Velocity

This function allows you to make a crescendo or diminuendo symbol affect the ac-
tual velocity values of the notes in the range. Proceed as follows:

❐ This function makes permanent changes to your notes!

1. Double click on the crescendo or diminuendo symbol.
The Process Crescendo dialog appears.

2. If the Crescendo Start and End positions are not exactly what you want, adjust them in 
the dialog.

3. Use the Velocity Start value to set up the amount of velocity change you want to apply 
to the note(s) at the absolute beginning of the crescendo.
The value is defined as a percentage of original velocity.

4. Use the Velocity End value to set up the amount of Velocity change to apply to the 
notes exactly at the end of the crescendo.

5. If you want the velocity change specified at the end of the crescendo to be performed 
on all following notes in the score, activate “End Velocity until End”.

6. Decide if you want the change to affect the current staff only, or all staves, by clicking 
the appropriate button.
The velocities of the notes in the range are now processed.
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Dynamics to Velocity

This function allows you to make a dynamic symbol affect the actual velocity of a 
range of notes. Proceed as follows:

❐ This function makes permanent changes to your notes!

1. Double click on the dynamic symbol.
The Process Dynamics dialog appears.

2. Use the Start and End values to specify the range to which the velocity change should 
be applied. 

3. Use the Velocity value to set up the amount of Velocity change you want to apply to 
the note(s) in the range. 
The value is defined as a percentage of original velocity.

4. Decide if you want the change to affect the current stave only, or all staves, by clicking 
the appropriate button.
The velocities of the notes in the range are now processed.
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Troubleshooting
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In this Chapter you will learn:

• Reasons to problems you might encounter and how to solve them.

How to use this Chapter

This chapter contains a number of questions that might arise when you use Score 
Edit, and answers to each one. For more information about the functions referred 
to below, please check the previous chapters. If you don’t know where to look, use 
the Index.

Adding and Editing Notes

I enter a note with one value and it is shown as a note with another value.

In the default Song that comes with Cubase VST, the Rest Display Quantize is set to 
quarter notes. Change this to a smaller note value. Try turning off Auto Quantize, 
especially if you don’t have any triplets or triplets only.

Notes are not displayed on correct positions.

Try raising the Note Display Quantize value.

There are a number of short rests after my notes.

Your Rest Display Quantize might be set to too small a note value. Raise it. Also 
check Clean Lengths.

When I change the length of a note, nothing happens.

This is because the Display Quantize value puts a restriction on what note values 
can be displayed. Check that Display Quantize is actually set to the smallest note 
value you have in your piece.

I have adjusted Display Quantize and the other Staff settings best I can. The notes are 
still shown with the wrong values.

You might need to use one of three features: inserting Display Quantize Events, 
using Polyphonic Voicing, or applying Score Note To MIDI.

I change the Display Quantize settings in the Staff Settings dialog and nothing 
happens.

Maybe you have already inserted Display Quantize Events in the score? These over-
ride the Staff settings.

Suddenly many Display Quantize Events appear in the score.

This is not a malfunction. If you have had Auto Quantize on and start inserting 
Display Quantize Events, the Auto Quantizing is automatically transformed into 
Display Quantize Events.
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One long note is shown as many tied notes.

Do other notes occur at the same positions but with different lengths? Then you 
need to use Polyphonic Voicing. Are the note(s) syncopated? Then you should try 
the syncopation feature.

Even though I’ve tried the above, notes are not tied as I want them.

The way notes are tied in Cubase VST follows basic notation rules. You may need to 
make exceptions to these rules, by using the Cutflag tool.

I have an unnecessary amount of rests.

Especially with Polyphonic Voicing, superfluous rests may be created. Try turning 
off rests for one or more voices. You might also leave the rests on in the Polyphonic 
Voice dialog and then Hide the rests you don’t need, one by one.

When using Polyphonic Voices, a number of rests are drawn on top of each other.

As above, you should try Hiding rests (in the Polyphonic Voices dialog), Center 
Rests and possibly manually moving or hiding rests.

In Polyphonic Voices, notes that are on the same musical position are not displayed 
exactly vertically above each other.

This is not a malfunction. Cubase VST has built in automatic algorithms for making 
the score as legible as possible. Sometimes this will include adjustments of the 
“graphic” position of notes, especially with small intervals like seconds. You can al-
ways move the notes using the Layout Tool.

When using Polyphonic Voices, notes with small intervals “collide”.

As described above, Cubase VST tries to avoid this, but only for Voices 1 and 2 in the 
upper Staff and Voices 5 and 6 in the lower. For other Voices, please use the Layout 
tool to manually move the notes.

An action affects more or less objects (for example notes) than I expected.

Maybe the function uses the To menu? Please note that the To menu choice auto-
matically changes sometimes. For example when you click on one note the choice 
might switch to “Selected”.

When I select a note, nothing is shown on the Info Line.

The note is probably tied to another note. This means that the second note doesn’t 
really exist, it is just a graphic indication that the main note is long. Try selecting the 
main note instead.
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Symbols and Layout

Symbols from the Layout part of the Symbol Palette are sometimes invisible when I 
open the score.

This is not a malfunction. Those symbols are part of a Layout. If you open the score 
with another Layout, for example because you open another combination of Tracks, 
you will see another Layout which might not contain any Symbols at all. See the 
chapter “Working With Layouts”.

I can’t select an object on the screen, or I can’t select an object without selecting 
another object.

Use the selection rectangle to drag up (or down) and around the objects. Then hold 
down [Shift] and deselect all the objects you don’t want included, by clicking on 
them. You should also check out the Lock Layer function.

Symbols have disappeared.

Are they Layout symbols? Then maybe they belong to another Layout than the one 
you are editing now.

If that is not the reason, maybe you have inserted the symbol into the wrong staff. 
Please observe the warning on page 190.

A Symbol doesn’t move with its Staff. Auto Layout produces far too wide spacing.

Maybe you have inserted the symbol into the wrong staff. Please observe the warn-
ing on page 190.

A Note symbol appears too far from the note I wanted it inserted on.

Do you have the correct voice activated? Note symbols are inserted into voices, just 
like notes.
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19
Tips and Tricks
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In this Chapter you will learn:

• A number of useful techniques to help you work more efficiently with Cubase Scoring.

❐ Don’t forget to check out the example files in the Score Tutorial folder (within the Cubase 
VST folder). They provide a lot of hands-on tips on how to use the program efficiently.

Moving a Note without Transposing it

If you hold down [Shift] while moving a note (or a number of notes), and drag side-
ways to start with, you don’t have to worry about it being transposed. Another way 
is to press [Command] and use the left and right arrow key to move the selected 
note(s) to the left or right, in steps corresponding to the Snap value.

Moving and Spacing Several Staves

If you have a number of staves that you want displayed with an equal distance (for 
example, all strings of a grand staff in a full orchestra score), this can be done using 
the Position window: 

1. Open the Preferences–Scores–Editor Behaviour dialog and deactivate the option 
“Global Staff Spacing with [Option]-[Command]”.

2. In the score, select the staves that you want to set to an equal distance.

3. Open the Position Window (by clicking on the Ruler).
If the Staff Spacing values are not visible, you need to click on the window’s zoom box.

4. Use the ∆Previous Staff or ∆Next Staff settings to specify the desired distance between 
the staves.
Don’t close the value box yet!

5. Hold down [Option]-[Command] and press [Return] to close the value box.
All selected staves are spaced according to your settings.

• If you do this with the “Global Staff Spacing with [Option]-[Command]” option acti-
vated, all staves in the score are affected.

Polyphonic Voicing Tip

If you are working on a full score with more than one instrument in one staff (2 
flutes,2 trumpets etc.), you should use polyphonic voices. And even if both instru-
ments play the same notes, you should insert notes for both instruments (you can 
mute the notes of the second voice, if playback is an issue). If you do this, it will be 
much easier to extract single parts later (by using the “Extract Voices” command).

Using the “Move Events To” function

This function on the Score menu can help you work quicker, in the following way:

1. Create two empty Tracks, one for “Global Text”, another for “Important Phrases”. 

2. Pull down the Score menu and select “Edit...” from the Move Events To submenu.
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3. In the dialog that appears, tick these two Tracks in the “In Menu” column.
Now they will be added to the list on the Move Events To submenu. 

4. When working on the scores, copy global form remarks from time to time to the “Glo-
bal Text“ Track. 
This is done by selecting the object(s), holding down [Option] and selecting the “Global Text” 
Track from the Move Events To submenu. 

5. Do the same with important phrases.

When it’s time to extract single parts from the full score, you can copy form remarks 
and phrases (for cue notes) from the Tracks into the single parts, thereby saving time 
and work.

Using the Bar Handles

These are great for copying accents, but you can also use them for copying drum 
phrases, etc.

• If you hold down [Shift] and double click on a bar handle, this and the next bar are se-
lected. 
This is handy when copying phrases of two or more bars in one go.

Copying a Section with “Invisibles”

If you want to Copy and paste a section which contains hidden elements, adjusted 
beams and stems etc., there are two ways to proceed:

• Use the “Show Invisible” dialog or the Filter Bar to make indicators appear in the score. 
Then select these indicators together with the notes before you Copy.
This ensures the notes are copied with their formatting etc.

• Double click the bar handle of one of the bars, and make sure all relevant Event types 
are checked in the dialog. Then select the bars you want to copy by [Shift]-clicking 
their bar handles, and copy them by [Option]-dragging the bar handles.

Using “Score Notes To MIDI”

This function converts the score data, as displayed, to MIDI data. You might run into 
a situation when your score is displayed to 99% of perfection. That last 1% forces 
you to turn off functions in Staff settings (like Clean Lengths, No Overlap and Auto 
Quant) which makes the other parts of the score illegible. In this case, try “Score 
Notes To MIDI”. But work on a copy of the Track! For more info, see page 82.

Automatic Enharmonic Shift

Setting Enharmonic Shifting manually for a big score can take ages. Cubase has a 
feature that does this automatically if you provide a Chord Track, see page 234.

Optimizing Rests

If you have a number of consecutive empty bars you can replace them with one 
multiple rest. See page 276.
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Zero System Lines

Having no System lines at all might seem like stupid idea to start with. But, this op-
tion allows you to create chord sheets really quickly. See the Make Chords feature 
described on page 229.

A lead sheet created by specifying “0” system lines.

Examples and Scales

If you are creating scale examples and similar, you can use the Real book option 
and manually hide all symbols at the beginning of the first staff to make the score 
appear like separate unconnected “lines”.

For scales, remember you can also hide the bar lines.

An example scale without bar lines.

Controlling the order and appearance of Grace Notes

Grace Notes are normally beamed. Their order under the beam is controlled by their 
order in the Track. It is enough to put a grace note one tick before the next grace 
note to make them appear in the desired order under the beam.

Initially the grace notes are put in with a 32nd note beam. By double clicking the note 
and changing the “flag” type in the Note Info dialog, you can change this. If you click 
the “As Default” button in the dialog, your selection will be used as default for all sub-
sequent grace notes.

Complex grace notes.
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Deciding what type of Text to use

Using Text Attribute Sets

If you load one of your Songs on a different computer and find that your scores use 
the wrong fonts, proceed as follows: 

1. Use the Save As dialog on the File menu to save the current settings as a “Preferences” 
file.
This saves all current Preferences as a separate file. Later the owner of the computer can re-
store his own settings by loading the Preferences file.

2. Activate “Save with Song” in the Text Attribute Sets Edit dialog. 

3. Open the Song again. 
Now the text sets of the Song are used instead of those stored in the Preferences. 

4. If the wrong fonts still are used, make sure all fonts that are defined in your Text At-
tribute Sets are installed on the computer. 

Adding Left and Right Hand indications to Drum Scores

Select all notes to be played with one hand. Select “Lyrics” from the “Other” Sym-
bols Palette. Make sure the “To” menu is set to “All Selected (Events)”. Hold down 
[Option] and click on one of the selected notes. Type in for example “r” and press 
[Return]. Proceed with the other hand.

Using lyrics for drum hand indications.

Type Of Text: Application:

Lyrics Well, not only for lyrics, but also for fingering and hand indications. See below.

Text For text that should move with a staff and that should appear in all Layouts. For 
example performance notes.

Page Text For Layout related text that should stay in place regardless if the staves are 
moved. For example page footers, copyright notices, sub titles etc.

System Text Same as Text but for text related to a Layout. For example instrument names.



- 331 - 

Adding Fingering

The tip above can be used to speed up entering numbers for fingering. Simply re-
place the text with numbers.

Using Lyrics for fingering.

Speeding up Inserting Key Changes

If you have a grand staff with many instruments, inserting key changes one by one 
can take an awful lot of time.

If you instead insert the new key on one staff and hold down [Option] when clicking 
with the Pen, this key change is inserted on all staves in the Grand Staff.

Speeding up Inserting Staccato and Accents

Symbols linked to notes can also be put in for a number of notes at the same time, 
even on different staves. See page 192.

Setting the Distance between Staves in a Piano Score

Hold down [Option] while dragging the first bass staff on the first page. This will 
copy the spacing to all staves. Please note that this can only be done in Page Mode.

If you wish you had a faster computer

Here are some tips for those who find some operations slower than they would like:

• Work an a smaller section of the score at a time. Break the piece up into Parts and work on 
those Parts individually until the final layout stage.

• When you are working on the Layout, turn on “Layout Layer Only” whenever possible.
• Switch On Multi Rests as late as possible.
• When working in Edit mode, set Default Bars Across The Page to a small value, for example 2.
• In Edit mode, resize the window so that only one grand staff at a time is visible.
• Consider upgrading your computer hardware.



- 332 - 



- 333 - 

20
Shortcuts
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Multi Edit and Multi Insert

Generally in Score, if you hold down the [Option] key while performing an opera-
tion, this operation will be copied to other parts of the score. Below follows a brief 
listing of where the [Option] key is used.

Multi Insert

Multi Edit

Element: Result With [Option] Pressed:

Dialog Boxes The settings are copied to all events set up to be affected by the To 
menu.

Accents, Staccato, and other 
Note dependant symbols 

Inserted on all notes set to be affected by the To menu (This can also 
be done by selecting Multi Insert from the Do pop-up menu).

Braces Inserted on all Grand Staves.

Keys Signature Changes Inserted on all staves in this Grand Staff.

Other symbols, like 
dynamics, crescendo etc.

Inserted on all staves in this Grand Staff.

Page Text Inserted at the same position on all pages. 

Element: Result With [Option] Pressed:

Bar lines Moving first or last bar line of a Grand Staff results in proportional width 
change of all the bars across the page.

Braces Changing the height of or moving a brace copies the new size and location 
to all Grand Staves.

Keys & Clefs Copies the new key/clef to all keys/clefs at the same position.

Symbols not linked to 
notes

Copies the change to all items set to be affected by the To menu. For exam-
ple, selected font and size gets copied to other text elements.

Page Text Edit all Page Text elements at the same position, for example replacing a 
sentence that was typed in incorrectly.



- 335 - 

Get Info

You can “Get Info” about almost any item in the Score. Exactly which dialog box, 
window or pop-up appears depends on which element you activated. There are 
three ways to get info for an element in the score:

• Double click on it.

• Select it and select Get Info from the Edit menu.

• Select it and press the “i” button on the Score Toolbar

 

Element: Menu/Dialog Box/Window:

Bar lines Select between different types of bar lines.

Notes Note Info window (change note appearance).

Multiple Rests Split Rests dialog.

Time Signature Set Time Signature dialog.

Clefs A dialog with the different clefs.

Keys A dialog with all keys.

Accents If MIDI Meaning is activated, and the particular symbol is listed in the MIDI 
Meaning dialog, then the MIDI Meaning dialog opens up.

Page Numbers The Preferences–Scores–Page Numbering dialog.

Bar Numbers The Bar Number Offset dialog.

Staff Names A name box. Note that when you are editing the Staff name, you may be 
changing the name of the actual Track or just the Staff name used in the 
scores, depending on the Staff Name settings in the Layout Settings dialog.

Crescendo Process Crescendo dialog. 

Lines and Boxes The Edit Line Attributes dialog.

Tempo Symbol Lets you edit the note value for the tempo calculation.

Change Tempo Feel
Symbol

Two different pop-ups depending on which half of the symbol you clicked. 
Used to set up one type of note to be interpreted as another type of note.

Guitar Symbol Edit the chord.

Chord Symbols Edit the chord.

Scale Elements Edit key or scale depending which half of the symbol you clicked.

Score Title Edit title, comment and copyright, plus font, style and size settings.

Text Edit text.
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“Context Menus” for symbols and other objects

You can edit many of the objects in the score by holding down [Command] and 
clicking with the arrow tool. This opens a “context menu”, a palette or similar, al-
lowing you to quickly change the properties of the object. 

• The adjustment you make affects all selected objects of the same type (taking the To 
pop-up menu into account).
This allows for quick editing of multiple objects.

The following object types support this feature:

Object: Result of [Command]-clicking:

Note Allows you to adjust the length of the note, in multiples of the current Snap 
value.

Note symbols Opens a palette allowing you to select another symbol of the same general 
type (another type of accent, another fermat sign, etc.).

Dynamic symbols Opens a palette allowing you to select another dynamic symbol.

Crescendo symbols Allows you to “flip” the crescendo direction.

Chord symbols Opens a pop-up menu listing the chord types stored in the Chord Library. 
Selecting an item from the pop-up menu will only change the chord type 
and tension - the root and bass notes are not affected.

Guitar chord symbol Opens a pop-up menu listing the guitar chords stored in the Guitar Library.

Text (all types) Opens a pop-up menu listing all defined Text Attribute Sets.
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A
Accents above Staves 192
Accents above Stems 192
Accidentals

About 156
And Chord Tracks 234
Distance From Note 162

Active Staff 49
Add Space 127
Adding Notes 91
Align

Dynamics 222
Symbols 217
Text 241

As Default button (Grace Notes) 178
Auditioning 100
Author 254
Auto Clef 59
Auto Grouping 167
Auto Layout

About 290
Bars and Staves 291
Hide Empty Staves 291
Icon 290, 291
Move All Bars 290
Move Bars 290
Move Staves 290
Optimize All 291
Spread All Pages 291
Spread Page 291

Auto Move To Voices 135
Auto Quantize 71

B
Bar Handles 211, 328
Bar Line Symbols 224
Bar Lines

Adding Extra 278
Breaking 293
Hidden 278
Indent 284
Moving 284
Selecting Type 277

Bar Numbers
As Time Code 260
Offsetting 259
Settings 258
Spacing 259

Bars
Inserting and Removing 283
Moving to Next/Previous Staff 282
Number Across Page 281
Resetting Spacing 285

Bars and Staves 291
Bass To Lowest

Explode Function 82
Polyphonic Voices 136

Beam Subgroups 74
Beams

Appearance 169
Group Settings 169
Grouping 164
Manual Adjustment 170
On/Off 163
Slant 169
Stem Direction 152

Bow Up/Down 161
Boxes 225
Braces 289
Bracket Head 162
Brackets 289
Build N-Tuplet 179
Build Trill 196

C
Chord Symbols

Global Settings 231
Inserting Automatically 229
Inserting Manually 227

Chord Tracks 234
Clean Lengths 71
Clean Up Layout 292
Clefs

Editing 117
Inserting 116
Moving 118
Setting Initial 58

Color
Editing 160
For Additional Meanings 113
Note Heads 159

Comment 254
Common Time 56
Connect Dynamics 221
Consolidate Rests 75
Context Menus 336
Copy 106, 216
Copy Events function 211
Copy To All Grand Staves 294
Copyright Text 256
Crescendo

Altering Note Velocity 320
Drawing 220
Flipping 221
Keeping Horizontal 220

Crescendo To Velocity 320
Cross Staff Beaming 167
Crossed Voicings 145
Cue Notes 174
Custom Palette 190
Cut 106
Cut Time 56
Cutflag Tool 172
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D
Damper Pedal Symbols 223, 318
Default Bars Across The Page 281
Delete

Bars 283
Notes 99
Symbols 216

Diminuendo
Altering Note Velocity 320
Drawing 220
Keeping Horizontal 220

Display Arrow after Inserting Symbol 191
Display Layouts 265
Display Length 112, 161
Display Quantize

About 10
Auto 71
Deleting Events 81
Editing Events 81
Hiding Events 80
In Polyphonic Voices 80, 143
Inserting Changes 78
Rest 12
Setting 70
Tool 13

Display Quantize Tool 78
Display Tracks 45
Display Transpose 62
Double Click Symbol to get Pencil Tool 191
Drag and Drop 107
Drum Map

About 296
Display Pitch 297
Initializing 299
Setting Up 299

Drum Notes
About 296
Adding and Editing 302
Hand Indications 330
Head Pairs 300
Setting Up The Staff 302
Single Line 303

Duplicate
Notes 103
Symbols 207
Using Bar Handles 211

Dynamics To Velocity 321

E
Edit Drum Map in Scores 301
Edit Guitar Lib 200
Edit Mode 47
Ending Symbols 225
Enharmonic Shift

Automatic 234
Manual 157

Eraser Tool 99, 293
Explode 82
Exporting as Image Files 314
Extract Voices 148

F
F button 51
Fill with Clipboard Lyrics 249
Filter Bar 51, 55
Find and Replace 253
Find Grace Notes 177
Fingering 331
Fit Page/Width 48
Fixed Stem Length 127
Flat Beams 74
Flat Ties 173
Flip

Crescendo 221
Slurs and Ties 215
Stems 152
Ties 162

Fonts 240, 260
For Grouping Only option 57, 164
Force Update 64

G
Get Form Only 263
Get Info 335
Get Layout 263
Global Staff Spacing 327
Global Symbol palette 203
Glue Tube Tool 111, 282
Grace Notes

Converting to Normal 178
Creating Automatically 177
Creating Manually 176
Order of 329
Settings 177

Graphic Move 173, 194
Graphic Note Type 162
Graphic Notes (Symbols) 222
Group Icon 165
Grouping

Automatic 167
Manual 165
Removing 166

Guitar Chord Symbols 198
Guitar Lib 200
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H
Help Lines 162
Hide Empty Staves 291
Hide Pedal Markers 223, 318
Hide Program Changes 224
Hide/Show Markers 269
Hiding Objects 274

I
Indent 284
Info Line 51, 111
Insert Bar 283
Insert buttons 137
Insert Quantize 79
Insert Slur 195
Insert Tuplet 180
Interpretation Flags 71, 125

K
Keep Crescendi Horizontal 220
Keep Moved Notes within Key 92, 101
Key

Editing 117
Inserting Changes 116
Setting Initial 60

Keyboard Symbol 197

L
L Button 102
Layout Layer 183
Layout Layer Only 184
Layout Settings 266, 271
Layout Symbols 183
Layout Tool 118, 173, 194
Layouts

About 263
Applying 267
Creating 264
Deleting 268
List 266
Loading And Saving 268
Opening Tracks In 265

Lead Sheet 233
Length of Notes 110
Line Symbols 225
Lines To Voices

Explode Function 82
Polyphonic Voices 136

Link Button 49
Lock button 102
Lock Layers 205

Lyrics
About 246
Adding from Clipboard 249
In Voices 248
Inserting Automatically 249
Inserting Manually 246

Lyrics from Clipboard 249

M
Magnification 48
Magnifying Glass tool 48
Make Chords 229
Marker Track to Form 269
Melisma Lines 238
Merge All Staves 147
MIDI In Button 109
MIDI Meaning 317
Modern Style Settings 272
Modern Time Signature 272
Mouse Position Box 90
Move All Bars 290
Move Bars 290
Move Events To 103, 327
Move Staves 290
Move To Next/Prev. Page 288
Move to Verse 248
Moving

Between Voices 139
Notes 100
Staves 286
Symbols 207
To Other Tracks 103
Using Bar Handles 211
Using the Arrow Keys 102, 173, 210

Multi Edit 334
Multi Insert 193, 334
Multi Rests

Creating 276
Settings 277
Splitting 276

Muting Notes 113

N
Next Dynamic 219
No Beams 74
No Overlap 72
No Stems 162
Non-note Position Display 208
Note Dependant Symbols 183
Note Info Dialog 158, 161
Note Layer

About 183
Hiding 184
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Note Symbols
About 183
Adding 192
Changing type 193

Note Values 88
Notes

Adding 91
Color 159
Deleting 99
Display Length 112
Duplicating 103
Editing Via MIDI 109
Graphic 162
Graphic Move 173
Grouping 165
Head Shape 158
Help Lines 162
Info Dialog 153
Length 110
Moving 100
Muting 113
Note Values 88
Selecting 96
Spacing 271
Splitting 112

Number Of Bars Dialog 281

O
Octave Symbols 222
Offset Bar Numbers 259
Optimize All 291
Optimize Two/Four Voices 134

P
Page

Selecting 47
Page mode 46
Page Numbers 255
Page Setup 50
Page Text 250
Page Up and Down keys 47
Paste 106, 216
Paste Note Attributes 163
Pedal Symbols 223, 318
Pencil tool 191
Piano Staff

Fixed Split Point 114
Polyphonic Voices 141
Variable Split Point 134

Pickup Bar 279
Pictures 202
Polyphonic Presets 134

Polyphonic Voicing 129
About 130
Automatic 147
Checking Notes 138
Display Quantize 143
Entering Notes 137
Moving Notes To Voices 139
Presets 134
Rest Handling 140
Selecting Notes 138
Setting Up 132
Stem Direction 151

Position Window 208
Preferences 64
Previous Dynamic 219
Printing

All Layouts 313
From Score Edit 313
From the Finder 313
Making Settings 50

Program Change Symbols 224, 319

Q
Q Tool 78
Quantize Tool 13

R
Rastral 127
Real Book 272
Rehearsal Marks 225
Remove Bar 283
Repeats Symbols 223
Replace Text Font 252
Rests

Adding 95
Creating Multi Rests 276
In Polyphonic Voices 133, 140

Ruler 53, 208

S
Scale Events 224
Scale Pop-up Menu 48
Scissors Tool 112, 282
Score Notes To MIDI 83
Score Preferences 64
Score Toolbar

Showing and Hiding 51
Tearing Off 52

Scrolling 47
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Selecting
Equal Pitch 98
In One Voice Only 97, 138
Layouts 265
Notes 96
Same Enharmonic 99
Same Verse 248
Symbols 204

Show Braces in Edit mode 289
Show command 275
Show Invisible Dialog 55, 274
Show Invisible Filter Bar 51, 55
Show Long Staff Names on new Pages 257
Shuffle 73
Single Line Drum Staff 303
Size (System) 127
Slurs

Adding 194
Shape and Direction 215

Snap Value 89
Song Position 46
Spacing 271
Speaker Icon 100
Spectacle Bass 166
Split Note

Explode Function 82
Piano Staff 115
Polyphonic Voices 136

Split Staff
Normal 114
Polyphonic Voices 141

Spread All Pages 291
Spread Page 291
Staff Mode

Polyphonic 132
Single 124
Split 114

Staff Names
Displaying 256
From Track Names 256
Long and Short 257
Settings 257

Staff Options 74, 126
Staff Presets 122
Staff Separators 272
Staff Settings

About 68, 85
General MIDI 128
Multiple Staves 69, 121
Switching Staves 69
Switching Tracks 86
Values For Note Input 87

Staff Size 273
Status Bar 51
Staves

Moving 286
Relation to Tracks 43

Stem Direction
About 150
In Polyphonic Voices 151
Manual Flip 152
Note Info Dialog 162

Stems Hidden 162
Stems Length 154
Symbol Palettes

About 54
Available Symbols 187
Customizing 190
Displaying 185
Moving and Handling 186

Symbols
Adding 194
Adding to Notes 192
Aligning 217
Deleting 216
Duplicating 207
Guitar Chords 198
In Palettes 187
Moving 207
Moving with Keyboard 210
Note Dependant 183
Note Symbols 183
Relation to Staves and Voices 190
Resizing 215
Selecting 204

Syncopation 72
System (Staff Settings) 127
System Lines 127
System Text 250

T
Tablature

Automatic Creation 305
Clef 308
Editing 310
Manual Creation 308
MIDI Channels 306
Number Note Head 309

Tempo Change Symbol 223
Tempo Symbols 223
Text

Adding 237
Aligning 241
Editing 239
Font, Size and Style 240
Inserting Score Characters 239
Lyrics 246
Melisma Lines 238
Page Text 250
Regular 246
Replacing Fonts 252
Replacing Words 253
System Text 250
Title, Comment, Author 254
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Text Attribute Sets
About 243
Creating 243
Deleting 245
On Different Computers 330
Using 244

Ties
About 93, 171
Adding As Symbols 194
Direction 162
Flat 173
Shape and Direction 215
Splitting 112
Using the Cutflag Tool 172

Time Signature
Composite 57
Editing 117
Grouping 57
Inserting 116
Modern 272
Relation to Master Track 57
Setting Initial 56

Title 254
Toggle Margins 50
Track/Staff relation 43
Transcription 66
Transposing 108
Transposing Instruments 62
Trills 196
Tuplets

About 179
Building 179
Creating with Display Quantize 180
Display Options 181
Group Symbols 222

U
Unmute Selected 113
Upbeats 279
Upd button 64
Use Chord Track for Accidentals 234
Use Colors for Additional Meanings 113

V
Variable Split 134
Verses 248
Voice Insert buttons 137
Voices

About 130
Checking Notes 138
Converting to Tracks 148
Display Quantize 143
Entering Notes Into 137
Moving Notes To 139
Rest Handling 140
Selecting Notes 138
Setting Up 132
Stem Direction 151

W
Words Palette 251

X
X-stem (spoken) 162
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